This manual is a complete user's guide to Liant Software Corporation's CodeWatch, a fully integrated development environment for RM/COBOL for Windows, which supports editing, compiling, and debugging RM/COBOL applications. It is assumed that the reader is familiar with programming concepts and with the COBOL language in general.

The information contained herein applies to systems running under Microsoft 32-bit Windows operating systems.

The information in this document is subject to change without prior notice. Liant Software Corporation assumes no responsibility for any errors that may appear in this document. Liant reserves the right to make improvements and/or changes in the products and programs described in this guide at any time without notice. Companies, names, and data used in examples herein are fictitious unless otherwise noted.

No part of this publication may be reproduced, stored in a retrieval system, or transmitted, in any form or by any means, electronic, mechanical, photocopied, recorded, or otherwise, without prior written permission of Liant Software Corporation.

The software described in this document is furnished to the user under a license for a specific number of uses and may be copied (with inclusion of the copyright notice) only in accordance with the terms of such license.

Copyright © 1999-2002 by Liant Software Corporation. All rights reserved.
Printed in the United States of America.
# Table of Contents

**Preface** ......................................................................................................................... ix
  Welcome to CodeWatch Version 7.5 .................................................................................. ix
  What's New....................................................................................................................... ix
  Prerequisites ..................................................................................................................... x
  About Your Documentation ............................................................................................... xi
  Related Publications ........................................................................................................ xii
  Registration ....................................................................................................................... xiii
  Technical Support ............................................................................................................ xiv
  Support Guidelines ......................................................................................................... xiv
  Test Cases......................................................................................................................... xv

**Chapter 1: Installation and System Considerations** .................................................... 1-1
  System Requirements ....................................................................................................... 1-1
  Required Hardware ......................................................................................................... 1-1
  Required Software .......................................................................................................... 1-2
  System Installation .......................................................................................................... 1-2

**Chapter 2: Getting Started with CodeWatch** ............................................................... 2-1
  Quick Start Tutorial ......................................................................................................... 2-1
  Starting CodeWatch ....................................................................................................... 2-7
    Starting CodeWatch from Windows ............................................................................. 2-7
    Starting CodeWatch Using a Saved Workspace ......................................................... 2-8
    Starting CodeWatch from an MS-DOS Environment .................................................. 2-9
    Starting CodeWatch with a Runtime Command Line ................................................. 2-10
      Exercise 1—Start CodeWatch .................................................................................. 2-11
  Configuring a Workspace ............................................................................................... 2-12
    Exercise 2—Configure a Workspace with the Workspace Wizard ......................... 2-13
  Viewing and Editing Program Source ........................................................................... 2-16
    Exercise 3—Locate Source Files .............................................................................. 2-16
  Running the Program ...................................................................................................... 2-18
    Exercise 4—Run the Program ................................................................................... 2-18
  Animating the Program ................................................................................................... 2-22
  Controlling the Flow of Execution ................................................................................ 2-22
  Setting Breakpoints ....................................................................................................... 2-23
    Exercise 6—Set a Breakpoint ................................................................................... 2-23
## Table of Contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Setting Watchpoints</td>
<td>2-24</td>
</tr>
<tr>
<td>Exercise 7—Set a Watchpoint</td>
<td>2-24</td>
</tr>
<tr>
<td>Inspecting and Modifying Data</td>
<td>2-26</td>
</tr>
<tr>
<td>Exercise 8—Select a Data Item</td>
<td>2-26</td>
</tr>
<tr>
<td>Stopping the Program</td>
<td>2-27</td>
</tr>
<tr>
<td>Exercise 9—Stop the Program</td>
<td>2-27</td>
</tr>
<tr>
<td>Changing the Workspace</td>
<td>2-28</td>
</tr>
<tr>
<td>Saving the Workspace</td>
<td>2-28</td>
</tr>
</tbody>
</table>

## Chapter 3: CodeWatch Interface ......................................................... 3-1

<table>
<thead>
<tr>
<th>Subsection</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>CodeWatch Workspace Wizard</td>
<td>3-1</td>
</tr>
<tr>
<td>Introduction Page</td>
<td>3-3</td>
</tr>
<tr>
<td>Select Program Page</td>
<td>3-5</td>
</tr>
<tr>
<td>Set Additional Options Page</td>
<td>3-7</td>
</tr>
<tr>
<td>Set Execution Environment Page</td>
<td>3-9</td>
</tr>
<tr>
<td>CodeWatch Main Window</td>
<td>3-11</td>
</tr>
<tr>
<td>Dockable Windows</td>
<td>3-14</td>
</tr>
<tr>
<td>Workspace Window</td>
<td>3-14</td>
</tr>
<tr>
<td>Programs Tab</td>
<td>3-16</td>
</tr>
<tr>
<td>Files Tab</td>
<td>3-17</td>
</tr>
<tr>
<td>Context Menu in a Workspace Window</td>
<td>3-18</td>
</tr>
<tr>
<td>Data Window</td>
<td>3-20</td>
</tr>
<tr>
<td>Breakpoints Tab</td>
<td>3-21</td>
</tr>
<tr>
<td>Watchpoints Tab</td>
<td>3-23</td>
</tr>
<tr>
<td>Data Files Tab</td>
<td>3-25</td>
</tr>
<tr>
<td>Call Stack Tab</td>
<td>3-26</td>
</tr>
<tr>
<td>Build Results Tab</td>
<td>3-27</td>
</tr>
<tr>
<td>Context Menu in a Data Window</td>
<td>3-28</td>
</tr>
<tr>
<td>Log Window</td>
<td>3-29</td>
</tr>
<tr>
<td>Context Menu in a Log Window</td>
<td>3-30</td>
</tr>
<tr>
<td>Document Windows</td>
<td>3-31</td>
</tr>
<tr>
<td>Using Document Windows</td>
<td>3-31</td>
</tr>
<tr>
<td>State of Document Windows</td>
<td>3-31</td>
</tr>
<tr>
<td>Document Menu</td>
<td>3-33</td>
</tr>
<tr>
<td>Cycling Through Open Windows</td>
<td>3-34</td>
</tr>
<tr>
<td>Splitting Document Windows</td>
<td>3-35</td>
</tr>
<tr>
<td>Closing Document Windows</td>
<td>3-36</td>
</tr>
<tr>
<td>Floating Windows</td>
<td>3-36</td>
</tr>
<tr>
<td>Find Dialog Box</td>
<td>3-36</td>
</tr>
<tr>
<td>Regular Expressions</td>
<td>3-38</td>
</tr>
<tr>
<td>Replace Dialog Box</td>
<td>3-40</td>
</tr>
<tr>
<td>Inspect/Modify Dialog Box</td>
<td>3-42</td>
</tr>
</tbody>
</table>

*iv Table of Contents*
Menus and Toolbars ............................................................................................................. 3-44
File Menu .............................................................................................................................. 3-45
Edit Menu ............................................................................................................................ 3-52
View Menu .......................................................................................................................... 3-54
Build Menu .......................................................................................................................... 3-55
Run Menu ............................................................................................................................. 3-57
Window Menu ....................................................................................................................... 3-59
Workspace Properties Dialog Box ....................................................................................... 3-61
Program Page ....................................................................................................................... 3-62
Options Page ......................................................................................................................... 3-64
Environment Page ................................................................................................................ 3-66
Command Page .................................................................................................................... 3-68
Breakpoints & Watchpoints Dialog Box .............................................................................. 3-69
Code Breakpoints Page ....................................................................................................... 3-69
Data Watchpoints Page ....................................................................................................... 3-71
Item Properties Dialog Box ................................................................................................. 3-73
Source File Property Page ................................................................................................... 3-74
Programs Property Page ...................................................................................................... 3-75
Build Options Property Page .............................................................................................. 3-76

Chapter 4: Source Code Editor .......................................................................................... 4-1
How CodeWatch Finds Source Files During Execution ....................................................... 4-1
Source Code/Edit Window ................................................................................................... 4-2
Contents of the Source Code/Edit Window ........................................................................ 4-2
Context Menu for the Source Code/Edit Window ............................................................... 4-4
Using the Source Code/Edit Window .................................................................................. 4-6
Creating a New Source Code Document ............................................................................... 4-6
Opening an Existing Source Code File ................................................................................ 4-7
Viewing Source During Program Execution ....................................................................... 4-8
Editing Operations in the Source Code/Edit Window ......................................................... 4-8
Setting Preferences ............................................................................................................. 4-9
Tabs Page ............................................................................................................................... 4-9
External Editing Page ......................................................................................................... 4-12
Basic Editing Techniques ................................................................................................... 4-15
Moving Around in a File ....................................................................................................... 4-15
Insertion Point ....................................................................................................................... 4-15
How to Move with the Mouse ............................................................................................ 4-16
Using the Vertical Scroll Bar ............................................................................................... 4-16
Using the Horizontal Scroll Bar ......................................................................................... 4-17
How to Move with the Keyboard ......................................................................................... 4-17
Table of Contents

Selecting Text................................................................................................................. ..... 4-18
  How to Select Text with the Mouse................................................................................. 4-19
  Selecting a Word ......................................................................................................... 4-19
  Selecting Entire Lines.................................................................................................. 4-19
  Selecting the Entire Document .................................................................................... 4-19
  Selecting Multiple Characters or Lines ....................................................................... 4-19
  Block Selection ........................................................................................................... 4-20
  Extending a Selection.................................................................................................. 4-20
  How to Select Text with the Keyboard............................................................................ 4-20
Inserting New Text............................................................................................................. .4 - 21
Overwriting Text ............................................................................................................... .. 4-22
  Overwriting Selected Text............................................................................................... 4-22
Deleting Text.................................................................................................................. ..... 4-22
Correcting and Editing Text............................................................................................... 4-23
Cutting, Copying, and Pasting Text..................................................................................... 4-25
Using the Windows Clipboard to Duplicate or Move Text................................................. 4-26

Chapter 5:  Building Programs with CodeWatch............................... 5-1
Compiling...................................................................................................................... ............ 5-1
  Compiling Only Changed Files ............................................................................................. 5-2
  Setting Compilation Options ................................................................................................. 5-2
The RMPATH and Environment Variables........................................................................... 5-6
Locating the Compiler.......................................................................................................... .5 - 7
Compiler Output................................................................................................................ .... 5-8

Appendix A:  Miscellaneous Configuration Options ......................... A-1
Runtime Options.................................................................................................................... A-1
  Setting the RM/COBOL Runtime Registry Key................................................................. A-1
  Setting the RM/COBOL Runtime Configuration .exe File............................................... A-2
Selecting a Runtime License Vault....................................................................................... A-2
Compiler Options ............................................................................................................... ...... A-3
  Setting the RM/COBOL Compiler Registry Key ................................................................. A-3
  Setting the RM/COBOL Compiler Configuration .exe File ................................................. A-3
Miscellaneous Options......................................................................................................... A-4
  Changing the Log Window Font ............................................................................................ A-4
  Setting the Log Window Size .............................................................................................. A-4
  Controlling Dependency Checking...................................................................................... A-4

Index ........................................................................................................................................ X-1
Comments

The following last-minute changes and enhancements have been added as comments to the CodeWatch User’s Guide:

Starting CodeWatch From an MS-DOS Environment ............................................................ 2-7
Statement Indicators and REPLACE Lines ........................................................................ 4-3

List of Tables

Table 3-1  Types of Workspace Windows ................................................................. 3-13
Table 3-2  Special Characters Allowed in CodeWatch Regular Expressions ........... 3-39
Table 4-1  Direction Keys ......................................................................................... 4-17
Table 4-2  Text Selection Keys ............................................................................... 4-21
Table 4-3  Editing Keys .......................................................................................... 4-23
Table 4-4  Edit Menu Shortcut Keys ....................................................................... 4-25
Table 5-1  RM/COBOL Compile Command Options Available ............................. 5-4
Preface

Welcome to CodeWatch Version 7.5

This document describes CodeWatch, Liant Software Corporation’s fully integrated development environment for RM/COBOL for Windows.

CodeWatch version 7.5 for Windows supports the entire development cycle, including editing, compiling, and debugging RM/COBOL applications. CodeWatch can be used to debug and change programs that are independently compiled, without requiring you to build projects. Instead, all the knowledge about the structure of your application is built up during debugging sessions.

What’s New

Version 7.5 of CodeWatch contains the following enhancements:

- The ability to edit and compile your programs without leaving CodeWatch.
  - It is now possible to see and correct errors and warnings in an external text editor.
  - CodeWatch provides complete support for all RM/COBOL compilation options.

- CodeWatch now contains a fully-integrated text editor (called the Source Code Editor), with the following capabilities:
  - Unlimited levels of Undo and Redo.
  - Search and replace, including regular expression support.
  - Ability to invoke an alternate text editor of your choice with just a keystroke. Many external editors can even position the cursor at the current line and column.
Prerequisites

Several conditions are necessary before you can run CodeWatch for Windows:

- CodeWatch requires that the following products be installed on your system:
  - One of the following operating systems is required:
    - Microsoft Windows 95 OSR2
    - Microsoft Windows 98 or Windows 98 Second Edition (SE)
    - Microsoft Windows Millennium Edition (Me)
    - Microsoft Windows NT version 4.0 (Service Pack 6 or higher is recommended)
    - Microsoft Windows 2000
    - Microsoft Windows XP
  
  **Note** As you read through this guide, note that Liant may use two shorthand notations when referring to these operating systems. The term “Windows 9x class” refers to the Windows 95, Windows 98, or Windows Me operating system. The term “Windows NT class” refers to the Windows NT 4.0, Windows 2000, or Windows XP operating system.

  - RM/COBOL for Windows development system, version 7.5 or later.

- For source-level debugging, the COBOL object files must be compiled using the RM/COBOL version 7.5 compiler, using the Full Debug Information (Y=2 or Y=3) Compile Command Option (see Chapter 6, Compiling, of the RM/COBOL User's Guide). This option embeds additional symbol information in the object file. A new option in the *rmpgmcom* utility, which is provided with the development system, can be used to strip this information from object files without the need to recompile (see Appendix G, Utilities, of the RM/COBOL User's Guide).

- For non-source level debugging, a printed RM/COBOL compiler listing file (produced by the compiler when the program was originally compiled) is required. CodeWatch can be used to set breakpoints and watch variables during non-source level debugging.
About Your Documentation

The following lists the topics that you will find in the CodeWatch User’s Guide and provides a brief description of each.

Chapter 1—Installation and System Considerations. This chapter lists the hardware and software required to install CodeWatch for Windows, and describes how to install the product.

Chapter 2—Getting Started with CodeWatch. This chapter provides a quick start tutorial of CodeWatch followed by a more in-depth, step-by-step walk through of a basic CodeWatch debugging session.

Chapter 3—CodeWatch Interface. This chapter provides detailed descriptions of the Workspace Wizard, and the various windows, dialog boxes, menus, and toolbars found in CodeWatch.

Chapter 4—Source Code Editor. This chapter explains how CodeWatch locates source files, describes the Source Code/Edit window and how to use the internal Source Code Editor, discusses setting preferences to customize the editing environment (including configuring an external editor), and provides an overview of the most common and basic editing tasks in CodeWatch.

Chapter 5—Building Programs with CodeWatch. This chapter provides an overview of how CodeWatch compiles source files.

Appendix A—Miscellaneous Configuration Options. This appendix describes a file called rmcw.ini, which is used by CodeWatch to include several optional configuration options and tuning parameters that are not set from within the program.

Related Publications

For additional information, refer to the following publications:

RM/COBOL User’s Guide
RM/COBOL Syntax Summary
CodeBridge—Calling Non-COBOL Subprograms
Symbols and Conventions

The following typographic conventions are used throughout this manual to help you understand the text material and to define syntax:

1. Words in all capital letters indicate COBOL reserved words, such as statements, phrases, and clauses; acronyms; configuration keywords; environment variables; and RM/COBOL Compiler and Runtime Command line options.

2. Text that is displayed in a monospaced font indicates user input or system output (according to context as it appears on the screen). This type style is also used for sample command lines, program code and file listing examples, and sample sessions.

3. Bold, lowercase letters represent filenames, directory names, and programs. Words you are instructed to type appear in bold. Bold type style is also used for emphasis, generally in some types of lists.

4. Italic type identifies the titles of other books and names of chapters in this guide, and it is also used occasionally for emphasis.

   In syntax, italic text denotes a placeholder or variable for information you supply, as described below.

5. The symbols found in the syntax charts are used as follows:
   a. *italicized words* indicate items for which you substitute a specific value.
   b. **UPPERCASE WORDS** indicate items that you enter exactly as shown (although not necessarily in uppercase).
   c. ... indicates indefinite repetition of the last item.
   d. | separates alternatives (an either/or choice).
   e. [ ] enclose optional items or parameters.
   f. { } enclose a set of alternatives, one of which is required.
   g. {||} surround a set of unique alternatives, one or more of which is required, but each alternative may be specified only once; when multiple alternatives are specified, they may be specified in any order.

6. All punctuation must appear exactly as shown.
7. Key combinations, sometimes called shortcut keys, are connected by a plus sign (+), for example, Ctrl+X. This notation indicates that you press and hold down the first key while you press the second key. For example, “press Ctrl+X” means to press and hold down the Ctrl key while pressing the X key. Then release both keys.

8. The term “window” refers to a delineated area of the screen, normally smaller than the full screen. The term “Windows” refers to Microsoft 32-bit Windows operating systems. As you read through this guide, note that Liant may use two shorthand notations when referring to these operating systems. The term “Windows 9x class” refers to the Windows 95, Windows 98, or Windows Me operating system. The term “Windows NT class” refers to the Windows NT 4.0, Windows 2000, or Windows XP operating system.

9. RM/COBOL Compile and Runtime Command line options may be preceded by a hyphen. If any option is preceded by a hyphen, then a leading hyphen must precede all options. When assigning a value to an option, the equal sign is optional if leading hyphens are used.

10. In the electronic PDF file, this symbol represents a “post-it” note that allows you to view last-minute comments about a specific topic on the page in which it occurs. This same information is also contained in the readme text file under the section, Documentation Changes.

Double-click on the note symbols to open them. You can click the note window’s Close box after you have reviewed the contents. These notes can be viewed in the Adobe Acrobat Reader but will not print, although you can copy and paste the text into another application, such as Microsoft Word, if you wish.

Registration

Please take a moment to fill out and mail (or fax) the registration card you received with RM/COBOL. You can also complete this process by registering your Liant product online at: http://www.liant.com.

Registering your product entitles you to the following benefits:

- **Customer support.** Free 30-day telephone support, including direct access to support personnel and 24-hour message service.
- **Special upgrades.** Free media updates and upgrades within 60 days of purchase.
• **Product information.** Notification of upgrades, revisions, and enhancements as soon as they are released, as well as news about other product developments.

You can also receive up-to-date information about Liant and all its products via our Web site. Check back often for updated content.

---

**Technical Support**

Liant Software Corporation is dedicated to helping you achieve the highest possible performance from the RM/COBOL family of products. The technical support staff is committed to providing you prompt and professional service when you have problems or questions about your Liant products.

These technical support services are subject to Liant’s prices, terms, and conditions in place at the time the service is requested.

While it is not possible to maintain and support specific releases of all software indefinitely, we offer priority support for the most current release of each product. For customers who elect not to upgrade to the most current release of the products, support is provided on a limited basis, as time and resources allow.

**Support Guidelines**

When you need assistance, you can expedite your call by having the following information available for the technical support representative:

1. Company name and contact information.
2. Liant product serial number (found on the media label, registration card, or product banner message).
3. Product version number.
4. Operating system and version number.
5. Hardware, related equipment, and terminal type.
6. Exact message appearing on screen.
7. Concise explanation of the problem and process involved when the problem occurred.
Test Cases

You may be asked for an example (test case) that demonstrates the problem. Please remember the following guidelines when submitting a test case:

- The smaller the test case is, the faster we will be able to isolate the cause of the problem.
- Do not send full applications.
- Reduce the test case to one or two programs and as few data files as possible.
- If you have very large data files, write a small program to read in your current data files and to create new data files with as few records as necessary to reproduce the problem.
- Test the test case before sending it to us to ensure that you have included all the necessary components to recompile and run the test case. You may need to include an RM/COBOL configuration file.

When submitting your test case, please include the following items:

1. **README text file that explains the problems.** This file must include information regarding the hardware, operating system, and versions of all relevant software (including the operating system and all Liant products). It must also include step-by-step instructions to reproduce the behavior.

2. **Program source files.** We require source for any program that is called during the course of the test case. Be sure to include any copy files necessary for recompilation.

3. **Data files required by the programs.** These files should be as small as possible to reproduce the problem described in the test case.
Chapter 1: Installation and System Considerations

This chapter lists the hardware and software required to install CodeWatch for Windows and describes how to install the product.

System Requirements

Your computer configuration is the assembled set of hardware and software that makes up your system. Before you install CodeWatch, please make sure that your computer meets these minimum requirements.

Required Hardware

To run CodeWatch, you must have certain hardware installed on your computer. The system requirements include:

- An IBM PC or compatible machine with a Pentium-class processor or higher is required.
- A mouse or other pointing device.
- A minimum of 32 megabytes of random access memory (RAM). Depending on your configuration, CodeWatch may run with less memory, but this is not recommended.
- Five megabytes of disk space for the CodeWatch program and supporting dynamic-link libraries (DLLs), and for updating system libraries, as required.
- An 800 x 600 x 256 color display adapter. (1024 x 768 x 256 or better is recommended.) Adapters that support more than 256 colors will eliminate screen flashing as you move between programs.

*Note* Although CodeWatch will run in 640 x 480 x 256, this is not recommended.

- One CD-ROM drive and one double-sided, high-density 3.5-inch diskette drive for program installation.
Required Software
To run CodeWatch, you must have the following software installed on your computer:

- One of the following operating systems is required:
  - Microsoft Windows 95 OSR2
  - Microsoft Windows 98 or Windows 98 Second Edition (SE)
  - Microsoft Windows Millennium Edition (Me)
  - Microsoft Windows NT version 4.0 (Service Pack 6 or higher recommended)
  - Microsoft Windows 2000
  - Microsoft Windows XP

**Note** As you read through this guide, note that Liant may use two shorthand notations when referring to these operating systems. The term “Windows 9x class” refers to the Windows 95, Windows 98, or Windows Me operating system. The term “Windows NT class” refers to the Windows NT 4.0, Windows 2000, or Windows XP operating system.

- An RM/COBOL development system, version 7.5 or higher for 32-bit Windows.

System Installation
To install CodeWatch, you select a check box during the installation of the RM/COBOL version 7.5 for Windows development system. Using the RM/COBOL Setup program, follow the instructions on your screen.

If you did not install CodeWatch when you initially installed RM/COBOL, simply reinstall RM/COBOL with the CodeWatch option selected.

**Note** A separate installation procedure for CodeWatch is not available.
Chapter 2: Getting Started with CodeWatch

This chapter provides a quick start tutorial of CodeWatch. The tutorial is followed by a more in-depth, step-by-step walk through of a basic CodeWatch debugging session, including sections and exercises on how to:

- Start CodeWatch (see page 2-7)
- Configure a workspace (see page 2-12)
- View and edit program source (see page 2-16)
- Run the program (see page 2-18)
- Change the workspace (see page 2-28)
- Save the workspace (see page 2-28)

Quick Start Tutorial

This section presents an overview of the process of creating a new program in a basic CodeWatch debugging session. The steps include the following:

1. Start CodeWatch from the CodeWatch desktop icon, or click the Windows Start menu, select Programs, select RMCOBOL v7.50, and then click CodeWatch.

You will see the Workspace wizard, illustrated below. If you do not see the wizard, from the File menu, choose New | Workspace.
2. In the Workspace wizard, press the **New File** button. If you prefer, you can dismiss the wizard by pressing the **Cancel** button or the **Esc** key, and then choose **New** from the **File** menu or press **Ctrl+N**.

In either case, a blank page will appear in the CodeWatch main window.

3. From the **File** menu, choose **Save**. The Save As dialog box is displayed.

4. Choose the directory wherein you wish to work and then type **Hello.cbl** in the **File name** box.

5. Make sure that the **Add to Workspace** check box and the **COBOL Source File** option are selected.

6. Press **Enter** or click **Save**.

CodeWatch now knows that you are building a COBOL program and will wrap the source file in a workspace. Within the CodeWatch main window (see page 3-11), click in the Source Code/Edit window and enter the following program. Press the Tab key on the first line to move the cursor into column 8. The remaining lines will be indented automatically.

```
IDENTIFICATION DIVISION.
PROGRAM-ID. HELLO.
PROCEDURE DIVISION.
MAIN.
   DISPLAY "HELLO WORLD", LINE 5, ERASE.
```
The following figure illustrates your screen.

Note The icon for Hello.cbl on the Files tab is grayed and checked, which indicates that the file has not been compiled. Different elements of the program are colored on your screen: COBOL reserved words are black, strings of characters are cyan, and user-defined words are blue. The state indicator on the status bar indicates “IDLE.” (For more information, see the “Contents of the Source Code/Edit Window” topic on page 4-2.)

7. Compile the program by clicking in the Source Code/Edit window and choosing Compile File from the Build menu.

8. If you have not saved the program, you will be prompted to save your changes. Press the Y key or click Yes.

The file will be saved and compiled, and you will see the following in the CodeWatch main window.
Notice the following changes:

- In the Workspace window in the upper-left corner (Workspace 1:1, in this illustration), the icon to the left of *Hello.cbl* is now blue, indicating the file is ready to run. A new item, *Hello.COB*, has been inserted. This item represents the generated program file. To reveal the list of programs in the program file, click the [+] symbol; click on the [+] again to reveal a list of source and copy files used to generate each program.

- In the Source Code/Edit window, line numbers and diagnostic lines have been added to the source lines. A green dot to the left of a line number indicates that the statement is executable. Breakpoints should be placed only on executable statements.

- The Data window (Workspace 1:2, in this illustration) is now visible in the lower-left corner. This window contains various tabs that are discussed beginning on page 3-20. The **Build Results** tab has been selected and the window contains the results of the compilation.

- The Log window (Workspace 1:3, in this illustration) is visible in the lower-right corner. This window contains the output produced during the compilation.
9. Next, let’s run this program. From the **Run** menu, choose **Start** (or press **F5**). The following prompt will appear in the Select Main Program dialog box the first time this program has been run. Since this workspace contains only one program, only one program is listed.

![Select Main Program dialog box](image)

**Note** Clicking **More Options** opens the Program page (see page 3-62) of the Workspace Properties dialog box.

10. Click **OK**. CodeWatch will remember your choice. The CodeWatch main window will appear as shown below.

![CodeWatch main window](image)

Notice the following changes that have occurred:

- The line that contains the **MAIN** declaration is highlighted. This is the first statement in the program.

- If the Data window does not display call stack information, click the **Call Stack** tab. This area indicates that you are about to execute line 4 in the program, `HELLO`. The name of the program file or library is also visible.
The Log window displays the state of the Debugger. You can click in this window and manually issue RM/COBOL Debug commands, if you so choose.

The RM/COBOL runtime window has been created and may be partially visible behind the CodeWatch workspace.

The status bar indicator now indicates “READY.”

11. To set a breakpoint, click anywhere in line 00005 and from the Run menu, choose Breakpoint | Set or press F9.

A solid red circle will appear to the left of the line number to indicate that a breakpoint has been set.

12. In the Data window, click the Breakpoints tab. This area indicates that execution will stop at line 5 in program HELLO.

13. From the Run menu, choose Resume or press F5 to run the program. The highlight will advance to the line containing the breakpoint and execution will stop.

14. To single-step the program, choose Step Statement or press F8 from the Run menu.

You should see HELLO WORLD in the RM/COBOL runtime window. (If this window is not visible, press F12 to bring it to the front.)

15. Click anywhere in the CodeWatch main window and press F8 to step again, or press F5 to run the program to completion.

The RM/COBOL runtime window will close and CodeWatch will be “IDLE” again.

16. To exit CodeWatch, choose Exit from the File menu.

17. At the prompt to save your changes to Workspace1, click Yes and give the workspace a name (for example, Hello).

The workspace will be saved as a workspace file, Hello.cwf, and may be quickly reloaded later (see “Starting CodeWatch Using a Saved Workspace” on page 2-8).
Starting CodeWatch

When you install CodeWatch, the Setup program automatically creates a new program group and new program items for CodeWatch in Windows. You have a number of choices for starting CodeWatch, including the following:

- Starting CodeWatch from Windows (see the following topic)
- Starting CodeWatch using a saved workspace (see page 2-8)
- Starting CodeWatch from an MS-DOS environment (see page 2-9)
- Starting CodeWatch with a Runtime Command line (see page 2-10)

Starting CodeWatch from Windows

If you have started and are running Windows, use one of the following methods to start CodeWatch:

- Click the Windows Start menu (usually located at the bottom left corner of your screen), point to Programs, point to RMCOBOL v7.50, and then click CodeWatch.
- Click the Windows Start menu, choose Run, and then enter rmcw.exe in the Run dialog box.
- From Windows Explorer, double-click the CodeWatch icon (rmcw75.exe) that was created by the installation procedure.
- If you elected to create and put a CodeWatch icon (a shortcut) on your desktop during installation, double-click the icon.

Using these methods, CodeWatch normally opens the Workspace wizard to help you establish and configure a workspace for the session (see page 2-12).
Starting CodeWatch Using a Saved Workspace

You may also start CodeWatch by opening an existing workspace file:

- From Windows Explorer, double-click a saved CodeWatch workspace file (workspace files have an extension of .cwf, which represents CodeWatch Workspace File).

- Alternatively, right-click the workspace file in Windows Explorer and select Open from the pop-up context-sensitive menu. This method allows you to resume debugging using the same set of configuration options, program files, program libraries, and source files that you used when you saved the workspace in a previous CodeWatch session.

  Note: Using Windows Explorer to start a saved workspace requires that the workspace file extension be registered with Windows. If the .cwf files are no longer associated with CodeWatch, you can still launch CodeWatch with a saved workspace by dragging and dropping a saved workspace file onto the CodeWatch icon. It may be necessary to use this technique if you run other applications that also use the .cwf file type for document files. Installing CodeWatch again will re-associate the .cwf extension with CodeWatch.

- To start CodeWatch with a previously saved CodeWatch workspace, using a command line, enter:

  \[ \text{rmcw \: filename.cwf} \]

  This command causes CodeWatch to open the specified workspace file. The .cwf extension must be specified, because it uniquely identifies this command line format.

When you start CodeWatch using a saved workspace file, there are several considerations to keep in mind:

- Workspace files are ASCII text files and can be carefully edited outside of CodeWatch. (For additional information, see page 4-12.)

- To avoid ambiguity, COBOL programs should not use the .cwf extension.

- If the filename contains a space, the entire filename must be enclosed in double quotes.
Starting CodeWatch from an MS-DOS Environment

You may occasionally want to start CodeWatch from an MS-DOS environment. Starting CodeWatch from the DOS command line provides several options:

- To start CodeWatch from the command line, enter:
  ```
  start rmcw
  ```
  The Workspace wizard is displayed unless it has been disabled, as described in the following item.

- To start CodeWatch without displaying the Workspace wizard, enter:
  ```
  start rmcw /n
  ```
  or
  ```
  start rmcw -n
  ```

- To start CodeWatch with the name of a saved workspace file:
  ```
  start *rmcw filename.cwf
  ```

**Note** To invoke the Workspace wizard at any time, from the **File** menu, choose **New** and then **Workspace**. If a workspace is currently open, do one of the following to invoke the wizard:

- From the **File** menu, choose **Workspace** and then click **New**.
- From the **File** menu, choose **Workspace** and then click **Properties**.

CodeWatch also may be started with a Runtime Command line, as described in the next section.
Starting CodeWatch with a Runtime Command Line

Note CodeWatch command line parameter options may be specified when CodeWatch is started from a DOS command line, from the Windows Start | Run menu, or within a Windows shortcut icon.

To start CodeWatch with an RM/COBOL Runtime Command line, enter:

```
start rmcw runcobol-command-line
```

This command creates a workspace using the RM/COBOL runtime options specified in runcobol-command-line. Note that runcobol-command-line should not include the name of the runtime itself, but may include any runcobol options. For example:

```
start rmcw mainprog L=lib\lib1.cob L=lib2.cob C=myconfig.cfg
```

or the equivalent:

```
start rmcw mainprog /L lib\lib1.cob /L lib2.cob /C mycfg.cfg
```

When you start CodeWatch with a Runtime Command line, there are several considerations to keep in mind:

- CodeWatch accepts either the DOS or UNIX style, but the two styles cannot be mixed in a single command. See Chapter 7, Running, of the RM/COBOL User’s Guide, for a complete description of the Runtime Command line syntax.

- A dash (-) may be used instead of a slash (/) in the UNIX style, and the option letters are not case-sensitive in either style.

- If a filename contains a space, the entire filename must be enclosed in double quotes.

- The /D (Debug) Runtime Command Option is always assumed to be present, even if not specified. This allows rmcw to be used instead of runcobol in existing batch scripts. The /D Option may be disabled by choosing Properties from the File menu and selecting the No Debug option on the Program page (see page 3-62) of the Workspace Properties dialog box.

- As is true with the RM/COBOL runtime system, some options cannot be set from the DOS command line when using CodeWatch. It may be necessary to define RMPATH, RUNPATH, or other environment variables in the Workspace Properties dialog box to completely replicate the execution environment. To open the Workspace Properties dialog box, choose Workspace | Properties from the File menu. Programs running under CodeWatch also inherit any previously set environment variables.
Exercise 1—Start CodeWatch

To start CodeWatch:

1. Start Microsoft Windows.

2. Click the Windows **Start** menu, point to **Programs**, point to **RMCOBOL v7.50**, and then click **CodeWatch**.

3. CodeWatch starts and displays the first page of the Workspace wizard. By default, the **Create Empty Workspace** option is selected.

To navigate quickly through the other pages of the Workspace wizard, press **Enter**. (The options on all these pages of the Workspace wizard are described in more detail beginning on page 3-1.) Once you save a workspace, the next time the wizard opens you will see a list of recently used configurations in the **Recent Workspaces** list. This allows you to select the **Use a Saved Workspace** option and then choose a saved workspace (with preset options) from the list, which can be used as a template, if desired, for a new workspace.

**Tip** To enter an RM/COBOL Runtime Command line quickly, click the **Command** button in the Workspace wizard. In the Set/Edit Command Line dialog box, type the command line in the edit box. Be sure to start with the name of the main program or program file. When you click **OK**, the fields in the Workspace wizard will be filled in from the command line that you entered. While the wizard is open, you can also press the **Command** button at any time to view or directly change the command line.

See the next section and exercise for steps on how to create (configure) a new workspace.
Configuring a Workspace

Once you have started CodeWatch, you will need to tell CodeWatch how to run your program. At a minimum, CodeWatch needs to know the name of your main program or program file and the directory where you wish to run the program. However, most RM/COBOL applications consist of many separately compiled programs and have additional requirements, which include:

- COBOL program files and libraries
- Configuration files
- Filename synonyms and other environment variables
- Runtime Command line options
- Source files
- Compilation options
- Directories to search for program files and source files

CodeWatch combines all of this information, and more, into a workspace. For convenience, a workspace can be saved to a file for later retrieval.

There are several ways to create a new workspace:

- Start CodeWatch using any of the methods discussed beginning on page 2-7 without any runtime command line options specified.
- Start CodeWatch with a `runcobol` command line (see page 2-10).
- If CodeWatch is already running, from the File menu, choose Workspace | New.

The Workspace wizard opens and then leads you through the process of creating the workspace. The name of the program or program file you wish to run is all that is required (although the execution directory may also need to be specified).

Note You can bypass the Workspace wizard by clicking on the Command button in the wizard and entering a command line. To start CodeWatch without starting the wizard, specify `/n` on the command line (see page 2-9).
Exercise 2—Configure a Workspace with the Workspace Wizard

In this exercise, you will configure a workspace using the Workspace wizard.

1. Continuing from Exercise 1 on page 2-11, on the Introduction (or first) page of the wizard, click Next or press Enter. The Select Program page is displayed.

2. Type verify in the Program to Run text box.

3. If you started CodeWatch from the Windows Start menu or Windows Explorer, the current directory will be set correctly. If not, enter the name of the directory where CodeWatch is installed in the Execution Directory field. Typically, this entry will be “C:\Program Files\RMCOBOL”.

4. Click Next or press Enter to move to the Set Additional Options page. This page allows you to enter program arguments or select configuration files. In this exercise, it is not necessary to change any of these settings.
5. Click **Next** or press **Enter** to move to the **Set Execution Environment** page.

On this page, you can do one or more of the following:

<table>
<thead>
<tr>
<th><strong>Click this tab</strong></th>
<th><strong>To specify the</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Libraries</td>
<td>COBOL program and dynamic-link libraries (DLLs). (This is equivalent to using the L= Runtime Command Option.)</td>
</tr>
<tr>
<td>Run Path</td>
<td>Directories to place into the RUNPATH environment variable. These directories are searched in the specified order to locate RM/COBOL programs (.cob) and application data files.</td>
</tr>
<tr>
<td>Program</td>
<td>Contents of the PATH environment variable. These are searched in the specified order to locate applications (.exe, .com, and .bat) and application extensions (.dll).</td>
</tr>
<tr>
<td>Environment</td>
<td>Additional options to place into the DOS environment, such as filename aliases (synonyms). This feature is provided for backward compatibility. Liant recommends that aliases be placed in the Windows registry file using the RM/COBOL registration utility (rmconfig.exe). For more information, refer to the “Windows Registry” and “Setting Synonym Properties” topics in Chapter 3, <em>Installation and System Considerations for Windows</em>, of the RM/COBOL User’s Guide.</td>
</tr>
<tr>
<td>Source</td>
<td>List of directories to be searched for source files. This list is used if a source file cannot be located using the information embedded in the program file or library file. These directories are also placed in the RMPATH environment variable when compiling files and are used by the compiler to locate source and copy files.</td>
</tr>
</tbody>
</table>
Tip 1  Remember that you can press Command at any time from within the Workspace wizard and manually enter options using the Runtime Command line syntax. You can also view the command line that will be used to run the program by clicking this button.

Tip 2  Once the wizard is closed, you can change runtime options at any time. From the File menu, choose Workspace | Properties to open the Workspace Properties dialog box (see page 3-61 for more information).

6. For this example, do not change any settings on the Set Execution Environment page. Simply click Finish or press Enter.

Configuration of a workspace is now complete. The Workspace window, displayed on the left side of the frame of the CodeWatch main window, shows the contents of your CodeWatch workspace.

The only item in the Main Program folder is the name of the main sample program, <verify>. The angle brackets indicate that possible ambiguities related to the program name have not been resolved; that is, verify may refer either to a standalone program named VERIFY.COB or to a program named verify in a COBOL library that has not yet been configured. CodeWatch cannot resolve these ambiguities until execution begins, as you may not yet have completed configuring the workspace.
Viewing and Editing Program Source

You can view or edit the source for a program by double-clicking the name of the program, or the name of the program file in any window where the name appears. You can also directly open the source for a program file, a library file, or a source file listed in the Workspace window.

If the source file does not appear, it may be due to one of the following reasons:

- The program or library was not compiled with the Full Debug Information (Y=2 or Y=3) Compile Command line option (see Chapter 6, Compiling, in the RM/COBOL User's Guide).
- The source file is not in the same location as when the file was originally compiled, and it could not be located using the search sequence described in the following exercise.
- There are program name ambiguities that have not yet been resolved. In this case, the name is shown in angle brackets.

Exercise 3—Locate Source Files

To locate the source file for a COBOL program, CodeWatch uses the following search sequence:

1. First, the absolute path of the source file that was used to produce the program file is searched. Note that the file might have been compiled on a different computer, and, therefore, may not be found on this computer using this technique.

2. Then, the directory that contains the program file is searched, even if the source file was not compiled in this directory.

3. Next, the current working directory is searched.
4. Finally, each directory in the workspace **Source Path** list is searched. To view and add directories to this list, take the following steps:

   a. From the **File** menu, click **Workspace | Properties** or click the **Workspace Properties** toolbar button to display the Workspace Properties dialog box.

   b. In the Workspace Properties dialog box, click the **Environment** tab.

   c. On the Environment page, click the **Source** tab.

   d. Click the **New (Insert)** button (or double-click on the first blank line in the list box) to add a new line.

   e. Type the name of the directory that contains your source file and press **Enter**. If necessary, click the ellipsis button at the end of the line to open a Select Directory dialog box where you can search for and select the directory.

   f. To insert additional directories, click the **Move Down** button (or press **Alt+Down Arrow**) and then click in the list box.

      **Note** You can reorder the list of directories by making a selection and pressing the **Move Up** and **Move Down** buttons (or the shortcut keys, **Alt+Up Arrow** and **Alt+Down Arrow**, respectively) or by dragging the items in the list with the mouse.

   g. Click **OK** to close the Workspace Properties dialog box.

   **WARNING** CodeWatch will load the first occurrence of a given filename that is found when following this search sequence. It is possible that an incorrect file will be displayed if another file of the same name is found first.
Once the workspace has been created, you can run the program. Program files may be produced either by CodeWatch using the Build menu or outside CodeWatch by the standalone RM/COBOL compiler. Note that, in order for CodeWatch to display the source for a program, the RM/COBOL compiler /Y2 or /Y3 options must be used.

For the example workspace, it is not necessary to configure any COBOL libraries since verify is a standalone program and is ready to run.

As you run your program, you can also perform the following tasks:

- Animate the program (see page 2-22)
- Control the program execution (see page 2-22)
- Set breakpoints (see page 2-23)
- Examine watchpoints (see page 2-24)
- Inspect and modify data (see page 2-26)
- Stop the program (see page 2-27)

Exercise 4—Run the Program

1. To start the program, do one of the following:
   - Press F5 (the easiest way to run the program).
   - From the Run menu, choose Start.
   - Click the Run toolbar button.

CodeWatch will load the RM/COBOL runtime system using the workspace options you specified in the previous exercise. The runtime, in turn, locates and loads program verify. Once the RM/COBOL runtime has been started successfully, in addition to the Workspace window, three new windows will be visible, as shown in the following figure.
Counterclockwise from the upper left, the following windows are displayed:

- **Workspace window.** Note that the angle brackets around program `<verify>` have been removed and that the name `verify` is shown in lowercase because the program ID was written quoted in lowercase when the program was compiled. A new item, `VERIFY.COB`, has been added to the Program Files folder listed on the Files tab. The `verify` program was located in the file `VERIFY.COB` in the current directory.

Click the Files tab, then [+], if necessary, to expand the item. You will see a list of objects in the COBOL library. In this case, `VERIFY.COB` contains only one program named `verify`. Because the program was compiled with the Full Debug Information (Y=2 or Y=3) Compile Command line option, an icon for the source file is also displayed.

- **Data window.** This window contains a set of five tabs: Breakpoints, Watchpoints, Data Files, Call Stack, and Build Results. Click a tab to view the available options and settings for each.
- **Log window.** This window allows you to interact with the RM/COBOL symbolic Debugger using a command line. You can click in this window and type RM/COBOL Debug commands while the program is running. This window is also used by the compiler to display progress messages during a build operation.

- **Source Code/Edit Window.** This window displays the source for the program that you are currently running. While you are debugging, the statement that is about to be executed is highlighted. To display multiple Source Code/Edit windows simultaneously, simply click the **Restore** button in the upper-right corner of the title bar. You may have as many Source Code/Edit windows visible simultaneously as you like, or you can maximize the window and see as much of a single source file at one time as possible. To maximize the window, click the **Maximize** button or double-click the title in the Source Code/Edit window.

You can also split a Source Code/Edit window either horizontally or vertically. From the **Window** menu, choose **Split.** Alternatively, you can drag the splitter bar next to the vertical or horizontal scroll bar to split the window. Splitting the window allows you to see non-adjacent sections in a source file.

You can open the source for any program for which source is available by double-clicking the source file, program file, or library file icon in the Files tab of the Workspace window, or the program in the Programs tab of the Workspace window.

**Note** These windows are described in more detail in Chapter 3, *CodeWatch Interface*, and Chapter 4, *Source Code Editor.*
2. Once the program has been started, you can continue to run the program in any of the following ways:

<table>
<thead>
<tr>
<th>To run</th>
<th>Choose</th>
<th>Or click</th>
</tr>
</thead>
<tbody>
<tr>
<td>To the next breakpoint, watchpoint, end of program, or until you choose to break the program</td>
<td>Resume on the Run menu or press F5</td>
<td>Run</td>
</tr>
<tr>
<td>One statement</td>
<td>Step Statement on the Run menu or press F8</td>
<td>Step Statement</td>
</tr>
<tr>
<td>One paragraph or to the end of the current paragraph</td>
<td>Step Paragraph on the Run menu or press Shift+F8</td>
<td>Step Paragraph</td>
</tr>
<tr>
<td>One section or to the end of the current section</td>
<td>Step Section on the Run menu or press Ctrl+F8</td>
<td>Step Section</td>
</tr>
<tr>
<td>To the end of this program</td>
<td>Step Program on the Run menu or press Alt+F8</td>
<td>Step Program</td>
</tr>
<tr>
<td>To run to the line containing the cursor in the Source Code/Edit window</td>
<td>To Cursor on the Run menu or press Shift+F5</td>
<td>Run to Cursor</td>
</tr>
<tr>
<td>To run to the next program (Note that this is either the next program called from within this program or the program that called the current program.)</td>
<td>To Program Change from the Run menu or press Alt+F5</td>
<td>Run To Program Change</td>
</tr>
</tbody>
</table>
Animating the Program

The animation feature determines whether CodeWatch will trace program execution while running. When enabled, CodeWatch opens the source code for each program in a Source Code/Edit window and highlights each line as it is executed. While this is beneficial for visually observing the flow of control within your program, there is a significant performance penalty for running the program with animation enabled.

Note You can turn animation on and off at any time during program execution.

Exercise 5—Animate the Program

- Continuing from Exercise 4 on page 2-18, click Animate from the Run menu to toggle animation on or click the Animate toolbar button.

  Note To indicate that this option is selected, a check mark appears next to the menu command.

Controlling the Flow of Execution

Once the program begins to execute, CodeWatch will run the program until one of the following events occurs:

- A breakpoint is encountered during execution.
- A watchpoint is encountered during execution.
- The operation has completed, if you are stepping across lines, paragraphs, or sections.
- You tell the program to stop running by choosing Break from the Run menu.
- The program terminates for one of the following reasons:
  - You choose Stop from the Run menu.
  - The end of the RM/COBOL program is reached.
  - An error occurs in the RM/COBOL program.
  - You terminate CodeWatch or close the CodeWatch main window.

If the program halts for any of the above reasons except for the last, you can resume program execution with the Resume command from the Run menu or any of the other commands on the Run menu. Alternatively, you can choose Stop from the Run menu to terminate the program. (For more information on the Run menu commands, see page 3-57.)
Setting Breakpoints

A breakpoint causes program execution to pause, which gives you the opportunity to look around at the program, examine variables, or set additional breakpoints.

Breakpoints are part of the workspace and are, therefore, saved and loaded with the workspace. Any breakpoints that are set when you save a workspace will be set the next time you open the workspace.

Breakpoints are set by program name, line number, and statement number. If you have two programs in your workspace with identical names, and both programs contain the line number on which the breakpoint was set, execution will stop at both lines.

If a line contains a breakpoint, the Source Code Editor displays a red circle in front of the line number. The breakpoint is also reported in the Breakpoints tab of the Data window (see page 3-21). If the breakpoint is enabled, the red circle is solid; if the breakpoint is disabled, the red circle is hollow.

Exercise 6—Set a Breakpoint

1. Continuing from Exercise 5 on page 2-22, scroll down through the Source Code/Edit window until DISPLAY-MAIN-MENU is visible.

2. To set a breakpoint, click anywhere in the line and press the F9 key.

   A red circle appears to the left of the line number and the breakpoint appears in the Breakpoints tab.

**Note** In addition to pressing F9, you can set breakpoints by using any of the following methods:

- Click on the line in the Source Code/Edit window and choose **Breakpoint | Set** from the Run menu, or click the **Toggle Breakpoint** toolbar button.

- Right-click anywhere in the line in the Source Code/Edit window and choose **Set Breakpoint** from the pop-up menu. Note that you can also remove breakpoints, or temporarily disable and later enable breakpoints by using this menu.

- Press Ctrl+B or click the **Edit Breakpoints** toolbar button to display the Breakpoints & Watchpoints dialog box and interactively set, remove, or modify breakpoints using the Code Breakpoints page (see page 3-69).

- Display the Breakpoints tab (see page 3-21) in the Data window (choose **Breakpoints Tab** from the View menu or press Alt+1 to display this tab in the window, if not visible). Then, press Ins to insert a new breakpoint, Del to delete a
breakpoint, click the icon (solid red circle) to enable or disable a breakpoint, or press F2 to examine or change a breakpoint’s properties in the Code Breakpoints page of the Breakpoints & Watchpoints dialog box.

- Alternatively, you can cause a break at any time by choosing Break from the Run menu, pressing F5, or by clicking the Run toolbar button again while the program is running.

### Setting Watchpoints

A watchpoint allows you to examine or modify the contents of your COBOL data items. Watchpoints are displayed in the Watchpoints tab in the Data window (see page 3-23) and are updated whenever a program break occurs. You can also request that a program break occur when there is a change in the value of the data item being watched.

Watchpoints are part of the workspace and are, therefore, saved and loaded with the workspace. Any watchpoints that are set when you save a workspace will be set the next time you open the workspace.

#### Exercise 7—Set a Watchpoint

1. Continuing from Exercise 6 on page 2-23, scroll down through the Source Code/Edit window until ACCEPT-MAIN-MENU is visible.

2. Double-click on FUNCTION-NUMBER on the next line to highlight the word.

3. Right-click and choose **Watch Data Item** from the pop-up menu to set the watchpoint.

   The Data window switches to the Watchpoints tab. FUNCTION-NUMBER and its location, data type, and present value appear in the window.

4. Click on FUNCTION-NUMBER in the Watchpoints tab and press the **Spacebar** so that execution will stop when the value in FUNCTION-NUMBER changes.

   Alternatively, single click on the solid red circle to left of the data item name. It will turn into a hollow circle.

5. Choose **Resume** from the Run menu, click the Run toolbar button, or press **F5** to run the program.

Since animation is enabled, CodeWatch displays each line as it is executed. When the ACCEPT RETURN-KEY statement is reached, the RM/COBOL program output window will appear.
6. Press **Enter** and CodeWatch will stop at the watchpoint that you set on the ACCEPT-MAIN-MENU line.

7. Press **F5** to continue execution.
   
The runtime will request a test number.

8. Type **3** and press **Enter**.
   
Execution will stop again because FUNCTION-NUMBER has changed.

9. Choose **Step Statement** from the **Run** menu, click the **Step Statement** toolbar button, or press **F8** to step over the current statement.

10. Press **F8** again and you should see INIT-PARA in program **NUCTEST**.

   The program **NUCTEST** has now been added to the Called Programs folder in the Workspace window, and the program file **NUCTEST.COB** has been added to the list of program files in the Workspace window.

**Note** In addition to the method described in the preceding exercise, you can set watchpoints by using any of the following methods:

- Highlight and then right-click a data item name in any Source Code/Edit window and choose **Watch Data Item** or press **Alt+F9** from the pop-up context menu.

- Double-click a data item name in any Source Code/Edit window to display the Inspect/Modify dialog box. After examining and possibly modifying the value, you can click the **Watch** button in that dialog box to set a watchpoint (see page 2-26).

- Press **Ctrl+W** or click the **Edit Watchpoints** toolbar button to display the Breakpoints & Watchpoints dialog box and interactively add, remove, modify, or enable or disable a program break when the value of the watchpoint changes using the Data Watchpoints page (see page 3-71).

- Display the Watchpoints tab (see page 3-23) in the Data window (choose **Watchpoints Tab** from the **View** menu or press **Alt+2** to display this tab in the window, if not visible). Then, press **Ins** to insert a new watchpoint, **Del** to delete a watchpoint, click the icon (solid red circle) to enable or disable a watchpoint, or press **F2** to change a watchpoint’s properties in the Data Watchpoints page of the Breakpoints & Watchpoints dialog box.
Inspecting and Modifying Data

CodeBridge provides the Inspect/Modify dialog box, illustrated below, for inspecting and modifying data.

Any of the following actions cause the Inspect/Modify dialog box to appear:

- In a Source Code/Edit window, double-click the name of a data item, or select a data item and then double-click within the selection.
- In a Source Code/Edit window, select a data item and then right-click within the selection and choose View Data Item from the pop-up menu, or press Ctrl+I or Shift+F9.
- From the View menu, choose Data Item.

Exercise 8—Select a Data Item

If you have not yet selected a data item, take the following steps:

1. Type an identifier in the Name text box.
   
   **Note** See “Data Address Development” in Chapter 9, Debugging, of the RM/COBOL User’s Guide, for a description of allowed expressions.

2. In the Type list box (this is an optional field), select or enter a data type. See “Data Types” under the “General Debug Concepts” section in Chapter 9, Debugging, of the RM/COBOL User’s Guide, for a description of allowed data types.

3. Click Show or press Enter.
   
   The current value of the identifier is then displayed in the Show text box using either the selected type or the actual type of the identifier. If the identifier cannot be displayed, an error message is displayed in red. Note that the program must be
running and the identifier must be “in scope” (see page 3-43) before a value can be displayed.

To change the value of a data item:

- In the **Show** text box, type the new value and click **Change**.

  Be sure that the entered value is compatible with the displayed data type. You can also change the type before clicking **Change** to set the type using a different encoding style (for example, hexadecimal).

  **Note** The **Change** button is not enabled if the data item being inspected is a constant-name. Also note that you can select text with the cursor keys in either the **Name** or the **Show** text box, and right-click to pop up a menu that allows text to be copied to the Windows Clipboard or pasted from the Clipboard. You can use this technique to copy the contents of one data item into another data item.

To set a watchpoint for the data item:

- Click **Watch**.

  This is a convenient way to set a watchpoint on an item other than a simple variable; for example, a group item or an array element.

### Stopping the Program

There are several methods you can use to stop your program.

#### Exercise 9—Stop the Program

1. From the **Run** menu, choose **Stop** or click the **Stop Run** toolbar button.

   This action sends a stop request to the RM/COBOL runtime system. The runtime will display a termination message in the RM/COBOL program output window. If this is the case, single-step or choose **Stop** again to dismiss the output window.

   **Note** If you have set the Persistent runtime property, you will have to close the RM/COBOL program output window manually. See Chapter 3, *Installation and System Considerations for Microsoft Windows*, of the RM/COBOL User’s Guide.

2. Switch to the RM/COBOL program output window and close the window.

   **Note** Closing either the Workspace window or the CodeWatch main window will also stop the program.
Changing the Workspace

It is often desirable to change properties or runtime options, or add libraries to a workspace after it has already been created.

To change the workspace:

1. From the File menu, choose Workspace | Properties.

   The Workspace Properties dialog box appears (see page 3-61). This tabbed dialog box contains the same options that are displayed on the pages of the Workspace wizard.

2. In the Workspace Properties dialog box, select the page for the property that you want to change.

Saving the Workspace

To save the workspace for a subsequent debugging session:

- From the File menu, choose Workspace | Save or press Ctrl+Shift+S.

CodeWatch will prompt you for a name if the workspace has not previously been saved.

To save the workspace under a new name:

1. From the File menu, choose Workspace | Save As or press Ctrl+Shift+A.

2. At the prompt, enter a new name for the workspace.

3. Click OK.

   The workspace is saved with the new name.

The workspace is saved in a file with an extension of .cwf (CodeWatch Workspace File). This file is an ASCII text file that can be examined and modified with any text editor. If you have a COBOL application with a large number of libraries, it may, in some cases, be easier to create a workspace, close CodeWatch, and then add the libraries to the workspace file using a text editor. This practice, however, is not recommended.

Note When you close CodeWatch or the Workspace window, you will be prompted to save the workspace if any changes have been made.
Chapter 3: CodeWatch Interface

This chapter provides detailed descriptions of the Workspace wizard, and the various windows, dialog boxes, menus, and toolbars found in CodeWatch.

CodeWatch Workspace Wizard

The Workspace wizard helps guide you through the steps to create (configure) a new workspace. A workspace contains the name of your main program or program file and the directory where you wish to run the program. A workspace can also include information about COBOL program files and libraries; configuration files; filename synonyms and other environment variables; Runtime Command line options; source files; compilation options; and directories to search for program files and source files. A workspace is displayed in a Workspace window in the CodeWatch main window (see page 3-11). Workspace files have a .cwf filename extension.

Note CodeWatch does not require that you configure a workspace before you open or create a source file. It will create a default workspace, as required.

The CodeWatch Workspace wizard is displayed when you start CodeWatch without a command line parameter. If CodeWatch is running and no workspace is open, you can display the wizard by choosing the New | Workspace command from the File menu. (For more information on “Starting CodeWatch”, see page 2-7.)

If a workspace is already open for the session, choose Workspace | New from the File menu to open the wizard. However, since only one workspace may be open at a time, the workspace must be closed before you can open or create a new one. CodeWatch will prompt you to save the workspace if the workspace has not previously been saved, or has been changed since the last save. You may also save and close the workspace by choosing the Workspace | Save command from the File menu. To save and rename the workspace, choose Workspace | Save As from the File menu.
The Workspace wizard consists of four pages: Introduction, Select Program, Set Additional Options, and Set Execution Environment. Several buttons appear along the bottom of the Workspace wizard no matter which page is selected and displayed. They perform the same function or action on all the pages of the wizard and are described below.

<table>
<thead>
<tr>
<th>Use this button</th>
<th>To</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Command</strong></td>
<td>Open the Select/Edit Command Line dialog box where you can view or edit the RM/COBOL Runtime Command line options. This option is for advanced users.</td>
</tr>
<tr>
<td><img src="image" alt="command" /></td>
<td>Cancel the Workspace wizard and create a new source file. A workspace can automatically be created when the file is saved.</td>
</tr>
</tbody>
</table>
| ![command](image) | Cancel the Workspace wizard and display an Open a COBOL File or a Workspace dialog box where you can open an existing workspace file or any text file into the Source Code/Edit window. Select the Add to Workspace check box to create a workspace automatically for one of the following files:  
  - COBOL Source File  
  - COBOL Copy File  
  - COBOL Program File  
  - COBOL Program Library File  
 You can then use either the Open or Insert Items command from the File menu to add more files to the workspace. In all the cases above, the working directory is set to the directory containing the file. |
| ![command](image) | To configure the workspace (see page 3-61), choose Workspace | Properties from the File menu. See also “Configuring a Workspace” on page 2-12. |
| **Back**        | Display the previous page of the wizard. (Note that this button is grayed out on the first page of the wizard.) |
| **Next**        | Display the next page of the wizard. (Note that this button does not appear on the last page of the wizard.) |
| **Finish**      | Create the workspace using the settings from this and the preceding pages. (Note that this button appears only on the last page of the wizard.) |
| **Cancel**      | Cancel the wizard. |
| **Help**        | Display help for this page of the wizard. |
Introduction Page

This page introduces the Workspace wizard and allows you to select a computer to host the new workspace. You can also select a saved workspace that will be used as a template for the new workspace.

<table>
<thead>
<tr>
<th>Use this option</th>
<th>To</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create Empty Workspace</td>
<td>Create a new workspace without initializing any of the options on the subsequent pages of the Workspace wizard.</td>
</tr>
<tr>
<td>Choose a Host</td>
<td>Choose a host machine for the development debugging session. Note that this option is intended for future use, and is available only if the remote development extensions have been installed.</td>
</tr>
<tr>
<td>New</td>
<td>Open the New Host dialog box where you can add and set the attributes of a new host machine. Note that this option is intended for future use, and is available only if the remote development extensions have been installed.</td>
</tr>
<tr>
<td>Edit</td>
<td>Open the Edit Host dialog box where you can change the attributes of the selected host machine. Note that this option is intended for future use, and is available only if the remote development extensions have been installed.</td>
</tr>
<tr>
<td></td>
<td>Remove the selected host machine from the list. Note that this option is intended for future use, and is available only if the remote development extensions have been installed.</td>
</tr>
<tr>
<td>Use a Saved Workspace</td>
<td>Choose a saved workspace from the list of your most recently used workspaces. The settings of the saved workspace will be used to create the new workspace. Note This option simply reads the preset options from the previous workspace. It does not open the workspace.</td>
</tr>
<tr>
<td>Use this option</td>
<td>To</td>
</tr>
<tr>
<td>-------------------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Recent Workspaces</strong></td>
<td>Select a workspace file (.cwf) from the list of recently used workspaces on the selected computer.</td>
</tr>
<tr>
<td><strong>Other</strong></td>
<td>Open the Select a Workspace File dialog box and search for saved workspaces that are not in the recently used list.</td>
</tr>
<tr>
<td><strong>X</strong></td>
<td>Remove the selected workspace from the list of recently used workspaces. This action does not delete the actual workspace file from your disk, but is useful for removing workspaces that no longer exist from this list.</td>
</tr>
<tr>
<td><strong>Show this Wizard when starting CodeWatch</strong></td>
<td>Determine whether the Workspace wizard is displayed when CodeWatch is started.</td>
</tr>
</tbody>
</table>

For a description of the buttons that appear along the bottom of this page of the Workspace wizard, see page 3-2.
**Select Program Page**

The Select Program page of the Workspace wizard, illustrated below, allows you to select a program to run and to define the execution environment for the program.

![Select Program Page](image)

<table>
<thead>
<tr>
<th>Use this option</th>
<th>To</th>
</tr>
</thead>
<tbody>
<tr>
<td>Program to Run</td>
<td>Type or select the name of the COBOL program that CodeWatch is to run. This can be one of the following:</td>
</tr>
<tr>
<td></td>
<td>• The filename of a COBOL program file (for example, VERIFY.COB).</td>
</tr>
<tr>
<td></td>
<td>• The name of a COBOL program to be found in a COBOL library file (for example, VERIFY).</td>
</tr>
<tr>
<td></td>
<td>CodeWatch uses the RM/COBOL runtime to locate programs (see the “Subprogram Loading” topic in Chapter 8, RM/COBOL Features, of the RM/COBOL User’s Guide, for a complete description of the methods). For example, if VERIFY is specified as the program to run, and VERIFY is not found in any configured library, then the RM/COBOL runtime system will optionally search for a synonym for VERIFY in the environment, and will then search for a file named VERIFY.COB that contains exactly one separately compiled COBOL program in the current directory, the PATH, and the RUNPATH. CodeWatch does not attempt to resolve an ambiguous main program name until execution begins.</td>
</tr>
<tr>
<td></td>
<td>This box may be left blank. If a main program is not specified, you will be asked for the program name when you run the workspace.</td>
</tr>
<tr>
<td>Browse</td>
<td>Open the Select a Program File dialog box where you can search for and select a COBOL program file (.cob).</td>
</tr>
</tbody>
</table>
**Use this option** | **To**
--- | ---
No Debug | When selected, disable debugging. (The /D Runtime Command Option is always assumed to be present unless you disable it.) The program will be run as if CodeWatch were not present, using the parameters in the workspace.
Use Instrumentation | When selected, enable instrumentation. This option is equivalent to the /I Runtime Command Option.
Execution Directory | Select the current directory at the time the COBOL program begins execution. This selection can be one of three values:
  - **CodeWatch Startup Directory.** The runtime will be started in the directory where CodeWatch was started, which is the default.
  - **Runtime Installation Directory.** The runtime will be started in the directory where the RM/COBOL runtime was installed.
  - **Actual Directory Name.** The fully or partially qualified pathname of a directory. If you enter a relative pathname in this list box, it is interpreted as being relative to the CodeWatch startup directory.
Browse | Open a Browse for Folder dialog box where you can search for and select an execution directory.
Switches | Set or clear the current set of runtime switches. The eight switches are numbered consecutively from left to right. These options are equivalent to the /S Runtime Command Option.

For a description of the buttons that appear along the bottom of this page of the Workspace wizard, see page 3-2.
Set Additional Options Page

The Set Additional Options page of the Workspace wizard, illustrated below, allows you to continue configuring the execution environment.

<table>
<thead>
<tr>
<th>Use this option</th>
<th>To</th>
</tr>
</thead>
<tbody>
<tr>
<td>Arguments to Main Program</td>
<td>Enter arguments to be passed to the main program. This option has the following format:</td>
</tr>
<tr>
<td></td>
<td>[delimiter]string[delimiter]</td>
</tr>
<tr>
<td></td>
<td>The delimiter character may be either a single or double quote, must not appear within string, and is required only if string contains spaces or tabs. If you enter a string that contains spaces, but do not use a delimiter, CodeWatch will provide a delimiter or display an error if no delimiter can be chosen. This option is equivalent to the /A Runtime Command Option.</td>
</tr>
<tr>
<td>Overriding Configuration File</td>
<td>Select or enter the name of the primary runtime configuration file. This file completely overrides the default runtime configuration. This option is equivalent to the /C Runtime Command Option. If a relative path is specified, the path is interpreted as relative to the directory specified in the Execution Directory option on the Select Program page of the wizard (see page 3-5).</td>
</tr>
<tr>
<td>Browse</td>
<td>Open the Select a Configuration File dialog box where you can search for and select a configuration file (.cfg).</td>
</tr>
</tbody>
</table>
### Use this option

<table>
<thead>
<tr>
<th>Description</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Supplemental Configuration File</strong></td>
<td>Select or enter the name of the supplemental runtime configuration file. The contents of this file supplement the default runtime configuration without replacing it. If an overriding configuration is specified, the contents of this file supplement that configuration. If no other configuration is specified, this file provides the complete configuration. This option is equivalent to the /X Runtime Command Option. If a relative path is specified, the path is interpreted as relative to the directory specified in the Execution Directory option on the Select Program page of the wizard (see page 3-5).</td>
</tr>
<tr>
<td><strong>Browse</strong></td>
<td>Open the Select a Configuration File dialog box where you can search for and select a configuration file (.cfg).</td>
</tr>
<tr>
<td><strong>Accept Buffer Size</strong></td>
<td>Enter the maximum buffer size to be used by ACCEPT and DISPLAY statements. The maximum size is 65280 characters, and the default size is 264 characters. This option is equivalent to the /B Runtime Command Option.</td>
</tr>
<tr>
<td><strong>Memory for Sort</strong></td>
<td>Enter the amount of memory (in bytes) to be used for a sort operation. The default is 256000 bytes. Specify a larger value to improve the efficiency of sort operations. Decrease this value to allocate more memory for other data or called subprograms. If neither SORT nor MERGE operations will be used in this run unit, specifying 0 will free all reserved memory for other uses. This option is equivalent to the /T Runtime Command Option.</td>
</tr>
<tr>
<td><strong>Level 2 ANSI Semantics for Format 1 ACC/DIS</strong></td>
<td>When selected, indicate that Level 2 ANSI semantics are to be used for Format 1 ACCEPT and DISPLAY operations. The default is to use Level 1 ANSI semantics for these operations. This option is equivalent to the /M Runtime Command Option.</td>
</tr>
<tr>
<td><strong>Suppress Startup and STOP RUN Messages</strong></td>
<td>When selected, suppress the banner message and the STOP RUN message. This option is equivalent to the /K Runtime Command Option.</td>
</tr>
</tbody>
</table>

For a description of the buttons that appear along the bottom of this page of the Workspace wizard, see page 3-2.
Set Execution Environment Page

The Set Execution Environment page of the Workspace wizard, illustrated below, allows you to finish defining the execution environment for your RM/COBOL program. This page contains five tabs. Click on a tab to set the parameters for the options available.

<table>
<thead>
<tr>
<th>Use this option</th>
<th>To</th>
</tr>
</thead>
<tbody>
<tr>
<td>Libraries</td>
<td>Specify a list of pathnames of COBOL and non-COBOL program libraries to be loaded. Libraries are loaded and searched in the specified order. The order can be changed by selecting a library and pressing the Move Up or Move Down buttons to move the name of the library within the list, or by dragging the name of the library to a new position with the mouse. Relative pathnames are interpreted relative to the directory specified in the Execution Directory option on the Select Program page of the wizard (see page 3-5). This option is equivalent to the /L Runtime Command Option.</td>
</tr>
<tr>
<td>Run Path</td>
<td>Specify a list of directories to be inserted before the RUNPATH environment variable. The RM/COBOL runtime will search these directories in the specified order for COBOL programs, libraries, non-COBOL libraries, and configuration files. These directories are inserted in front of any directories already in the RUNPATH environment variable. Relative pathnames are interpreted relative to the directory specified in the Execution Directory option on the Select Program page of the wizard (see page 3-5).</td>
</tr>
<tr>
<td>Program Path</td>
<td>Specify a list of directories to be inserted before the PATH environment variable. These directories are inserted in front of any directories already in the PATH environment variable. Relative pathnames are interpreted relative to the directory specified in the Execution Directory option on the Select Program page of the wizard (see page 3-5).</td>
</tr>
</tbody>
</table>
Use this option | To
--- | ---
Environment | Specify a list of string pairs to be placed into the RM/COBOL program’s environment. The syntax is:

name=value

Among other purposes, environment strings are used to specify synonyms for filenames. See the “Locating RM/COBOL Files” topic in Chapter 3, *Installation and System Considerations for Microsoft Windows*, of the *RM/COBOL User’s Guide*.

Source | Specify a list of directories to be searched for source files, in the event that a source file cannot be found at the location specified in the object file. These directories are searched in the specified order, and the first file with a matching name is used. Relative pathnames are interpreted relative to the directory specified in the Execution Directory option on the Select Program page of the wizard (see page 3-5). For additional information, see “How CodeWatch Finds Source Files During Execution” on page 4-1 and “Viewing Source During Program Execution” on page 4-8.

The following buttons appear on each of the tabs of the Set Execution Environment page and perform the same function on each tab.

**Button** | **Description**
--- | ---
![New](image) | New. Inserts a new item.
![Delete](image) | Delete. Removes the selected item.
![Move Up](image) | Move Up (Alt+Up Arrow) and Move Down (Alt+Down Arrow). Moves the selected item up or down in the list.
![Ellipsis](image) | Ellipsis. On tabs that specify files or directories, clicking this button displays a File Open dialog box in order to search for and select a file or directory.

For a description of the buttons that appear along the bottom of this page of the Workspace wizard, see page 3-2.
Once the Workspace wizard has created a workspace, you will see the CodeWatch main window, as shown in the following illustration. The main window consists of two general parts:

1. A window frame, consisting of a title bar, menu bar, and toolbar at the top of the window, and a status bar at the bottom. The frame surrounds the client area.

2. The client area. This is the area bounded by the frame and may contain zero or more Workspace windows.

The following briefly describes the elements of the window frame area of the CodeWatch main window.
<table>
<thead>
<tr>
<th>Area</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Title Bar</td>
<td>Displays the text, “CodeWatch for Windows”, followed by the name of the current workspace and the file being displayed. You can move the CodeWatch main window by clicking the title bar and dragging with the mouse.</td>
</tr>
<tr>
<td>Menu Bar</td>
<td>Use drop-down menus on the menu bar to display CodeWatch commands and subcommands. The menus available depend on whether or not a program file has been opened. For more information, see page 3-44.</td>
</tr>
<tr>
<td>Toolbar</td>
<td>Click buttons on the toolbar to choose menu commands quickly. The toolbar buttons available depend on several factors, including whether or not a program file has been opened and whether the program is running. See page 3-44 for more details. Note that an option on the View menu allows you to show or hide toolbars. You can move a toolbar at a different position in the CodeWatch main window by dragging the toolbar’s gripper bar (the two etched lines at the left end of the toolbar) with the mouse. You can detach a toolbar from the main window and float it anywhere on the screen by holding down the Ctrl key while dragging the toolbar.</td>
</tr>
<tr>
<td>Status Bar</td>
<td>Displays current information about the execution state, the date, the time, and the keyboard state. The execution state field indicates the state of the program you are debugging and may display one of the following messages:</td>
</tr>
<tr>
<td></td>
<td>• NO PROGRAM. No program has been configured into the workspace.</td>
</tr>
<tr>
<td></td>
<td>• IDLE. The program is not currently running.</td>
</tr>
<tr>
<td></td>
<td>• LOADING. The program is loading.</td>
</tr>
<tr>
<td></td>
<td>• READY. The program has been loaded, is ready to run, and is awaiting a Debug Command.</td>
</tr>
<tr>
<td></td>
<td>• RUNNING. The program is running.</td>
</tr>
<tr>
<td></td>
<td>• ACCEPT. The program is awaiting keyboard input. If the running program is not visible, press Alt+Tab to switch to the program.</td>
</tr>
</tbody>
</table>
The CodeWatch main window may contain zero or more Workspace windows. These windows are used to perform most of the actual work in CodeWatch. Table 3-1 describes the characteristics of the three types of Workspace windows.

**Table 3-1: Types of Workspace Windows**

<table>
<thead>
<tr>
<th>Window Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dockable Windows</td>
<td>Dockable windows have a small title bar, and are initially attached to the frame of the CodeWatch main window or to each other. Dockable windows can be:</td>
</tr>
<tr>
<td></td>
<td>- Docked to the inside of the frame of the main window.</td>
</tr>
<tr>
<td></td>
<td>- Floated outside of the frame of the main window anywhere on the screen.</td>
</tr>
<tr>
<td></td>
<td>- Converted to or from a document window. To convert a docked window into a document window or back again, choose Docked from the Window menu.</td>
</tr>
<tr>
<td></td>
<td>- To undock a docked window, choose Floating from the Window menu. You can then move the window around by dragging its title bar. To prevent the window from docking as you move it over the window frame, hold down the Ctrl key.</td>
</tr>
<tr>
<td></td>
<td>Right-clicking within the dockable window provides access to a menu that allows you to toggle between Docked and Floating. In addition, right-clicking the title bar of a dockable window displays a menu with additional options that allow you to precisely control how and where the window docks.</td>
</tr>
<tr>
<td></td>
<td>For more information, see “Dockable Windows” on page 3-14.</td>
</tr>
<tr>
<td>Document Windows</td>
<td>Document windows have a large title bar and usually occupy a large part of the CodeWatch main window. A document window cannot be moved outside the boundaries of the frame of the main window but can be positioned anywhere within the frame of the main window not occupied by a dockable window.</td>
</tr>
<tr>
<td></td>
<td>When a document window is maximized to occupy the entire document area, the title bar is hidden.</td>
</tr>
<tr>
<td></td>
<td>For more information, see “Document Windows” on page 3-31.</td>
</tr>
</tbody>
</table>
Table 3-1: Types of Workspace Windows (Cont.)

<table>
<thead>
<tr>
<th>Window Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Floating Windows</td>
<td>Floating windows are similar in appearance to dockable windows, but cannot be docked and always float free of the frame of the CodeWatch main window. Floating windows are used by the Find command on the Edit menu and the Data Item command on the View menu. For more information, see “Floating Windows” on page 3-36.</td>
</tr>
</tbody>
</table>

The following sections describe the content of the CodeWatch main window.

Dockable Windows

Three of the windows used in CodeWatch are dockable. These include the Workspace window, the Data window, and the Log window, which are discussed in the following sections.

As discussed in Table 3-1, CodeWatch allows you to convert any dockable window into a document window. To do so, click in the window you wish to convert, and uncheck Docked on the Window menu. This option is also available on the pop-up context menu that appears if you right-click in the window or on the title bar of any of the dockable windows.

Workspace Window

The Workspace window is initially docked to the left side of the frame of the CodeWatch main window, and allows you to examine and manipulate the contents of the workspace. The Workspace window is always visible when a workspace is active. By clicking on the Workspace window’s title bar, you can reposition it anywhere within the CodeWatch main window. You can close the Workspace window at any time by clicking the Close button at the end of the window’s title bar.

The Workspace window includes two tabs: Programs and Files, which are described and illustrated on pages 3-16 and 3-17, respectively. To see the workspace organized by programs, click the Programs tab. To see the workspace organized by files, click the Files tab. If an item is preceded by a [+] symbol, the item is expandable. Click [+] in front of an item to display the contents of that item. If an item is preceded by a [-] symbol, click [-] to minimize the size of the list.
The following icons are used in the Workspace window:

<table>
<thead>
<tr>
<th>This icon</th>
<th>Represents</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1" alt="Icon" /></td>
<td>A grouping of items. Note that this icon does not represent a directory on the disk.</td>
</tr>
<tr>
<td><img src="image2" alt="Icon" /></td>
<td>An RM/COBOL program for which source code is or is not available.</td>
</tr>
<tr>
<td><img src="image3" alt="Icon" /></td>
<td>An RM/COBOL program file or library file that contains one or more programs. When grayed, source code is unavailable for one or more programs in the library.</td>
</tr>
<tr>
<td><img src="image4" alt="Icon" /></td>
<td>An RM/COBOL source file. When checked, the file has been modified and is awaiting compilation. When grayed, the file has never been compiled.</td>
</tr>
<tr>
<td><img src="image5" alt="Icon" /></td>
<td>An RM/COBOL copy file. A check indicates that the copy file has been edited and all programs that use it must be recompiled. Those programs will also be checked.</td>
</tr>
</tbody>
</table>

Closing the Workspace window also closes the workspace. CodeWatch will prompt you to save the workspace if the workspace has not been saved, or if changes have been made since the last save. You can then save or discard the changes before closing the workspace, or cancel the operation.
Programs Tab

The Programs tab, illustrated to the right, contains the names of all of the programs in the workspace, organized into three sections:

- **Main Program.** Contains the name of the main RM/COBOL program. If the name has not been resolved, the name is enclosed in angle brackets to indicate that it is a placeholder.

- **Called Programs.** When debugging, contains a list of programs that have been called during the current run. The currently active program is always at the top of the list.

- **Other Programs.** Contains a list of the programs that have not yet been called in the current run.

A new workspace contains no programs, other than a placeholder for the main program. When the workspace is run for the first time, the runtime system resolves the program name to an actual program and replaces the placeholder. As additional programs are called during a debugging session, the names of these programs are added to the Called Programs folder, which is a convenient list of programs that have been invoked during the session. At the beginning of the next debugging session, the called programs are moved into the Other Programs folder, and migrate into the Called Programs folder as they are again invoked.

The list of programs is saved when you save the workspace to a file. This makes it possible to visually browse source files and set breakpoints without first having to run the program to recreate the Called Programs folder. To see the source code for a given program, double-click on the name of the program. The source code opens in a Source Code/Edit window (see page 4-2).

**Note** In addition to the drop-down menus on the menu bar, CodeWatch provides context-sensitive menus that pop up at the click of the right mouse button to access frequently-performed operations quickly. The contents of the context menu changes depending on the item that is currently selected. To open a context menu in the Workspace window, select an object and right-click. From the pop-up context menu, choose the command you need. To learn more about the context menu for the Programs tab, see page 3-18.
Files Tab

The Files tab, illustrated to the right, contains the names of all of the files in the workspace, organized into four sections:

- **Program Files.** Contains the RM/COBOL program files, by name, that are run.

- **Library Files.** Contains the RM/COBOL library files that were specified using the /L Runtime Command Option or that were added to the workspace library list.

- **Source Files.** Contains the list of source files in the workspace. Source files that are inserted into this list as a result of a reference from a program are displayed using a green icon. Source files that are inserted manually using the Open or Insert Items commands from the File menu appear gray.

- **Copy Files.** Lists all copy files in the workspace. Copy files that are inserted into this list as a result of a reference from a program are displayed using a green icon. Copy files that are inserted manually using the Open or Insert Items commands from the File menu appear gray.

The Program Files and Library Files folders can be expanded to reveal the list of program or library files in each folder. Each program file or library file can be further expanded to reveal the list of programs within the file, as well as the source and copy files that were used to compile the program file or library file. Programs that contain other programs can be expanded to reveal the nesting relationship between programs. Finally, double-clicking on any of these elements will open the source file for the program in a Source Code/Edit window for examination (see page 4-1).

**Note** In addition to the drop-down menus on the menu bar, CodeWatch provides context-sensitive menus that pop up at the click of the right mouse button to access frequently-performed operations quickly. The contents of the context menu changes based on the currently selected item. To open a context menu in the Workspace window, select an object and right-click. From the pop-up context menu, choose the command you need. To learn more about the context menu for the Files tab, see page 3-18.
Context Menu in a Workspace Window

When you right-click over a selected object in either the Programs or Files tab of a Workspace window, a pop-up context menu appears. The contents of the context menu will vary depending on the currently selected object and the currently selected tab. The following table displays the possible context-menu commands and their purpose. (See also “Menus and Toolbars” on page 3-44.)

<table>
<thead>
<tr>
<th>Command</th>
<th>Shortcut Key</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Insert Program File</td>
<td>Ins</td>
<td>Displays the Open File dialog box and allows you to choose one or more files to be added to the workspace. The type of item added by this menu command is determined by the currently highlighted item in the Workspace window. For example, to insert a source file, right-click on an existing source file or the Source File folder in the Files tab. You can insert any number of files in one operation by holding down the Shift key when selecting files in the Open File dialog box. All files must be the same type. Note that the text of the menu command displayed will reflect the action that will be performed.</td>
</tr>
<tr>
<td>Insert Library File</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Insert Source File</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Insert Copy File</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
| Remove “filename”  | Del          | Removes the specified item from the workspace. The type of item that is removed is determined by the selection. For example:  
  • Folders cannot be removed from the workspace.  
  • Source and copy files can be removed from the workspace only if they are not in use by a COBOL program or library. In that case, you must instead remove the program or library from the workspace. Note that the text of the menu command will change to reflect the action that will be performed. |
<table>
<thead>
<tr>
<th>Command</th>
<th>Shortcut Key</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Compile File</td>
<td>(Ctrl+F7)</td>
<td>Compiles the selected item, as follows:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• If the focus is in the Workspace window, and a COBOL source file is selected, that file is compiled. In that case, the menu command will contain the name of the file to compile.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• If the source file is open in a Source Code/Edit window and has been edited and not saved, you are prompted to save the file or cancel the compilation.</td>
</tr>
<tr>
<td>Properties</td>
<td>Alt+Enter</td>
<td>Displays the properties of the selected item in the Workspace Properties dialog box, as follows:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• The dialog box that is displayed is dependent on the item that is currently selected in the Workspace window.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• The item properties that can be examined include the following:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>− a list of included copy files;</td>
</tr>
<tr>
<td></td>
<td></td>
<td>− a list of programs produced when the source file was compiled or a list of source files that depend on the copy file;</td>
</tr>
<tr>
<td></td>
<td></td>
<td>− for source files, the build settings that were in effect for the last compilation.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• The Source tab on the Environment page of the Workspace Properties dialog box allows you to set the compilation options for the specified item, and also allows you to set the default compilation options to be used for all files that do not have individual settings.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>See page 3-61 for a complete discussion of the Workspace Properties dialog box.</td>
</tr>
<tr>
<td>Edit File “name” or Edit Source</td>
<td>F2</td>
<td>Opens the specified item in the Source Code/Edit Window. This operation may be performed on program files, programs, source files, and copy files.</td>
</tr>
</tbody>
</table>
Docked

Checked (√), if the window is docked to the frame of the CodeWatch main window. Deselecting this menu item converts the window from a dockable window into a document window. Checking this item docks the window to the frame of the main window.

Floating

Checked (√), if the window is floating free of the frame of the CodeWatch main window. Deselecting this menu item docks the window; checking this window causes it to float free of the frame in the main window.

Data Window

The Data window, which displays information about the program that you are debugging, contains a set of five tabs:

- Breakpoints (see page 3-21)
- Watchpoints (see page 3-23)
- Data Files (see page 3-25)
- Call Stack (see page 3-26)
- Build Results (see page 3-27)

To select a tab in the Data window, click on it. Alternatively, from the View menu, select the command or press the shortcut key that corresponds to the tab you want to display.

The Data window is opened automatically whenever you click the Start command from the Run menu or click the Run toolbar button. You can close the Data window at any time by clicking the Close button at the end of the window’s title bar.

To reopen the Data window, choose either Breakpoints Tab, Watchpoints Tab, Data Files Tab, Call Stack Tab, or Build Results Tab from the View menu or press the corresponding shortcut key.
Breakpoints Tab

To access the Breakpoints tab, illustrated below, do one of the following:

- Click the **Breakpoints** tab in the Data window.
- Choose **Breakpoints Tab** from the **View** menu.
- Press **Alt+1**.

<table>
<thead>
<tr>
<th>This option</th>
<th>Describes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Program</td>
<td>The name of the program containing the breakpoint. The Debugger does not differentiate between separately compiled programs and contained (that is, nested) programs that have the same name. Execution will stop when any instance of the named program is entered and the specified line is encountered. The program name is preceded by a red circle if the breakpoint is enabled, or by a hollow circle if the breakpoint is temporarily disabled.</td>
</tr>
<tr>
<td>Line</td>
<td>The number of the target line.</td>
</tr>
<tr>
<td>Stmt</td>
<td>The statement number specified within the line. Leave this blank to indicate that the break will occur when the first (or only) statement on the line is executed. Or, specify an offset: +1 indicates the second statement on the line, and +2 indicates the third.</td>
</tr>
<tr>
<td>Pass</td>
<td>The number of times a breakpoint should be skipped before being triggered. The default is to trigger the breakpoint on each pass. For example, a value of 5 indicates that the breakpoint will be skipped four times and then triggered. Once a breakpoint is triggered, it will be triggered on each subsequent pass unless the pass count is set again.</td>
</tr>
</tbody>
</table>
You can perform the following operations in the Breakpoints tab:

- Enable or disable a breakpoint by pressing the Spacebar or by single-clicking the red circle preceding the program name. When enabled, the program will halt when the conditions attached to the breakpoint are satisfied. When disabled, the breakpoint has no effect on the program.

- Add a new breakpoint by pressing the Ins key.

- Remove a breakpoint by pressing the Del key.

- Edit a breakpoint by pressing the F2 key.

- Display a pop-up context menu by right-clicking with the mouse (alternatively, press Shift+F10). This pop-up menu allows you to change the properties of the Breakpoints tab using the Code Breakpoints page of the Breakpoints & Watchpoints dialog box, described on page 3-69, as well as perform the other operations listed above.

You can also set, clear, enable, or disable a breakpoint in the Source Code/Edit window (see page 4-2) by one of the following methods:

- Double-click on the line number to set or clear a breakpoint.

- Right-click on a line to set, clear, enable, or disable a breakpoint by using the options on the pop-up context menu.
Watchpoints Tab

To access the Watchpoints tab, illustrated below, do one of the following:

- Click the **Watchpoints** tab in the Data window.
- Choose **Watchpoints Tab** from the **View** menu.
- Press **Alt+2**.

![Verify.cwfd2](image)

<table>
<thead>
<tr>
<th>Name</th>
<th>Loc</th>
<th>Type</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>TITLE</td>
<td>4</td>
<td>GRP</td>
<td>RMRCOBOX.Verifikation.Program - V...</td>
</tr>
<tr>
<td>TEST-NAME(2)</td>
<td>60</td>
<td>ANS</td>
<td>Nextest</td>
</tr>
<tr>
<td>FUNCTION-NUMBER</td>
<td>46</td>
<td>NSU</td>
<td>1</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>This option</th>
<th>Describes</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Name</strong></td>
<td>The name of the data item being watched. The name is preceded by a red circle to halt the program whenever the content of the data item changes. A hollow circle indicates that the watchpoint will not halt the program.</td>
</tr>
<tr>
<td><strong>Loc</strong></td>
<td>The location of the data item within the program.</td>
</tr>
<tr>
<td><strong>Type</strong></td>
<td>The type of the data item. This field determines how the value is displayed. It defaults to the actual type of the data item, but may be overridden using the Inspect/Modify dialog box (see page 3-42).</td>
</tr>
<tr>
<td><strong>Value</strong></td>
<td>The value of the data item.</td>
</tr>
</tbody>
</table>
You can perform the following operations in the Watchpoints tab:

- Enable or disable a watchpoint by pressing the Spacebar or by single-clicking the red circle preceding the data item name. When enabled, execution halts whenever the value in the data item changes. When disabled, the value is updated whenever the program halts, but a value change will not cause the program to halt.

- Add a new watchpoint by pressing the Ins key.

- Remove a watchpoint by pressing the Del key.

- Edit a watchpoint or modify the value of the data item by pressing the F2 key.

- Display a pop-up context menu by right-clicking with the mouse or by pressing Shift+F10. This pop-up menu allows you to change the properties of the watchpoints listed on the Watchpoints tab using the Data Watchpoints page of the Breakpoints & Watchpoints dialog box, described on page 3-71, as well as perform the other operations described above.

You can also add a watchpoint in the Source Code/Edit window (see page 4-2) by using one of the following methods:

- Select the name of a data item with the mouse, double-click to inspect the data item, and then click the Watch button in the Inspect/Modify dialog box (see page 3-42). (Note that you can also modify the data item by adding qualification or subscripting in this way. See the RM/COBOL User’s Guide for more information.)

- Select the name of a data item with the mouse, then right-click and choose Watch Data Item from the pop-up context menu.
Dockable Windows

Data Files Tab

The Data Files tab, illustrated below, contains a running trace of all files opened during the execution of this program and is for information purposes only. To access the Data Files tab, do one of the following:

- Click the Data Files tab in the Data window.
- Choose Data Files Tab from the View menu.
- Press Alt+3.

<table>
<thead>
<tr>
<th>This option</th>
<th>Describes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The name of the file.</td>
</tr>
<tr>
<td>Type</td>
<td>The type of file, where:</td>
</tr>
<tr>
<td></td>
<td>PGM          Indicates program file</td>
</tr>
<tr>
<td></td>
<td>SEQ          Indicates sequential file</td>
</tr>
<tr>
<td></td>
<td>REL          Indicates relative file</td>
</tr>
<tr>
<td></td>
<td>INX          Indicates indexed file</td>
</tr>
<tr>
<td>Mode</td>
<td>The mode used to open the file, where:</td>
</tr>
<tr>
<td></td>
<td>I            Indicates open for input</td>
</tr>
<tr>
<td></td>
<td>IO           Indicates open for input and output</td>
</tr>
<tr>
<td></td>
<td>O            Indicates open for output</td>
</tr>
<tr>
<td></td>
<td>E            Indicates open for extend (output at end of file)</td>
</tr>
<tr>
<td>Pathname</td>
<td>The full pathname of the file.</td>
</tr>
</tbody>
</table>
Call Stack Tab

The Call Stack tab, illustrated below, contains a list of currently active programs and the number of the currently active line within each of those programs. To access the Call Stack tab, do one of the following:

- Click the Call Stack tab in the Data window.
- Choose Call Stack Tab from the View menu.
- Press Alt+4.

<table>
<thead>
<tr>
<th>This option</th>
<th>Describes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Program</td>
<td>The name of the program. The currently active program is always indicated by the blue arrow and is displayed at the top of the list. The next line is the caller of the currently active program, and the next line is its caller. Note that you can return to the current program’s caller by choosing Step Program from the Run menu (see page 3-57).</td>
</tr>
<tr>
<td>Line</td>
<td>The number of the line currently executing in each program.</td>
</tr>
<tr>
<td>Filename</td>
<td>The filename of the COBOL program file or library that contains each program.</td>
</tr>
</tbody>
</table>

You can perform the following operations in the Call Stack tab:

- Open a Source Code/Edit window (see page 4-2) and move to the indicated line by pressing Enter or F2.
- Display a pop-up context menu by right-clicking with the mouse, or by pressing Shift+F10. This pop-up menu allows you to change the properties of the Call Stack tab.

Note: You can see a list of all programs that have been executed in this session by examining the Programs tab (see page 3-16) in the Workspace window.
Build Results Tab

The Build Results tab, illustrated below, contains a list of the source files compiled by the last build, along with the results of each compilation. Note that if any errors or warnings were detected, the line is displayed in red. To access the Build Results tab, do one of the following:

- Click the Build Results tab in the Data window.
- Choose Build Results Tab from the View menu.
- Press Alt+5.

<table>
<thead>
<tr>
<th>Name</th>
<th>Error</th>
<th>Warn</th>
<th>Pathname</th>
</tr>
</thead>
<tbody>
<tr>
<td>verify.cbl</td>
<td>0</td>
<td>0</td>
<td>OcDev\My Programs\verify.cbl</td>
</tr>
<tr>
<td>veritest.cbl</td>
<td>0</td>
<td>0</td>
<td>OcDev\My Programs\veritest.cbl</td>
</tr>
<tr>
<td>maintest.cbl</td>
<td>4</td>
<td>1</td>
<td>OcDev\My Programs\maintest.cbl</td>
</tr>
<tr>
<td>output.cbl</td>
<td>0</td>
<td>0</td>
<td>OcDev\My Programs\output.cbl</td>
</tr>
<tr>
<td>printtest.cbl</td>
<td>0</td>
<td>0</td>
<td>OcDev\My Programs\printtest.cbl</td>
</tr>
<tr>
<td>texttest.cbl</td>
<td>0</td>
<td>0</td>
<td>OcDev\My Programs\texttest.cbl</td>
</tr>
<tr>
<td>test.cbl</td>
<td>0</td>
<td>0</td>
<td>OcDev\My Programs\test.cbl</td>
</tr>
</tbody>
</table>

This option Describes

Name The name of the file. The icon is checked if the file compiled with errors (indicating recompilation is required), and the entire row is colored red if there were any errors or warnings.

Error The number of errors detected during the compilation.

Warn The number of warnings detected during the compilation.

Pathname The full pathname of the file.

You can perform the following operations in the Build Results tab:

- Open a Source Code/Edit window (see page 4-2) and move to the indicated line by pressing Enter or F2.
- Display a pop-up context menu by right-clicking with the mouse, or by pressing Shift+F10. This pop-up menu allows you to change the properties of the Build Results tab.
Context Menu in a Data Window

When you right-click in a Data window, a pop-up context menu appears. The contents of the context menu will vary depending on the currently selected item and the currently selected tab. The following table displays the possible context-menu commands and their respective purposes. (See also “Menus and Toolbars” on page 3-44.)

<table>
<thead>
<tr>
<th>Command</th>
<th>Shortcut Key</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>New</td>
<td>Ins</td>
<td>Displays either the Code Breakpoints page or the Data Watchpoints page of the Breakpoints &amp; Watchpoints dialog box (see page 3-69) and allows you to manually define an item. This option is not enabled in the Data Files, Call Stack, or Build Results tabs.</td>
</tr>
<tr>
<td>Delete</td>
<td>Del</td>
<td>Deletes the specified breakpoint or watchpoint. This option is not enabled in the Data Files, Call Stack, or Build Results tabs.</td>
</tr>
<tr>
<td>Properties</td>
<td>Alt+Enter</td>
<td>Displays the properties for the selected item and allows you to edit the properties in either the Code Breakpoints page or the Data Watchpoints page of the Breakpoints &amp; Watchpoints dialog box (see page 3-69). This option is not enabled in the Data Files, Call Stack, or Build Results tabs.</td>
</tr>
<tr>
<td>Edit Source</td>
<td>F2</td>
<td>For breakpoints, the call stack, or build results, edits the source file referenced by the selected item and moves the cursor to the referenced line. This option is not enabled in the Watchpoints or Data Files tabs.</td>
</tr>
<tr>
<td>Enabled</td>
<td>Spacebar</td>
<td>For breakpoints and watchpoints, enables or disables the selected item. This option is not enabled in the Data Files, Call Stack, or Build Results tabs.</td>
</tr>
<tr>
<td>Clear All</td>
<td></td>
<td>For breakpoints and watchpoints, removes the selected item. This option is not enabled in the Data Files, Call Stack, or Build Results tabs.</td>
</tr>
<tr>
<td>Disable All</td>
<td></td>
<td>Disables all breakpoints or watchpoints. This option is not enabled in the Data Files, Call Stack, or Build Results tabs.</td>
</tr>
</tbody>
</table>
Dockable Windows

<table>
<thead>
<tr>
<th>Command</th>
<th>Shortcut Key</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable All</td>
<td></td>
<td>Enables all breakpoints or watchpoints. This option is not enabled in the Data Files, Call Stack, or Build Results tabs.</td>
</tr>
<tr>
<td>Docked</td>
<td></td>
<td>Checked (✓), if the Data window is docked to the frame of the CodeWatch main window. Deselecting this menu item converts the window from a dockable window into a document window. Checking this item docks the window to the frame of the main window.</td>
</tr>
<tr>
<td>Floating</td>
<td></td>
<td>Checked (✓), if the Data window is floating free of the frame of the CodeWatch main window. Deselecting this menu item docks the window; checking this window causes the Data window to float free in the frame in the main window.</td>
</tr>
</tbody>
</table>

Log Window

The Log window, illustrated below, is opened automatically whenever you click the Start command from the Run menu or click the Run toolbar button. You can also access the Log window by choosing Log Window from the View menu or pressing Alt+6.
The Log window serves two purposes:

- Displays compiler messages during and after a compilation. The window is automatically cleared before each of the Build menu commands (see page 3-55).
- Allows you to directly issue commands to the RM/COBOL command line Debugger during program execution, as shown in the example above. Any of the commands, described in Chapter 9, Debugging, of the RM/COBOL User’s Guide, can be entered directly in the Log window. The Debugger’s output is also displayed in this window.

To enter a Debug command, click anywhere within the Log window, type the command, and press Enter. To view previous commands or output, scroll through the window by using the scroll bars. Note that the Log window displays only the most recent 100 lines of output.

You can close the Log window at any time by clicking the Close button at the end of the window’s title bar. To reopen the Log window, choose Log Window from the View menu or press Alt+6. The Log window is also opened automatically whenever you click the Start command from the Run menu.

### Context Menu in a Log Window

When you right-click in a Log window, a pop-up context menu appears. The contents of the context menu will vary depending on the currently selected item. The following table displays the possible context-menu commands and their purpose. (See also “Menus and Toolbars” on page 3-44.)

<table>
<thead>
<tr>
<th>Command</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Clear</td>
<td>Clears the contents of the Log window.</td>
</tr>
<tr>
<td>Docked</td>
<td>Checked (✓), if the Log window is docked to the frame of the CodeWatch main window. Deselecting this menu item converts the window from a dockable window into a document window. Checking this item docks the window to the frame of the main window.</td>
</tr>
<tr>
<td>Floating</td>
<td>Checked (✓), if the Log window is floating free of the frame in the CodeWatch main window. Deselecting this menu item docks the window; checking this window causes it to float free of the frame in the main window.</td>
</tr>
</tbody>
</table>
Document Windows

The area within the frame of the CodeWatch main window that is not occupied by the dockable windows (see page 3-14) is reserved for “document” windows. Document windows have a large title bar, are listed in the Window menu, and always float only in the document area of the main window. (If the document window’s title bar is not visible, click the Restore button.) Unlike dockable windows, you can have any number of document windows that are displaying different objects. You can even display the same object in two different document windows. The Source Code/Edit window, described on page 4-2, is an example of a document window.

Note CodeWatch allows you to convert any dockable window into a document window. To do so, click in the window you wish to convert, and uncheck Docked on the Window menu. This option is also available on the pop-up context menu that appears if you right-click in the window or on the title bar of the dockable window.

Using Document Windows

This section describes the state of document windows, details the Document menu commands and toolbar buttons, and explains how to cycle through, split, and close document windows.

State of Document Windows

Document windows can take on three different states: minimized, maximized, or normal.

- **Normal.** In the normal state, all document windows are overlapped in the document area. You can use commands on the Window menu to arrange all of the document windows, either by tiling or cascading the windows.

- **Maximized.** In the maximized state, only the topmost document window is visible and there is no separate document title bar. You can move between document windows by pressing Ctrl+Tab or by using the Window menu.

- **Minimized.** In the minimized state, the document window is reduced so only its title bar is visible at the bottom of the document area.
The state of a document window is set by one of the following methods:

- Using the Document menu that appears when you click the document icon in the upper-left corner of the title bar. If the document window’s title bar is not visible, restore the document by clicking the Restore button.

- By clicking the Minimize, Maximize, or Close buttons on the upper right-corner of the title bar.

**Note** If the document window is maximized, the Document menu icon is moved to the left side of the menu bar and the buttons are moved to the right side of the menu bar.

To activate the Document menu from the keyboard:

1. Press the **F10** key, or press and release the **Alt** key. This activates the File menu.
2. Press the Left Arrow key, which activates the Document menu for the current window.
3. Press the Down Arrow key, which drops down the menu.
### Document Menu

The Document menu contains the following commands. The corresponding shortcut key and button, if applicable, are also shown.

<table>
<thead>
<tr>
<th>Command</th>
<th>Shortcut Key</th>
<th>Button</th>
<th>Action</th>
</tr>
</thead>
</table>
| Restore |              | ![Button] | Restores the view so all document windows are potentially visible in the document area. The Restore button always replaces the Maximize button or the Minimize button when that command is carried out. Use the following commands to arrange the restored windows:  
- Window | Cascade to cascade all document windows from left to right, top to bottom across the document area.  
- Window | Tile to tile all document windows in the document area so a part of each window is visible. |
<p>| Move    |              |        | Moves the window. You can use the mouse or the arrow keys to position the window in the document area. This function is not available if the window is maximized. You can also move a window with the mouse by clicking anywhere in the title bar and dragging the window to a new location. |
| Size    |              |        | Resizes the window. The Up and Down Arrow keys, respectively, increase and decrease the size of the window vertically, and the Left and Right Arrow keys perform the same operation horizontally. This function is not available if the window is maximized or minimized. You can also size a window with the mouse by clicking the frame on any side, or clicking a corner and dragging with the mouse. |</p>
<table>
<thead>
<tr>
<th>Command</th>
<th>Shortcut Key</th>
<th>Button</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Maximize</td>
<td></td>
<td>![Maximize Icon]</td>
<td>Maximizes all document windows so the top-most window occupies the entire document area. No title bar is visible, the document menu is moved to the left side of the menu bar, and the document window buttons are moved to the right end of the menu bar.</td>
</tr>
<tr>
<td>Minimize</td>
<td>Ctrl+F4</td>
<td>![Minimize Icon]</td>
<td>Minimizes the currently selected document window. A minimized window is represented by a title bar at the bottom of the document area. Note that the title bar is not visible if another maximized document window is available.</td>
</tr>
<tr>
<td>Close</td>
<td>Ctrl+F4</td>
<td>![Close Icon]</td>
<td>Closes the currently active document window, regardless of the state of the window. If the document has been changed but not saved, you will be prompted to save or discard the changes.</td>
</tr>
<tr>
<td>Next</td>
<td>Ctrl+F6 or Ctrl+Tab</td>
<td>![Next Window Icon]</td>
<td>Activates the next document window.</td>
</tr>
<tr>
<td>Previous</td>
<td>Ctrl+Shift+F6 or Ctrl+Shift+Tab</td>
<td>![Previous Window Icon]</td>
<td>Activates the previous document window. (Note that this command is not on the menu).</td>
</tr>
</tbody>
</table>

When CodeWatch is closed, it remembers the state of the last document window (maximized or normal), and that setting is used the next time CodeWatch is started.

**Cycling Through Open Windows**

Document windows are kept in a stack. If document windows are maximized, you can see only the top-most document in the stack. To cycle through all open document windows, do one of the following:

- Press **Ctrl+F6** or **Ctrl+Tab** to move forward to the next window in the document window stack.
- Press **Ctrl+Shift+F6** or **Ctrl+Shift+Tab** to move back to the previous window in the document window stack.
Splitting Document Windows

CodeWatch allows you to split a document window into either two or four smaller windows (called panes) that can be independently positioned over the text. This is useful for viewing the Working-Storage Section of your source at the same time as viewing the Procedure Division.

There are two ways to split a document window:

- From the Window menu, choose Split.
- Alternatively, drag the split box (illustrated to the right) with the mouse. The split boxes are located on top of the vertical scrollbar, and to the left of the horizontal scrollbar.

In either case, the document window is immediately transected by a horizontal and a vertical divider (called a split bar), and the intersection of the dividers may be moved with the mouse or the arrow keys on the keyboard. Press the Enter key or release the mouse button when you are finished positioning the split bar.

When you split document windows, there are several considerations to keep in mind:

- To divide the window into two panes instead of four, drag the unwanted split bar to the edge of the window.
- The panes may be positioned independently, but only the pane containing the cursor is active.
- To move the cursor into the next pane, choose Pane | Next from the Window menu or press F6. To move the cursor into the previous pane, choose Pane | Previous from the Window menu or press Shift+F6.

  **Note** Neither of the Pane commands will activate a different document window. To activate a different document, press Ctrl+F6 or Ctrl+Shift+F6.

- To adjust the split bar, choose Split from the Window menu. To move the divider with the mouse, simply click and drag the split bar to the new position.
- To close a pane, drag the split bar to the edge of the window with the keyboard or the mouse, or double-click the divider with the mouse.
Closing Document Windows

Closing a document window returns you to the previous document window in the stack. There are several ways to close a document window. Do one of the following:

- Press Ctrl+F4 or click the Close button on the document window’s title bar. If the window is maximized, the Close button is at the right end of the menu bar.
- Choose Close from the Document menu.

These functions close only the currently active document window and also close the document if there is only one open document window. If you used the New Window command from the Window menu to create additional windows on the document, the document is not closed until all windows are closed.

To close all windows associated with the current document:

- Choose File | Close.
  
  If the document has been changed, you will be given the option to save the document.

Floating Windows

Floating windows “float” over the CodeWatch main window and may be revealed or hidden at any time. Three of the dialog boxes used in CodeWatch are floating type windows. The Find, Replace, and Inspect/Modify dialog boxes are discussed in the following sections.

Find Dialog Box

The Find dialog box, illustrated below, allows you to search for text in the source file in various ways. This dialog box is enabled only when a Source Code/Edit window (see page 4-2) is open.

To display the Find dialog box, do one of the following:

- From the Edit menu, choose Find.
- Click the Find toolbar button.
- Press Ctrl+F or Alt+F3.
<table>
<thead>
<tr>
<th>Use this option</th>
<th>To</th>
</tr>
</thead>
<tbody>
<tr>
<td>Find what</td>
<td>For the current file, type the information you want to search for (this is referred to as the search criteria). Or, click a previous search entry from the list.</td>
</tr>
<tr>
<td>Match whole word only</td>
<td>Match the search string only if the found occurrence is delimited by:</td>
</tr>
<tr>
<td></td>
<td>• spaces, tabs, or the beginning and/or end of the line, or</td>
</tr>
<tr>
<td></td>
<td>• any of the following characters:</td>
</tr>
<tr>
<td></td>
<td>\ &quot; ' ` ~ — = ! @ # $ % ^ &amp; * _ ( ) + [ ] { } ; : . , &lt; &gt; / ?</td>
</tr>
<tr>
<td></td>
<td>For example, searching for “25” when this option is not checked will match “1255” and “A25”. Checking this option ensures that only “25” is matched.</td>
</tr>
<tr>
<td>Match case</td>
<td>When selected, find only the text that exactly matches the search text criteria. When not selected, uppercase and lowercase letters are considered to be identical. Therefore, searching for ABC will match “abc” and “AbC” in addition to “ABC”.</td>
</tr>
<tr>
<td>Regular expression</td>
<td>When selected, specify that the search text is a UNIX-style regular expression. This provides the ability to perform powerful search operations. For more information, see “Regular Expressions” on page 3-38.</td>
</tr>
<tr>
<td>Direction</td>
<td>Control the direction of the search: select Down to search forward in the file toward the end, or select Up to search backward in the file toward the beginning.</td>
</tr>
</tbody>
</table>
### Use this option | To
---|---
Find Next | In the current file, find the next occurrence of the text string entered or selected in the Find what list box in the specified direction. If found, the text is highlighted.

Pressing F3, choosing Find Next from the Edit menu, or clicking the Find Next toolbar button performs this same operation using the current settings in the Find dialog box, even if the Find dialog box is not open (or visible).

Find the previous occurrence of the text in the current file. If found, the text is highlighted. Note that pressing Shift+F3, choosing Find Previous from the Edit menu, or clicking the Find Previous toolbar button performs this operation using the current settings in the Find dialog box, even if the window is not visible.

Mark All | Mark all the found occurrences.

Cancel | Close the Find dialog box without matching and cancel all entries made in the dialog box.

### Regular Expressions

CodeWatch allows you to search for text patterns, called regular expressions, rather than fixed strings. You indicate that the search string is a regular expression by checking the Regular expression check box in the Find dialog box or in the Replace dialog box, as described on pages 3-37 and 3-41, respectively.

Regular expressions are made by combining normal characters with a number of special characters. For example:

\[ ^\*888888 \* [FfG-I] \]

where `^` is a space that matches “88,” followed by one or more spaces, followed by any of the letters in the string “FfGHI”. The 88 must be the first non-blank characters on the line.

Table 3-2 lists these special characters and their uses as defined by CodeWatch.
### Table 3-2: Special Characters Allowed in CodeWatch Regular Expressions

<table>
<thead>
<tr>
<th>Special Character</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>^ (caret)</td>
<td>Indicates that the regular expression immediately following this character must be found at the beginning of the line.</td>
</tr>
<tr>
<td>$</td>
<td>Indicates that the regular expression immediately preceding this special character must be found at the end of the line.</td>
</tr>
<tr>
<td>. (period)</td>
<td>Matches a single character.</td>
</tr>
<tr>
<td>*</td>
<td>Matches any number of the character or pattern that immediately precedes it.</td>
</tr>
<tr>
<td>[...]</td>
<td>Matches any one of the characters or a range of consecutive characters enclosed between brackets. For example, [xy] matches either x or y. A range of consecutive characters is specified by separating the first and last characters in the range with a hyphen. For example, [0-9] will match any digit from 0 to 9. <strong>Note</strong> A caret (^) changes its special meaning inside brackets. A caret as the first character in the bracket reverses its meaning; it tries to match any character not in the list. To match a circumflex, place it later in the range.</td>
</tr>
<tr>
<td>{n,m}</td>
<td>Matches a range of occurrences of the single character (including a character specified by a regular expression) that immediately precedes it. N and m are integers between 0 and 256 that specify the number of occurrences to match. {n} matches exactly n occurrences, {n,} matches at least n occurrences, and {n,m} matches any number of occurrences between n and m. For example, L{2,3} will match either LL (as in LLAMA) or LLL (as in LLL Ranch), but not the single letter L.</td>
</tr>
<tr>
<td>\ (backslash)</td>
<td>Indicates that the following special character is treated as an ordinary character; for example, “.&quot; stands for a period and “*” stands for an asterisk.</td>
</tr>
</tbody>
</table>
Replace Dialog Box

The Replace dialog box, illustrated below, allows you to search for and replace text in the source file in various ways. This window is enabled only when a Source Code/Edit window (see page 4-2) is open.

To reveal or hide the Replace dialog box, do one of the following:

- From the Edit menu, choose Replace.
- Press Ctrl+H.

<table>
<thead>
<tr>
<th>Use this option</th>
<th>To</th>
</tr>
</thead>
<tbody>
<tr>
<td>Find what</td>
<td>For the current file, enter or select the text to search for. (You can click the down-arrow to see a list of previous searches and repeat a search by clicking in the list.)</td>
</tr>
<tr>
<td>Replace with</td>
<td>Enter or select the text that is to replace each matched instance of the search criteria specified in the Find what option.</td>
</tr>
<tr>
<td>Match whole word only</td>
<td>Match the search criteria specified in the Find what option only if the found occurrence is delimited by:</td>
</tr>
<tr>
<td></td>
<td>- spaces, tabs, or the beginning and/or end of the line, or</td>
</tr>
<tr>
<td></td>
<td>- any of the following characters:</td>
</tr>
<tr>
<td></td>
<td>\ &quot; ' ~ - = ! @ # $ % ^ &amp; _</td>
</tr>
<tr>
<td></td>
<td>( ) + [ ] { } ; : . &lt; &gt; / ?</td>
</tr>
</tbody>
</table>

For example, searching for “25” when this option is not selected will match “1255” and “A25”. Selecting this option ensures that only “25” is matched.
<table>
<thead>
<tr>
<th>Use this option</th>
<th>To</th>
</tr>
</thead>
<tbody>
<tr>
<td>Match case</td>
<td>When selected, find only the text that exactly matches the search</td>
</tr>
<tr>
<td></td>
<td>criteria. When not selected, uppercase and lowercase letters are</td>
</tr>
<tr>
<td></td>
<td>considered to be identical. Therefore, searching for ABC will</td>
</tr>
<tr>
<td></td>
<td>match “abc” and “AbC” in addition to “ABC”.</td>
</tr>
<tr>
<td>Regular expression</td>
<td>When selected, specify that the search criterion is a UNIX-style</td>
</tr>
<tr>
<td></td>
<td>regular expression. This provides the ability to perform powerful</td>
</tr>
<tr>
<td></td>
<td>search and replace operations. For more information, see</td>
</tr>
<tr>
<td></td>
<td>“Regular Expressions” on page 3-38.</td>
</tr>
<tr>
<td>Replace In</td>
<td>Limit the scope of the Replace All operation (discussed below).</td>
</tr>
<tr>
<td></td>
<td>You can choose to replace all matching instances of the search</td>
</tr>
<tr>
<td></td>
<td>criteria specified in the Find what option in either the selection</td>
</tr>
<tr>
<td></td>
<td>or the entire file.</td>
</tr>
<tr>
<td>Find Next</td>
<td>Find and highlight the next occurrence of the search criteria</td>
</tr>
<tr>
<td></td>
<td>specified in the Find what option in either the selection or the</td>
</tr>
<tr>
<td></td>
<td>entire file.</td>
</tr>
<tr>
<td></td>
<td>Pressing F3, choosing Find Next from the Edit menu, or clicking</td>
</tr>
<tr>
<td></td>
<td>the Find Next toolbar button performs this same operation using</td>
</tr>
<tr>
<td></td>
<td>the current settings in the Replace dialog box, even if the Replace</td>
</tr>
<tr>
<td></td>
<td>dialog box is not open (or visible).</td>
</tr>
<tr>
<td></td>
<td>Find the previous occurrence of the text in the current file. If</td>
</tr>
<tr>
<td></td>
<td>found, the text is highlighted. Note that pressing Shift+F3,</td>
</tr>
<tr>
<td></td>
<td>choosing Find Previous from the Edit menu, or clicking the Find</td>
</tr>
<tr>
<td></td>
<td>Previous toolbar button performs this operation using the current</td>
</tr>
<tr>
<td></td>
<td>settings in the Find dialog box, even if the dialog box itself is</td>
</tr>
<tr>
<td></td>
<td>not visible.</td>
</tr>
<tr>
<td>Replace</td>
<td>Replace the currently highlighted instance of the search criteria</td>
</tr>
<tr>
<td></td>
<td>in the file with the replacement string. If you want to replace</td>
</tr>
<tr>
<td></td>
<td>all occurrences of the search criteria automatically, choose the</td>
</tr>
<tr>
<td></td>
<td>Replace All option.</td>
</tr>
<tr>
<td>Replace All</td>
<td>Replace all instances of the search criteria in the file with the</td>
</tr>
<tr>
<td></td>
<td>replacement string. Compare with the Replace option.</td>
</tr>
<tr>
<td>Cancel</td>
<td>Terminate the Replace dialog box without matching and cancel all</td>
</tr>
<tr>
<td></td>
<td>entries made in the dialog box.</td>
</tr>
</tbody>
</table>
Inspect/Modify Dialog Box

The Inspect/Modify dialog box, illustrated below, allows you to examine RM/COBOL data items and also to change the contents of an RM/COBOL data item.

To reveal or hide the Inspect/Modify dialog box, select a data item in a Source Code/Edit window, and do one of the following:

- From the View menu, chose Data Item.
- Click the View/Modify Data toolbar button.
- Double-click the name of a data item.
- Right-click within the selection and choose View Data Item from the pop-up menu, or press Shift+F9 or Ctrl+I.
<table>
<thead>
<tr>
<th><strong>Use this option</strong></th>
<th><strong>To</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Name</strong></td>
<td>Enter the name of the data item to be inspected or modified. You can enter a simple name or an expression as described in the “Data Address Development” topic of Chapter 9, <em>Debugging</em>, of the RM/COBOL User’s Guide.</td>
</tr>
</tbody>
</table>
| **Type**          | Select or enter the type of the data item. Specifying `<default>` displays the data item using the actual type of the data item. You can cause the value of a data item to be displayed as a different type by choosing a type from the drop-down list. See “Data Types” under the “General Debug Concepts” section in Chapter 9, *Debugging*, of the RM/COBOL User’s Guide, for a description of allowed data types.  
If the data item is a POINTER data type (PTR), then selecting a non-PTR type from the Type list box causes CodeWatch automatically to dereference the pointer. (An indirect reference is sometimes called a dereferenced pointer.) To dereference the pointer, select the type of the pointed-to data from the list. The pointer will automatically be dereferenced to indicate that the displayed value was obtained indirectly. The value will be displayed in green. If the pointer has not been initialized, or the pointed-to memory cannot be accessed, an error message is displayed in red.  
To manufacture a pointer to a data item, select “&PTR” from the Type list box. The value of a pointer to the specified data item will be displayed in green. (An “address of” modified reference is sometimes called a manufactured pointer.)  
One use for this function is to copy the value to the Windows Clipboard, and then replace the value of another pointer with the contents of the Clipboard. To copy and paste this value, select the text with the mouse and use the pop-up menu that appears when the right mouse button is clicked in the Show text box. |
| **Show (Button)** | Cause the current value of the data item to be displayed in the Show text box (the area below the Show button). If the value is available, that is, the data item is “in scope”, meaning the currently executing program includes or contains the data item, the value will be displayed in the Show box. If the data item is “out of scope”, or the value cannot be displayed using the specified type, a message is displayed in red. |
**Use this option** | **To**
--- | ---
Show (Box) | Display the current value of the data item. If the value is available, that is, the data item is “in scope”, meaning the currently executing program includes or contains the data item, the value will be displayed in the Show box. If the data item is “out of scope”, or the value cannot be displayed using the specified type, a message is displayed in red. Indirect references and addresses of references are displayed in green. See “Data Address Development” in Chapter 9, *Debugging*, of the *RM/COBOL User’s Guide*, for more information on the pointer data item.
Change | Store any changes you made in the Show box into the data item, if possible. This button is disabled if the value is a constant item.
Watch | Add the data item to the list of watchpoints.

**Menus and Toolbars**

The CodeWatch menu bar and toolbar are illustrated below. The menu bar appears at the top of the CodeWatch main window, immediately below the title bar, and is used to issue commands. The toolbars are, by default, arrayed below the menu bar. You can, however, drag a toolbar to a different docking location, or even float the toolbar free of the CodeWatch main window by holding down the Ctrl key while dragging.

![CodeWatch Interface](image)

**Note** The CodeWatch main window menu bar and toolbar vary depending on whether or not a program file has been opened and whether the program is running.

In the sections that follow, the toolbar buttons are illustrated with the corresponding menu commands.
### File Menu

The File menu contains the following commands that operate on the current document, and on the workspace as a whole. The corresponding shortcut key and toolbar button, if applicable, are also shown.

<table>
<thead>
<tr>
<th>Command</th>
<th>Shortcut Key</th>
<th>Toolbar</th>
<th>Action</th>
</tr>
</thead>
</table>
| New     | Ctrl+N      | ![New](image) | Creates a new, empty, unnamed source code document. The new document is not a file until it is saved for the first time, does not have a type, and is not part of the workspace.  
- To give the new source code document a name, optionally give it a type (for example, COBOL source), and add it to the workspace by choosing the Save command on the File menu.  
- Only files that are named and that are in the workspace may be compiled.  
- Any number of source code documents may be opened at the same time. |
| Open    | Ctrl+O      | ![Open](image) | Opens a file. A dialog box that allows you to choose a file is displayed.  
- This menu command can open source files, copy files, COBOL libraries, and COBOL program files, and automatically add them to the current workspace.  
- If there is no current workspace, one will be created.  
- You can select more than one file by holding down the Ctrl key and clicking on the name of the file with the mouse. However, all selected files will be added to the workspace as the same type.  
- If a COBOL library is added to the workspace, a runtime /L Option naming the library will be passed to the runtime when execution begins. This is not the case for COBOL program files. |
<table>
<thead>
<tr>
<th>Command</th>
<th>Shortcut Key</th>
<th>Toolbar</th>
<th>Action</th>
</tr>
</thead>
</table>
| Close           |              | ![Close](close_icon.png) | Closes the current document.  
• If the document contains unsaved changes, you will be asked if you would like to save the changes before the document is closed.  
• If the document is maximized (that is, occupies the entire document area), the Close button is at the right end of the menu bar. Otherwise, the Close button is at the right end of the document title bar. |
| Save            | Ctrl+S       | ![Save](save_icon.png) | Saves the current document to a file.  
• This command is available only if the document contains changes that have not been saved.  
• If the document has not previously been saved into a file, then this command is the same as the Save As command. |
| Save As         |              |         | Saves the current document to a specified file and then changes the name of the document to match the new filename.  
• CodeWatch will ask you if you wish to overwrite an existing file.  
• This command is not available for files that are part of the workspace. Use the Save Copy As command instead.  
• This command is always available. |
| Save Copy As    |              |         | Saves the current document to a specified file without changing the name of the document.  
• CodeWatch will prompt if the specified file already exists.  
• This command is always available. |
<table>
<thead>
<tr>
<th>Command</th>
<th>Shortcut Key</th>
<th>Toolbar</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Workspace</td>
<td>Ctrl+Shift+N</td>
<td></td>
<td>Creates a new workspace and displays the Workspace wizard (see page 3-1).</td>
</tr>
<tr>
<td>New</td>
<td></td>
<td></td>
<td>• If a workspace is currently open, and the contents of that workspace have changed since the last save, you will be prompted to save or discard that workspace before the wizard is displayed.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• The Workspace wizard is displayed even if it has been disabled at startup.</td>
</tr>
<tr>
<td>Workspace</td>
<td>Ctrl+Shift+O</td>
<td></td>
<td>Opens a previously saved workspace.</td>
</tr>
<tr>
<td>Open</td>
<td></td>
<td></td>
<td>• If a workspace is currently open, and the contents of that workspace have changed since the last save, you will be prompted to save or discard that workspace before the new workspace is opened.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• The Open a Workspace File dialog box is displayed to allow you to choose the saved workspace, which is stored as a .cwf file.</td>
</tr>
<tr>
<td>Workspace</td>
<td>Ctrl+Shift+F4</td>
<td>X</td>
<td>Closes the current workspace without creating or opening a new workspace.</td>
</tr>
<tr>
<td>Close</td>
<td></td>
<td></td>
<td>• If the current workspace contains unsaved changes, you are asked if you want to save or discard the current workspace.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• If a program is running, it is automatically terminated when the workspace is closed.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• The Close Workspace button appears at the right end of the Workspace window title bar.</td>
</tr>
<tr>
<td>Workspace</td>
<td>Ctrl+Shift+S</td>
<td></td>
<td>Saves the current workspace to a file.</td>
</tr>
<tr>
<td>Save</td>
<td></td>
<td></td>
<td>• This command is available only if the workspace contains changes that have not been saved.</td>
</tr>
</tbody>
</table>
|               |                 |         | • If the workspace has not previously been saved into a file, then this command is the same as Workspace | Save As.
<table>
<thead>
<tr>
<th>Command</th>
<th>Shortcut Key</th>
<th>Toolbar</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Workspace</td>
<td>Ctrl+Shift+A</td>
<td></td>
<td>Saves the workspace to a specified file and then changes the name of the workspace to match the new filename.</td>
</tr>
<tr>
<td>Save As</td>
<td></td>
<td></td>
<td>• CodeWatch will ask you if you wish to overwrite an existing workspace file.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• This command is always available.</td>
</tr>
<tr>
<td>Workspace</td>
<td>Ctrl+Shift+T</td>
<td>![Workspace Icon]</td>
<td>Changes the workspace’s properties. These options are discussed in the “Workspace Properties Dialog Box” topic on page 3-61.</td>
</tr>
<tr>
<td>Properties</td>
<td></td>
<td></td>
<td>Insert Items</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>1. COBOL Source File</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>2. COBOL Copy File</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>3. COBOL Library File</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>4. COBOL Program File</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Selecting an option displays the File Selection dialog box.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• This command is available only if there is a workspace.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• You can insert any number of files in one operation by holding down the Shift key when selecting files in the dialog box. All files must be the same type.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• The Insert Items command is also available on the pop-up context menu that appears when you right-click on an item or folder in the Workspace window. The item to be inserted is determined by the highlighted item or folder.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• The type of item added by the Ins key is also determined by the currently highlighted item in the Workspace window.</td>
</tr>
</tbody>
</table>
### Remove Item

**Command** | **Shortcut Key** | **Toolbar** | **Action**
---|---|---|---
Remove Item | Del | | Removes the item currently selected in the Workspace window from the workspace.

- Folders cannot be removed from the workspace.
- Source and copy files can be removed from the workspace only if they are not in use by a COBOL program or library. In this case, you must remove the program or library from the workspace.
- The Remove Item command is also available on the pop-up context menu that appears when you right-click on an item in the Workspace window.

Note that the text of the menu item will change to reflect the action that will be performed.

### Item Properties

**Command** | **Shortcut Key** | **Toolbar** | **Action**
---|---|---|---
Item Properties | Ctrl+T | | Displays the properties of the selected item in the Item Properties dialog box. (See page 3-73 for a complete discussion of this dialog box.)

- The tabbed property page that is displayed in the dialog box (Source File, Program, or Build Options) is dependent on the item that is currently selected in the Workspace window.
- The item properties that can be examined include:
  1. A list of included copy files.
  2. A list of programs produced when the source file was compiled, or a list of source files that depend on the copy file.
  3. For source files, the build settings that were in effect for the last compilation.

The Build Options tabbed property page box allows you to set the compilation options for the specified item, and also allows you to set the default compilation options to be used for all files that do not have individual settings. (See page 5-2 for more details.)
<table>
<thead>
<tr>
<th>Command</th>
<th>Shortcut Key</th>
<th>Toolbar</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open Item</td>
<td>F2</td>
<td></td>
<td>Opens a Source Code/Edit window for the item that is currently highlighted in the Workspace window.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>The highlighted item may be:</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>- A source or copy file. The specified file is opened.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>- A COBOL program. If the program was compiled with the /Y2 or /Y3 option, and the source code file is accessible, then the file is opened and the cursor is positioned to the beginning of the selected program.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>- A COBOL library or program file. If the library or program file contains programs that were compiled with the /Y2 or /Y3 option, and the source code file is accessible, then the file is opened and the cursor is positioned to the beginning of the selected program. If the library was created by the Combine Program utility (rmpgmcom) program, the source file for the first embedded COBOL program that was compiled with /Y2 or /Y3 is opened.</td>
</tr>
<tr>
<td>Note</td>
<td></td>
<td></td>
<td>Note that the text of the menu item will change to reflect the action that will be performed.</td>
</tr>
<tr>
<td></td>
<td>Alt+F2</td>
<td></td>
<td>Invokes the external editor. If you have not configured an external editor, CodeWatch will issue a query as to whether you want to do so. If you do, CodeWatch displays the External Editing page (see page 4-12) of the Preferences dialog box so that you can configure the editor of your choice.</td>
</tr>
<tr>
<td>Note</td>
<td></td>
<td></td>
<td><strong>Note</strong> If an external editor has not been configured, the text of this command is Edit File “filename” with… .</td>
</tr>
<tr>
<td>Command</td>
<td>Shortcut Key</td>
<td>Toolbar</td>
<td>Action</td>
</tr>
<tr>
<td>---------------------</td>
<td>--------------</td>
<td>---------</td>
<td>------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Recent Workspaces</td>
<td></td>
<td></td>
<td>Displays a list of recently opened workspaces.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>- Choose one of the workspaces in the list to open the workspace quickly.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>- You can quickly access a workspace in the list by pressing the key representing the digit in front of the workspace name. For example, to quickly reopen the most recently used workspace, press Alt+F to pull down the File menu, and then press the 1 key.</td>
</tr>
<tr>
<td>Exit</td>
<td>Alt+F4</td>
<td>![X]</td>
<td>Ends your CodeWatch session.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>- If the current workspace has not been saved, you are asked either to save or discard the contents of the workspace.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>- The Close button appears at the right end of the title bar in the CodeWatch main window.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>- Any running program is automatically terminated before CodeWatch exits.</td>
</tr>
</tbody>
</table>
## Edit Menu

The Edit menu contains the following commands that operate on the current selection or the object that currently has focus. The corresponding shortcut key and toolbar button, if applicable, are also shown.

<table>
<thead>
<tr>
<th>Command</th>
<th>Shortcut Key</th>
<th>Toolbar</th>
<th>Action</th>
</tr>
</thead>
</table>
| Undo    | Ctrl+Z or Alt+Backspace | | Undoes one level of changes to the current file.  
• The change to be undone may be as simple as a typed character, or as complicated as a Replace that affected every line in the file.  
• You can issue the Undo command repeatedly to undo additional changes.  
• You can undo an undo operation with the Redo command (see below). |
| Redo    | Ctrl+Y or Ctrl+Backspace | | Reverses the effect of the last Undo operation.  
• This command is available only after an Undo operation.  
• An Undo command can be undone with a Redo command only if no additional changes have been made to the document since that Undo command was issued.  
• If the Undo command has been issued repeatedly, the Redo command can also be used repeatedly to undo each level of Undo. |
<p>| Cut     | Ctrl+X or Shift+Del | | Copies the current selection to the Windows Clipboard, and then deletes the selection. |
| Copy    | Ctrl+C or Ctrl+Ins | | Copies the current selection to the Windows Clipboard. |
| Paste   | Ctrl+V or Shift+Ins | | Inserts the contents of the Windows Clipboard at the cursor position. If there is an active selection, the selected text is replaced with the text from the Windows Clipboard. |</p>
<table>
<thead>
<tr>
<th>Command</th>
<th>Shortcut Key</th>
<th>Toolbar</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select All</td>
<td>Ctrl+A</td>
<td></td>
<td>Selects all text in the current document.</td>
</tr>
<tr>
<td>Find</td>
<td>Ctrl+F or</td>
<td><img src="image" alt="Find toolbar icon" /></td>
<td>Displays the Find dialog box, which allows you to search for text strings in the current document. See page 3-36.</td>
</tr>
<tr>
<td></td>
<td>Alt+F3</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Find Next</td>
<td>F3</td>
<td><img src="image" alt="Find Next toolbar icon" /></td>
<td>Searches for the next occurrence of the last text string for which you searched. The search is always toward the end of the file.</td>
</tr>
<tr>
<td>Find Previous</td>
<td>Shift+F3</td>
<td><img src="image" alt="Find Previous toolbar icon" /></td>
<td>Searches for the previous occurrence of the last text string for which you searched. The search is always toward the beginning of the file.</td>
</tr>
<tr>
<td>Replace</td>
<td>Ctrl+H</td>
<td><img src="image" alt="Replace toolbar icon" /></td>
<td>Displays the Replace dialog box, which allows you to search for and replace text strings in the current document. See page 3-40.</td>
</tr>
<tr>
<td>Breakpoints</td>
<td>Ctrl+B</td>
<td><img src="image" alt="Breakpoints toolbar icon" /></td>
<td>Displays the Code Breakpoints page of the Breakpoints &amp; Watchpoints dialog box. See page 3-69.</td>
</tr>
<tr>
<td>Watchpoints</td>
<td>Ctrl+W</td>
<td><img src="image" alt="Watchpoints toolbar icon" /></td>
<td>Displays the Data Watchpoints page of the Breakpoints &amp; Watchpoints dialog box. See page 3-69.</td>
</tr>
</tbody>
</table>
## View Menu

The View menu contains the following commands. The corresponding shortcut key and toolbar button, if applicable, are also shown. When these commands are selected, a check mark (✓) appears to the left of the menu option.

<table>
<thead>
<tr>
<th>Command</th>
<th>Shortcut Key</th>
<th>Toolbar</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Toolbar</td>
<td></td>
<td></td>
<td>Displays or hides the toolbars.</td>
</tr>
<tr>
<td>Status Bar</td>
<td></td>
<td></td>
<td>Displays or hides the status bar.</td>
</tr>
<tr>
<td>Breakpoints Tab</td>
<td>Alt+1</td>
<td></td>
<td>Displays the Breakpoints tab (see page 3-21) in the Data window.</td>
</tr>
<tr>
<td>Watchpoints Tab</td>
<td>Alt+2</td>
<td></td>
<td>Displays the Watchpoints tab (see page 3-23) in the Data window.</td>
</tr>
<tr>
<td>Data Files Tab</td>
<td>Alt+3</td>
<td></td>
<td>Displays the Data Files tab (see page 3-25) in the Data window.</td>
</tr>
<tr>
<td>Call Stack Tab</td>
<td>Alt+4</td>
<td></td>
<td>Displays the Call Stack tab (see page 3-26) in the Data window.</td>
</tr>
<tr>
<td>Build Results Tab</td>
<td>Alt+5</td>
<td></td>
<td>Displays the Build Results tab (see page 3-27) in the Data window.</td>
</tr>
<tr>
<td>Log Window</td>
<td>Alt+6</td>
<td></td>
<td>Displays or hides the interactive debug Log window (see page 3-29).</td>
</tr>
<tr>
<td>Data Item</td>
<td>Shift+F9 or Ctrl+I</td>
<td></td>
<td>Displays or hides the Inspect/Modify dialog box (see page 3-42).</td>
</tr>
<tr>
<td>Program Output</td>
<td>F12</td>
<td></td>
<td>If the RM/COBOL program is currently running, reveals the RM/COBOL program output window and gives it the input focus.</td>
</tr>
<tr>
<td>Preferences</td>
<td>Alt+0</td>
<td></td>
<td>Displays the Preferences dialog box (described on page 4-9) where you can customize the behavior of the Source Code/Edit window.</td>
</tr>
</tbody>
</table>
## Build Menu

The Build menu contains the following commands. The corresponding shortcut key and toolbar button, if applicable, are also shown.

<table>
<thead>
<tr>
<th>Command</th>
<th>Shortcut Key</th>
<th>Toolbar</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Compile File</td>
<td>Ctrl+F7</td>
<td></td>
<td>Compiles the currently selected file or document.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• If a source file is opened in the Source Code/Edit window, the edit document containing the cursor is compiled.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• If the focus is in the Workspace window, and a COBOL source file is selected, that file is compiled. In this case, the menu item will contain the name of the file to compile.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• If the current source file has been edited and not saved, you will be asked to save the file or cancel the compilation.</td>
</tr>
<tr>
<td>Compile Changes</td>
<td>F7</td>
<td></td>
<td>Compiles all files in the workspace that are marked as requiring recompilation.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• If a file to be compiled is open in a Source Code/Edit window, has been edited, and has not been saved, you will be asked to save the file or cancel the compilation.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• The following events will cause a file to be marked as needing recompilation:</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>− If the file has been edited.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>− If a copy file used by the source file has been edited.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>− If the program file associated with the source file cannot be located, or if the timestamp of the source file is more recent than the timestamp of the program file.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>− If a compilation option has been changed either at the file or at the workspace level and compiling the file with the current options would affect the program.</td>
</tr>
<tr>
<td>Command</td>
<td>Shortcut Key</td>
<td>Toolbar</td>
<td>Action</td>
</tr>
<tr>
<td>-----------------</td>
<td>----------------------</td>
<td>---------</td>
<td>----------------------------------------------------------------------</td>
</tr>
<tr>
<td>Compile All</td>
<td>Ctrl+Shift+F7</td>
<td></td>
<td>Compiles all source files in the workspace.</td>
</tr>
<tr>
<td>Options</td>
<td>Alt+F7</td>
<td></td>
<td>Displays the Build Options page of the Item Properties dialog box for the currently selected source file. This page allows you to set compilation options for the current file, or for the entire workspace. (See page 3-76 for more information.)</td>
</tr>
<tr>
<td>Results</td>
<td>Find Next</td>
<td>F4</td>
<td>Displays a submenu where you can choose to move the cursor to the next or previous error or warning in the current file.</td>
</tr>
<tr>
<td>Results</td>
<td>Find Previous</td>
<td>Shift+F4</td>
<td></td>
</tr>
</tbody>
</table>
The Run menu contains the following commands. The corresponding shortcut key and toolbar button, if applicable, are also shown.

<table>
<thead>
<tr>
<th>Command</th>
<th>Shortcut Key</th>
<th>Toolbar</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start</td>
<td>F5</td>
<td></td>
<td>Starts running the workspace.</td>
</tr>
<tr>
<td>Break</td>
<td></td>
<td></td>
<td>• If the workspace program is already running, breaks execution at the next statement.</td>
</tr>
<tr>
<td>Resume</td>
<td></td>
<td></td>
<td>• Resumes running after a break.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Note that the name of this command in the menu changes depending on the state you are in.</td>
</tr>
<tr>
<td>Stop</td>
<td></td>
<td></td>
<td>Stops the program.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• This is an orderly shutdown and all files will be properly closed. Execution can be restarted only from the beginning of the program.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• If the Persistent runtime attribute is set, the program cannot be restarted until you close the RM/COBOL program output window.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>See Chapter 3 in the RM/COBOL User’s Guide.</td>
</tr>
<tr>
<td>Step Statement</td>
<td>F8</td>
<td></td>
<td>Executes one statement.</td>
</tr>
<tr>
<td>Step Paragraph</td>
<td>Shift+F8</td>
<td></td>
<td>Runs to the end of the current paragraph.</td>
</tr>
<tr>
<td>Step Section</td>
<td>Ctrl+F8</td>
<td></td>
<td>Runs to the end of the current section.</td>
</tr>
<tr>
<td>Step Program</td>
<td>Alt+F8</td>
<td></td>
<td>Runs until the current program returns or exits.</td>
</tr>
<tr>
<td>To Cursor</td>
<td>Shift+F5</td>
<td></td>
<td>Runs to the line in the current Source Code/Edit window that contains the cursor.</td>
</tr>
<tr>
<td>To Program Change</td>
<td>Alt+F5</td>
<td></td>
<td>Runs until the program highlighted by the cursor is entered or re-entered.</td>
</tr>
</tbody>
</table>
Breakpoint

Displays a submenu that allows you to set, clear, enable or disable, clear all, and show state of breakpoints. The commands on this submenu are described in the following table.

Animate

Enables or disables animation. When enabled, CodeWatch highlights each line as it is executed. When disabled, CodeWatch displays source code lines only when execution is paused or stops.

When the program is running, you can pause execution at any time by pressing the F5 key in CodeWatch.

When this command is selected, a check mark (✓) appears to the left of the menu option.

The following functions are accessible from the Run | Breakpoint menu, the toolbar and the keyboard, and are enabled only while a source code file is open in the Source Code/Edit window.

<table>
<thead>
<tr>
<th>Command</th>
<th>Shortcut Key</th>
<th>Toolbar</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Set</td>
<td></td>
<td></td>
<td>Inserts (or sets) a breakpoint at the line that contains the cursor.</td>
</tr>
<tr>
<td>Clear</td>
<td></td>
<td></td>
<td>Removes (or clears) the breakpoint at the current line.</td>
</tr>
<tr>
<td>Toggle Breakpoint</td>
<td>F9</td>
<td></td>
<td>Sets or clears a breakpoint at the current line. Note that the button appears pressed, and the menu option is checked if the current line contains a breakpoint.</td>
</tr>
<tr>
<td>Clear All Breakpoints</td>
<td></td>
<td></td>
<td>Removes (or clears) all breakpoints from the workspace.</td>
</tr>
<tr>
<td>State</td>
<td>Disable</td>
<td></td>
<td>Temporarily disables the breakpoint at the current line.</td>
</tr>
<tr>
<td>State</td>
<td>Enable</td>
<td></td>
<td>Enables the breakpoint at the current line.</td>
</tr>
<tr>
<td>Command</td>
<td>Shortcut Key</td>
<td>Toolbar</td>
<td>Action</td>
</tr>
<tr>
<td>---------------------</td>
<td>--------------</td>
<td>---------</td>
<td>----------------------------------------------------------------------</td>
</tr>
<tr>
<td>State</td>
<td>Toggle</td>
<td>Ctrl+F9</td>
<td>Enables or disables a breakpoint at the line that contains the cursor. Note that the button appears pressed and the menu option is checked if the current line contains an enabled breakpoint.</td>
</tr>
<tr>
<td>State</td>
<td>Disable All</td>
<td></td>
<td>Disables all breakpoints in the workspace without removing the breakpoints.</td>
</tr>
<tr>
<td>State</td>
<td>Enable All</td>
<td></td>
<td>Enables all disabled breakpoints in the workspace.</td>
</tr>
</tbody>
</table>

**Window Menu**

The Window menu contains the following commands. (For additional information, see also “Using Document Windows” on page 3-31.)

<table>
<thead>
<tr>
<th>Command</th>
<th>Shortcut Key</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>New Window</td>
<td></td>
<td>Opens a new document window that displays the same content as the current window. This command is available only for Source Code/Edit windows (see page 4-2).</td>
</tr>
<tr>
<td>Cascade</td>
<td></td>
<td>Cascades all document windows from left to right and top to bottom in the client area of the frame of the CodeWatch main window.</td>
</tr>
<tr>
<td>Tile</td>
<td></td>
<td>Arranges all document windows so they are visible in the client area of the frame of the CodeWatch main window.</td>
</tr>
<tr>
<td>Arrange Icons</td>
<td></td>
<td>Arranges all minimized document windows across the bottom of the client area of the frame of the CodeWatch main window.</td>
</tr>
<tr>
<td>Command</td>
<td>Shortcut Key</td>
<td>Action</td>
</tr>
<tr>
<td>---------------------------</td>
<td>--------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Split</td>
<td></td>
<td>Splits the current document window into two or four panes, each of which may be independently scrolled over the window content. This command is available only if the current window supports this operation. (See page 3-35 for more information.)</td>
</tr>
<tr>
<td>Pane</td>
<td>Next</td>
<td>F6</td>
</tr>
<tr>
<td>Pane</td>
<td>Previous</td>
<td>Shift+F6</td>
</tr>
<tr>
<td>Docked</td>
<td></td>
<td>If the current window is a dockable window, toggles the window between a docked window and a document window. When selected, the window is overlaid by two perpendicular intersecting lines, which may be positioned with the mouse or the keyboard. This command is available only if the current window supports this operation. (See page 3-14 for additional information.)</td>
</tr>
<tr>
<td>Floating</td>
<td></td>
<td>If the current window is a docked window, undocks the window and allow the window to float outside the frame of the CodeWatch main window. This command is available only if the current window supports this operation. (See page 3-36 for additional information.)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Note that the window will automatically dock if moved over a docking site on the frame of the CodeWatch main window. To avoid docking, hold down the Ctrl key while moving the window.</td>
</tr>
<tr>
<td>Open Windows</td>
<td></td>
<td>Displays a list of currently opened document windows. To choose one of the windows in the list, type the number or click the name that corresponds to the Source Code/Edit window you want to work with.</td>
</tr>
</tbody>
</table>
Workspace Properties Dialog Box

The Workspace Properties dialog box contains four pages: Program, Options, Environment, and Command. These pages correspond closely to pages in the Workspace wizard, which is described beginning on page 3-1. The Workspace wizard pages are used to establish properties when a workspace is being created, whereas the pages in the Workspace Properties dialog box allow you to change the properties of an existing workspace. Each page of the Workspace Properties dialog box is described in detail in the following sections.

To open the Workspace Properties dialog box, do one of the following:

- From the File menu, choose Workspace | Properties.
- Click the Properties toolbar button.
- Press Ctrl+Shift+T.

Several buttons appear along the bottom of the Workspace Properties dialog box no matter which page is selected and displayed. They perform the same function or action on all the pages of the dialog box and are described below.

<table>
<thead>
<tr>
<th>Use this button</th>
<th>To</th>
</tr>
</thead>
<tbody>
<tr>
<td>OK</td>
<td>Save changes and close the page.</td>
</tr>
<tr>
<td>Cancel</td>
<td>Cancel the page.</td>
</tr>
<tr>
<td>Apply</td>
<td>Apply changes without closing the page. Changes made with the Apply button cannot be canceled by clicking the Cancel button.</td>
</tr>
<tr>
<td>Help</td>
<td>Display help for this page.</td>
</tr>
</tbody>
</table>
Program Page

The Program page of the Workspace Properties dialog box, illustrated below, allows you to specify the name of the main program to run and to define the execution environment for that program.

<table>
<thead>
<tr>
<th>Use this option</th>
<th>To</th>
</tr>
</thead>
<tbody>
<tr>
<td>Program to Run</td>
<td>Type or select the name of the COBOL program that CodeWatch is to run. This can be one of the following:</td>
</tr>
<tr>
<td></td>
<td>• The filename of a COBOL object file (for example, VERIFY.COB).</td>
</tr>
<tr>
<td></td>
<td>• The name of a COBOL program to be found in a COBOL library (for example, VERIFY).</td>
</tr>
<tr>
<td></td>
<td>CodeWatch uses the RM/COBOL runtime to locate programs (see the “Subprogram Loading” topic in Chapter 8, RM/COBOL Features, of the RM/COBOL User’s Guide, for a complete description of the methods). For example, if VERIFY is specified as the program to run, and VERIFY is not found in any configured library, then the RM/COBOL runtime system will optionally search for a synonym for VERIFY in the environment, and will then search for a file named VERIFY.COB that contains exactly one separately compiled COBOL program in the current directory, the PATH, and the RUNPATH. CodeWatch does not attempt to resolve an ambiguous main program name until execution begins.</td>
</tr>
<tr>
<td></td>
<td>This box may be left blank. If a main program is not specified, you will be asked for the program name when you run the workspace.</td>
</tr>
<tr>
<td>Browse</td>
<td>Open the Select a Program File dialog box where you can search for and select a COBOL program file (.cob).</td>
</tr>
<tr>
<td>Use this option</td>
<td>To</td>
</tr>
<tr>
<td>-------------------------</td>
<td>----------------------------------------------------------------------</td>
</tr>
<tr>
<td>No Debug</td>
<td>When selected, disable debugging. (The /D Runtime Command Option is always assumed to be present unless you disable it.) The program will be run as if CodeWatch were not present, using the parameters in the workspace.</td>
</tr>
<tr>
<td>Use Instrumentation</td>
<td>When selected, enable instrumentation. This option is equivalent to the /I Runtime Command Option.</td>
</tr>
<tr>
<td>Execution Directory</td>
<td>Select the current directory at the time the COBOL program begins execution. This selection can be one of three values:</td>
</tr>
<tr>
<td></td>
<td>• <strong>CodeWatch Startup Directory.</strong> The runtime will be started in the directory where CodeWatch was started, which is the default.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Runtime Installation Directory.</strong> The runtime will be started in the directory where the RM/COBOL runtime was installed.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Actual Directory Name.</strong> The fully or partially qualified pathname of a directory. If you enter a relative pathname in this list box, it is interpreted as being relative to the CodeWatch startup directory.</td>
</tr>
<tr>
<td>Browse</td>
<td>Open a Browse for Folder dialog box where you can search for and select an execution directory.</td>
</tr>
<tr>
<td>Switches</td>
<td>Set or clear the current set of runtime switches. The eight switches are numbered consecutively from left to right. These options are equivalent to the /S Runtime Command Option.</td>
</tr>
</tbody>
</table>

For a description of the buttons that appear along the bottom of this page of the Workspace Properties dialog box, see page 3-61.
Options Page

The Options page of the Workspace Properties dialog box, illustrated below, allows you to specify additional execution parameters.

<table>
<thead>
<tr>
<th>Use this option</th>
<th>To</th>
</tr>
</thead>
</table>
| Arguments to Main Program        | Enter arguments to be passed to the main program. This option has the following format:  

{delimiter}string{delimiter}

The delimiter character may be either a single or double quote, must not appear within string, and is required only if string contains spaces or tabs. If you enter a string that contains spaces, but do not use a delimiter, CodeWatch will provide a delimiter or display an error if no delimiter can be chosen. This option is equivalent to the /A Runtime Command Option. |
| Overriding Configuration File    | Select or enter the name of the primary runtime configuration file. This file completely overrides the default runtime configuration. This option is equivalent to the /C Runtime Command Option. If a relative path is specified, the path is interpreted as relative to the directory specified in the Execution Directory option on the Program page (see page 3-62). |
| Browse                           | Open the Select a Configuration File dialog box where you can search for and select a configuration file (.cfg). |
Use this option | To
--- | ---
**Supplemental Configuration File** | Select or enter the name of the supplemental runtime configuration file. The contents of this file supplement the default runtime configuration without replacing it. If an overriding configuration is specified, the contents of this file supplement that configuration. If no other configuration is specified, this file provides the complete configuration. This option is equivalent to the /X Runtime Command Option. If a relative path is specified, the path is interpreted as relative to the directory specified in the Execution Directory option on the Program page (see page 3-62).

**Browse** | Open the Select a Configuration File dialog box where you can search for and select a configuration file (.cfg).

**Accept Buffer Size** | Enter the maximum buffer size to be used by ACCEPT and DISPLAY statements. The maximum size is 65280 characters, and the default size is 264 characters. This option is equivalent to the /B Runtime Command Option.

**Memory for Sort** | Enter the amount of memory (in bytes) to be used for a sort operation. The default is 256000 bytes. Specify a larger value to improve the efficiency of sort operations. Decrease this value to allocate more memory for other data or called subprograms. If neither SORT nor MERGE operations will be used in this run unit, specifying 0 will free all reserved memory for other uses. This option is equivalent to the /T Runtime Command Option.

**Level 2 ANSI Semantics for Format 1 ACC/DIS** | When selected, indicate that Level 2 ANSI semantics are to be used for Format 1 ACCEPT and DISPLAY operations. The default is to use Level 1 ANSI semantics for these operations. This option is equivalent to the /M Runtime Command Option.

**Suppress Startup and STOP RUN Messages** | When selected, suppress the banner message and the STOP RUN message. This option is equivalent to the /K Runtime Command Option.

For a description of the buttons that appear along the bottom of this page of the Workspace Properties dialog box, see page 3-61.
Environment Page

The Environment page of the Workspace Properties dialog box, illustrated below, allows you to specify the execution environment for your RM/COBOL program. The Environment page contains five tabs. Click on a tab to set the parameters for the options available.

<table>
<thead>
<tr>
<th>Use this option</th>
<th>To</th>
</tr>
</thead>
<tbody>
<tr>
<td>Libraries</td>
<td>Specify a list of pathnames of COBOL and non-COBOL program libraries to be loaded. Libraries are loaded and searched in the specified order. The order can be changed by selecting a library and pressing the Move Up or Move Down buttons to move the name of the library within the list, or by dragging the name of the library to a new position with the mouse. Relative pathnames are interpreted relative to the directory specified in the Execution Directory option on the Program page (see page 3-62). This option is equivalent to the /L Runtime Command Option.</td>
</tr>
<tr>
<td>Run Path</td>
<td>Specify a list of directories to be inserted before the RUNPATH environment variable. The RM/COBOL runtime will search these directories in the specified order for COBOL programs, libraries, non-COBOL libraries, and configuration files. These directories are inserted in front of any directories already in the RUNPATH environment variable. Relative pathnames are interpreted relative to the directory specified in the Execution Directory option on the Program page (see page 3-62).</td>
</tr>
<tr>
<td>Program Path</td>
<td>Specify a list of directories to be inserted before the PATH environment variable. These directories are inserted in front of any directories already in the PATH environment variable. Relative pathnames are interpreted relative to the directory specified in the Execution Directory option on the Program page (see page 3-62).</td>
</tr>
</tbody>
</table>
Use this option | To
---|---
Environment | Specify a list of string pairs to be placed into the RM/COBOL program’s environment. The syntax is:

\[name=value\]

Among other purposes, environment strings are used to specify synonyms for filenames. See the “Locating RM/COBOL Files” topic in Chapter 3, *Installation and System Considerations for Microsoft Windows*, of the *RM/COBOL User’s Guide*.

Source | Specify a list of directories to be searched for source files in the event that a source file cannot be found at the location specified in the object file. These directories are searched in the specified order, and the first file with a matching name is used. Relative pathnames are interpreted relative to the directory specified in the Execution Directory option on the Program page (see page 3-62). For more information, see “How CodeWatch Finds Source Files During Execution” on page 4-1 and “Viewing Source During Program Execution” on page 4-8.

The following buttons appear on each of the tabs of the Environment page and perform the same function on each tab.

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="New" /></td>
<td>New. Inserts a new item.</td>
</tr>
<tr>
<td><img src="image" alt="Delete" /></td>
<td>Delete. Removes the selected item.</td>
</tr>
<tr>
<td><img src="image" alt="Move Up" /> <img src="image" alt="Move Down" /></td>
<td>Move Up (Alt+Up Arrow) and Move Down (Alt+Down Arrow). Moves the selected item up or down in the list.</td>
</tr>
<tr>
<td><img src="image" alt="Ellipsis" /></td>
<td>Ellipsis. On tabs that specify files or directories, clicking this button displays a File Open dialog box in order to search for and select a file or directory.</td>
</tr>
</tbody>
</table>

For a description of the buttons that appear along the bottom of this page of the Workspace Properties dialog box, see page 3-61.
**Command Page**

The Command page of the Workspace Properties dialog box, illustrated below, displays a text box where you can view or edit the RM/COBOL Runtime Command line options.

<table>
<thead>
<tr>
<th>Use this option</th>
<th>To</th>
</tr>
</thead>
<tbody>
<tr>
<td>RM/COBOL Runtime Command Line</td>
<td>Display the command line that will be used to invoke the RM/COBOL runtime, based on the current configuration in these property pages. Runtime Command line options may be changed by appending, deleting, or overtyping text in this text box. Any such changes will immediately be visible in the other properties pages, but will not be applied to the workspace until either the OK or Apply button is pressed.</td>
</tr>
</tbody>
</table>

For a description of the buttons that appear along the bottom of this page of the Workspace Properties dialog box, see page 3-61.
Breakpoints and watchpoints can be created, changed, and removed by using the Breakpoints & Watchpoints dialog box. This dialog box contains two tabbed pages: Code Breakpoints and Data Watchpoints.

**Code Breakpoints Page**

The Code Breakpoints page, illustrated below, allows you to create, remove, or change the properties of any or all breakpoints that are set in your workspace.

To display the Code Breakpoints page, do one of the following:

- From the **Edit** menu, choose **Breakpoints**.
- Click the **Edit Breakpoints** toolbar button.
- Press **Ctrl+B**.
- From the Breakpoints tab of the Data window (see page 3-21), right-click a program name and select **Properties** from the pop-up context menu or press **Alt+Enter**.
<table>
<thead>
<tr>
<th>Use this option</th>
<th>To</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Program</strong></td>
<td>Select or enter the name of the program that contains the breakpoint.</td>
</tr>
<tr>
<td><strong>Line</strong></td>
<td>Specify the number of the line that will cause a break to occur when executed.</td>
</tr>
<tr>
<td><strong>Stmt</strong></td>
<td>Specify the statement number within the line. Leave this blank to indicate that the break will occur when the first (or only) statement on the line is executed. Or, specify an offset: +1 indicates the second statement on the line, and +2 indicates the third.</td>
</tr>
<tr>
<td><strong>Pass</strong></td>
<td>Specify whether the breakpoint is to be skipped a number of times before being triggered. The default is to trigger the breakpoint on each pass. For example, a value of 5 indicates that the breakpoint will be skipped four times and then triggered. Once a breakpoint is triggered, it will be triggered on each subsequent pass unless the pass count is set again.</td>
</tr>
<tr>
<td><img src="image" alt="Add or change a breakpoint in the list. If the program name, line number, and statement offset match another breakpoint in the list, that breakpoint is changed. Otherwise, a new breakpoint is added to the list." /></td>
<td>Add or change a breakpoint in the list. If the program name, line number, and statement offset match another breakpoint in the list, that breakpoint is changed. Otherwise, a new breakpoint is added to the list.</td>
</tr>
<tr>
<td><img src="image" alt="Copy the properties of a breakpoint into the text boxes." /></td>
<td>Copy the properties of a breakpoint into the text boxes.</td>
</tr>
<tr>
<td><img src="image" alt="Remove the highlighted breakpoint from the list. The contents of the text boxes are ignored." /></td>
<td>Remove the highlighted breakpoint from the list. The contents of the text boxes are ignored.</td>
</tr>
<tr>
<td><strong>List of Code Breakpoints</strong></td>
<td>Display a list of all code breakpoints in the current workspace. Each breakpoint is preceded by a red circle. A solid red circle indicates that the breakpoint is enabled; a hollow red circle indicates the breakpoint is disabled. This is followed by the name of the program, the line number, the statement number within the line, and the pass number. A disabled breakpoint can be enabled, and an enabled breakpoint disabled by clicking on the red circle that precedes the breakpoint in this list.</td>
</tr>
</tbody>
</table>
### Use this option

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>OK</strong></td>
<td>Apply all changes made to the list of breakpoints to the workspace and close the page.</td>
</tr>
<tr>
<td><strong>Cancel</strong></td>
<td>Cancel the page without saving changes.</td>
</tr>
<tr>
<td><strong>Apply</strong></td>
<td>Apply all changes made to the list of breakpoints to the workspace without closing the page. Changes made with the Apply button cannot be canceled by clicking the Cancel button.</td>
</tr>
<tr>
<td><strong>Help</strong></td>
<td>Display help for this page.</td>
</tr>
</tbody>
</table>

## Data Watchpoints Page

The Data Watchpoints page, illustrated below, allows you to create, remove, or change the properties of any or all watchpoints that are set in your workspace.

To display the Data Watchpoints page, do one of the following:

- From the **Edit** menu, choose **Watchpoints**.
- Click the **Edit Watchpoints** toolbar button.
- Press **Ctrl+W**.
- From the Watchpoints tab of the Data window (see page 3-23), right-click a data item name and select **Properties** from the pop-up context menu or press **Alt+Enter**.
<table>
<thead>
<tr>
<th>Use this option</th>
<th>To</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Data Item</strong></td>
<td>Enter the name of the data item being watched.</td>
</tr>
<tr>
<td><strong>In/Of Data Item</strong></td>
<td>Specify qualification for the data item, if the name is not unique. The sequence of names must form a valid qualified reference to a data item, according to the rules for source program data references. After typing a data item name, click this button to add the item to the list. Use the up and down arrow buttons to arrange and order the data items in the list. Click this button to remove a data item from the list.</td>
</tr>
<tr>
<td><strong>Subscript</strong></td>
<td>Specify a list of decimal integer subscripts that specify the table element to watch if Data Item is a table. After typing a decimal integer subscript, click this button to add the subscript to the list. Use the up and down arrow buttons to arrange and order the subscripts in the list. Click this button to remove a subscript from the list. The number of subscripts must match the number of OCCURS clauses in the hierarchy of data description entries for the data item. The value of each integer is interpreted as an occurrence number in the same way as a literal subscript in the source program.</td>
</tr>
<tr>
<td><strong>Ref Mod Offset and Length</strong></td>
<td>Optionally specify a subfield of the data item. Offset is a decimal number with a value ranging from 1 to the length of the data item. Length is a decimal number whose value ranges from 1 to the remaining length of the data item, after Offset has been applied. If Length is not specified, but Offset is specified, the length from offset to the end of the data item is presumed.</td>
</tr>
<tr>
<td><strong>Type</strong></td>
<td>Select the type of the watchpoint. This option is used to display the value of the data item in the Watchpoints tab of the Data window (see page 3-23). If the data item being watched is a PTR data item, it is possible to watch either the value of the PTR or the memory that the data item points to. To watch the pointer’s value, select PTR from the Type list. To watch the pointed-to memory, select “type” from the list. For a description of allowed data types, see “Data Types” under the “General Debug Concepts” section in Chapter 9, Debugging, of the RM/COBOL User’s Guide.</td>
</tr>
</tbody>
</table>
Item Properties Dialog Box

The Item Properties dialog box allows you to inspect and examine or change the properties of the currently selected item. This dialog box contains three tabbed property pages: Source File, Programs, and Build Options.

Note In this release of CodeWatch, only source files can have their properties inspected and/or changed.
If a Source Code/Edit window is open, you can display the Item Properties dialog box by doing one of the following:

- From the File menu, choose Item Properties or click Ctrl+T.
- Select Properties from the workspace pop-up context menu that appears when you right-click in the Workspace window or Source Code/Edit window.
- Press Alt+Enter in the Source Code/Edit window or in the Workspace window.

**Note** To display the Item Properties dialog box by one of these methods when a Source Code/Edit window is not open, you must first select a source or copy file on the Files tab of the Workspace window.

**Source File Property Page**

The Source File property page, illustrated below, displays information about the currently selected source file.

<table>
<thead>
<tr>
<th>Use this option</th>
<th>To</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pathname</td>
<td>Display the complete pathname of the currently selected source file.</td>
</tr>
<tr>
<td>Last Modified</td>
<td>Display the date/time that the source file was last changed. This is the same as the date of the file on the disk.</td>
</tr>
<tr>
<td>COPY Files</td>
<td>Display a list of copy files that were included when this source file was last compiled, including the name of the file and its location.</td>
</tr>
</tbody>
</table>
**Programs Property Page**

The Programs property page, illustrated below, contains a list of programs that were generated when this source file was last compiled.

![Programs Property Page](image)

<table>
<thead>
<tr>
<th>Use this option</th>
<th>To</th>
</tr>
</thead>
<tbody>
<tr>
<td>Source File</td>
<td>Display the complete pathname of the currently selected source file.</td>
</tr>
<tr>
<td>Compiled</td>
<td>Display the date/time that the source file was last compiled.</td>
</tr>
<tr>
<td>Programs</td>
<td>Display a list of programs in the program file that were created when this file was compiled. The name of the program file, the library, and its location are available.</td>
</tr>
</tbody>
</table>
Build Options Property Page

The Build Options property page, illustrated below, details the options that were in effect the last time this source file was compiled and the options that are currently in effect.

<table>
<thead>
<tr>
<th>Use this option</th>
<th>To</th>
</tr>
</thead>
<tbody>
<tr>
<td>Source File</td>
<td>Display the complete pathname of the currently selected source file.</td>
</tr>
<tr>
<td>Compiled</td>
<td>Display the date/time that the source file was last compiled.</td>
</tr>
</tbody>
</table>
| Build Options          | Display a list of the compilation options that were in effect the last time this source file was compiled. For each compilation option, this page also specifies the default settings for the workspace and the settings for this file. The columns in the table provide the following information:

- **Option.** A description of the RM/COBOL compilation option.
- **File.** The setting for the currently selected file for each option.
- **All.** The setting for the workspace. This setting is used if the File column is blank for a given option.
- **Last Build.** The setting that was used when the file was last compiled. This setting is used if both the File and the All columns are blank for a given option.
<table>
<thead>
<tr>
<th>Use this option</th>
<th>To</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Change Setting For</strong></td>
<td>Change the setting in the column aligned with the button:</td>
</tr>
<tr>
<td>• <strong>File.</strong></td>
<td>Cycles the setting for the currently selected option between the possible values for the option. You can press this button from the keyboard by typing Alt+F.</td>
</tr>
<tr>
<td>• <strong>All.</strong></td>
<td>Cycles the setting for the currently selected option between the possible values for the option. You can press this button from the keyboard by typing Alt+A.</td>
</tr>
<tr>
<td></td>
<td>For options that have discrete values (such as a file or directory name), a dialog box will appear to allow you to set the value.</td>
</tr>
<tr>
<td><strong>Save</strong></td>
<td>Save the changes you made in this page of the dialog box. Changes do not take effect until you click this button.</td>
</tr>
<tr>
<td><strong>Restore</strong></td>
<td>Restore this dialog box to its initial state, or to the point where you last clicked the <strong>Save</strong> button.</td>
</tr>
</tbody>
</table>

For more information about using the options on this page, see “Setting Compilation Options” on page 5-2.
Chapter 4: Source Code Editor

The internal CodeWatch Source Code Editor displays the source code for the program that is currently executing, if available, in the Source Code/Edit window. You can also edit the source code in the Source Code/Edit window.

This chapter discusses the following topics:

- How CodeWatch locates source code files
- The contents of the Source Code/Edit window (see page 4-2)
- How to use the Source Code/Edit window to create new COBOL source files, open existing source files, view source files during execution, and perform editing operations on source files (see page 4-6)
- Using the Preferences dialog box to control the behavior of the Source Code/Edit window (see page 4-9)
- Basic editing techniques (see page 4-15)

How CodeWatch Finds Source Files During Execution

In order for CodeWatch to show the source code for a program during execution, the program must be compiled with RM/COBOL version 7.5 or later compiler, using the Full Debug Information (/Y2 or /Y3) Compile Command line option (see Chapter 6, Compiling, of the RM/COBOL User's Guide). In addition, CodeWatch must be able to find the source file. CodeWatch looks for a source file by checking the following:

- The absolute path of the source file at the time it was compiled.
- The directory that contains the program file.
- The current working directory.
- The directories listed under the Source tab on the Environment page of the Workspace Properties dialog box (see page 3-66).
The Source Code/Edit window is opened when you perform the following operations:

- You use the **File | Open** command, the **File | New** command, or double-click on a program name, program file, library, source file, or copy file in the Workspace window (see page 3-14).
- The program is animating, a breakpoint or watchpoint is triggered, or the end of a step operation is reached.

A Source Code/Edit window does not close automatically. Other than memory, there is no limit on the number of Source Code/Edit windows that may be open at one time in a CodeWatch main window.

**Note** Windows 9x-class operating systems may have difficulties if more than 100 Source Code/Edit windows are open simultaneously. If performance decreases, close some of the windows. Windows NT-class operating systems will not experience this problem.

The following sections describe the elements of the Source Code/Edit window and the commands that are available from the context-sensitive menu that pops up when you right-click a selected item in this window.

### Contents of the Source Code/Edit Window

The following illustrates a Source Code/Edit window.
From left to right, the Source Code/Edit window displays the following:

- **Gutter.** This area is shown as lightly shaded with brown or gray and contains the following:
  
  - A green dot to indicate the line contains a statement.
  - A solid red circle to indicate that a breakpoint has been set on the current line.
  - A hollow circle to indicate that a breakpoint has been set on the current line, and the breakpoint is temporarily disabled.
  - A compiler-assigned line number. The line number is visible only if a program file has been found for this source file.

- **Text Area.** This is the area where source code is displayed and edited. Compiler diagnostic lines and lines included from copy files are also displayed in this area, and are displayed in red to indicate that they cannot be changed.

  CodeWatch uses color to make your program easier to read:

  - Keywords and reserved words are displayed in black.
  - Paragraph and variable names are displayed in blue.
  - Comments are displayed in green.
  - Text that cannot be edited is displayed in red.
  - Quoted text strings are displayed in cyan.
  - Numbers are displayed in magenta.
  - During execution, the active statement is highlighted in yellow, and a suspended statement (for example, one that issued a CALL) is highlighted in blue.

Note The Source Code/Edit window is an example of a document window. For more in-depth information on how a document window works in CodeWatch, see page 3-31.
## Context Menu for the Source Code/Edit Window

When you right-click in the Source Code/Edit window, a pop-up context menu appears. The contents of the context menu will vary depending on the current context.

<table>
<thead>
<tr>
<th>Command</th>
<th>Shortcut Key</th>
<th>Toolbar</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Undo</td>
<td>Ctrl+Z or Alt+Backspace</td>
<td></td>
<td>Undoes one level of changes to the current file.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• The change to be undone may be as simple as a typed character, or as complicated as a Replace operation that affected every line in the file.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• You can issue the Undo command repeatedly to undo additional changes.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• You can undo an Undo operation with the Redo command.</td>
</tr>
<tr>
<td>Redo</td>
<td>Ctrl+Y or Ctrl+Backspace</td>
<td></td>
<td>Reverses the effect of the last Undo operation.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• This command is available only after an Undo operation.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• An Undo operation can be undone only while no additional changes have been made to the document since the Undo command was issued.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• If the Undo command has been issued repeatedly, the Redo command can also be used repeatedly to undo each level of Undo.</td>
</tr>
<tr>
<td>Cut</td>
<td>Ctrl+X or Shift+Del</td>
<td></td>
<td>Copies the current selection to the Windows Clipboard and then deletes the selection.</td>
</tr>
<tr>
<td>Copy</td>
<td>Ctrl+C or Ctrl+Ins</td>
<td></td>
<td>Copies the current selection to the Windows Clipboard.</td>
</tr>
<tr>
<td>Paste</td>
<td>Ctrl+V or Shift+Ins</td>
<td></td>
<td>Inserts the contents of the Windows Clipboard at the cursor position. If there is an active selection, the selected text is replaced with the text from the Windows Clipboard.</td>
</tr>
<tr>
<td>Select All</td>
<td>Ctrl+A</td>
<td></td>
<td>Selects all text in the current document.</td>
</tr>
<tr>
<td>Command</td>
<td>Shortcut Key</td>
<td>Toolbar</td>
<td>Action</td>
</tr>
<tr>
<td>--------------------------------</td>
<td>--------------</td>
<td>---------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Set Breakpoint (or Remove</td>
<td>F9</td>
<td>![icon]</td>
<td>Toggles the breakpoint on the current line. Note that the text of this menu changes to reflect the presence or absence of a breakpoint on the current line.</td>
</tr>
<tr>
<td>Breakpoint)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Enable Breakpoint (or Disable</td>
<td>Ctrl+F9</td>
<td>![icon]</td>
<td>Enables or disables a breakpoint at the line that contains the cursor. Note that the button appears pressed, and the menu option is checked, if the current line contains an enabled breakpoint.</td>
</tr>
<tr>
<td>Breakpoint)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>View Data Item</td>
<td>Shift+F9 or</td>
<td>![icon]</td>
<td>Displays or hides the Inspect/Modify dialog box (see page 3-42) and initializes the data item field with the contents of the selection. If there is no selection, the word under the cursor is used.</td>
</tr>
<tr>
<td>Ctrl+I</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Watch Data Item</td>
<td>Alt+F9</td>
<td>![icon]</td>
<td>Adds the current selection or the word under the cursor to the Watchpoints tab of the Data window (see page 3-23). Note that this information will also appear in the List of Data Watchpoints area on the Data Watchpoints tab of the Breakpoints &amp; Watchpoints dialog box, as described beginning on page 3-69.</td>
</tr>
</tbody>
</table>
Using the Source Code/Edit Window

You can use the Source Code/Edit window to create new COBOL source files, open existing COBOL source files, view COBOL source files during program execution, and perform editing operations.

Note The Source Code/Edit window is an example of a document window. For more in-depth information on how a document window works in CodeWatch, see page 3-31.

Creating a New Source Code Document

To create a new, blank source code document:

- If a workspace has not been opened, from the File menu, choose New | File.
- Otherwise, use the File | New command.

A blank Source Code/Edit window will appear, containing an untitled document. The document is not part of the workspace and is therefore not a COBOL source file until the file is saved for the first time. At that point, the following dialog box appears:

The file can be given any valid name—it does not need to have a .cbl extension to be treated as a COBOL source file. Instead, make sure Add to Workspace is checked and select either COBOL Source File or COBOL Copy File, as required, and click Save.

Note Only COBOL source files that are part of the workspace may be compiled from within CodeWatch.
Opening an Existing Source Code File

To open an existing source code file, do one of the following:

- Use the File | Open command. This command displays the following Open File dialog box:

  ![Open File Dialog Box]

  Select a file from the list. Check Add to Workspace if the file is a COBOL source or copy file and you would like to include the file in the workspace—in this case, be sure to also specify the kind of file you are opening.

  If a workspace is not open, the File | Open command defaults to opening a workspace. To open a source file, pull down the Files of Type combo box and choose any option except CodeWatch Workspace Files. The Add to Workspace options will be enabled. Then, choose your file and select the proper type. A default workspace will be created containing the selected file.

- Select an item in the Workspace window and select the File | Open Item command. You can open the source for the selected item (which may itself be a source file) right-clicking on the item and choosing Open Item from the menu, or by selecting the item and pressing the F2 (or open) key.
Viewing Source During Program Execution

The Source Code Editor will automatically display your source code during program execution as long as the program was compiled with the /Y2 or /Y3 option, and the source for the program is accessible. The program file, program, and attendant source and copy files are also automatically inserted into the workspace when opened in this way.

Editing Operations in the Source Code/Edit Window

You can perform the following editing operations in a Source Code/Edit window:

- Enter new text by clicking with the mouse to set the insertion point, and then typing.
- Select regions of text with the keyboard or the mouse.
- Delete a selected region of text, or copy or cut a region to the Windows Clipboard.
- Paste text from the Windows Clipboard at the insertion point.
- Right-click to display a pop-up menu.
- Undo or redo one or more operations.

Note  You can learn about basic techniques in editing beginning on page 4-15.

You can also perform the following non-editing operations in a Source Code/Edit window:

- Set a new breakpoint or clear an existing breakpoint by double-clicking in the indicator column or on the line number. You can set, clear, enable, or disable a breakpoint by right-clicking on a line and choosing the appropriate item from the pop-up context menu, or by using buttons on the toolbar.

  For a breakpoint to be effective, it must be set on a line that contains executable code. Such lines are indicated by a small green dot in the gutter. Comment lines are not executed; neither are the second or subsequent lines of statements that span more than one line.

- Examine a data item during execution. To do this, highlight the data item in the Source Code/Edit window by clicking with the mouse; then, double-click the selected item to display the Inspect/Modify dialog box (see page 3-42). If the data item requires a subscript or qualification, you can edit the name in the Inspect/Modify dialog box. The value of the data item will be updated the next time the Debugger reaches a breakpoint or watchpoint, or you can force the value to be refreshed immediately by choosing Break from the Run menu, or by pressing F5. You can
also add a watchpoint by clicking the Watch button, or modify the data item by entering a new value and clicking the Change button in this dialog box.

You can also set a watchpoint by right-clicking on a highlighted data item with the mouse and choosing Watch Data Item or by pressing Alt+F9 from the pop-up menu. Note that you cannot specify qualification or subscripts in this way, but you can edit the watchpoint later to add this information.

• Search for a text string by doing one of the following:
  – From the Edit menu, choose Find.
  – Click the Find toolbar button.
  – Press Alt+F.

You can search again by using the Edit menu and choosing the Find Next or Find Previous command (or by pressing the corresponding toolbar buttons). As an alternative, you can also use the shortcut keys. Press F3 to search forward or press Shift+F3 to search backward in the file.

Setting Preferences

The behavior of the Source Code Editor can be customized by using the Preferences dialog box. This dialog box contains two tabbed pages: Tabs and External Editing.

To display the Preferences dialog box:

• From the View menu, choose Preferences or press Alt+0.

Tabs Page

The Tabs page, illustrated below, allows you to specify the way CodeWatch expands tab characters when displaying a file in the Source Code/Edit window and determines how the CodeWatch Source Code Editor behaves when the Tab key is pressed on the keyboard in Insert mode.
Use this option

Tab Character Expansion

Select how CodeWatch expands tab characters when displaying a file in the Source Code/Edit window.

- **Every 8 Columns.** Selecting this option indicates that a tab character causes the cursor to advance by 1 to 8 spaces so the next character is displayed on an 8-character boundary. This is the standard interpretation of tabs by DOS and by many UNIX systems and is the default setting.

- **Every 4 Columns.** Selecting this option indicates that a tab character causes the cursor to advance by 1 to 4 spaces so the next character is displayed on a 4-character boundary.

- **Compiler Default.** Selecting this option indicates that a tab character will be processed as they are processed by the RM/COBOL compiler. A tab in columns 1-7 advances the cursor to column 8 (the first column in area A), and subsequent tab characters advance the cursor to the next 4-character boundary.

Notes

- The Tab Character Expansion setting applies to all Source Code/Edit windows.

- CodeWatch does not insert tab characters; this setting controls how existing tab characters in files are interpreted. If you edit a line, CodeWatch will replace tabs with spaces.

- When compiling in CodeWatch, the compiler expands tabs the same way that CodeWatch expands tabs. This behavior can be overridden by specifying a compiler configuration file on the Build Options property page (see page 5-2); however, overriding tab settings in this way is not recommended.
<table>
<thead>
<tr>
<th>Use this option</th>
<th>To</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tab Key Action</td>
<td>Determine how the CodeWatch Source Code Editor behaves when the Tab key is pressed on the keyboard in Insert mode.</td>
</tr>
<tr>
<td></td>
<td>• <strong>COBOL Tab Stops.</strong> Selecting this option indicates that the cursor is advanced to the next COBOL tab position. If the cursor is in columns 1-7, the cursor is advanced to column 8 (area A). Otherwise, the cursor is advanced to the next 4-character boundary. This is desirable behavior when coding COBOL and is the default setting.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Matches the setting above.</strong> Selecting this option indicates that the cursor is advanced either to the next 8-character, 4-character, or COBOL tab boundary, as specified by the settings in the Tab Character Expansion area.</td>
</tr>
<tr>
<td>Notes</td>
<td>• The Tab Key Action setting applies to all Source Code/Edit windows.</td>
</tr>
<tr>
<td></td>
<td>• CodeWatch does not insert tab characters. This setting controls how the cursor moves, and how many spaces are inserted when the Tab key is pressed.</td>
</tr>
<tr>
<td>OK</td>
<td>Apply any changes made above and close this dialog box.</td>
</tr>
<tr>
<td>Cancel</td>
<td>Close this dialog box without saving changes.</td>
</tr>
<tr>
<td>Apply</td>
<td>Apply changes without closing the page. Changes made with the Apply button cannot be canceled by clicking the Cancel button.</td>
</tr>
</tbody>
</table>
**External Editing Page**

The External Editing page, illustrated below, allows you to configure the environment to be used by an external editor.

<table>
<thead>
<tr>
<th>Use this option</th>
<th>To</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pathname of Program</td>
<td>Specify the full pathname of the external editor program to invoke. This should be the complete pathname of the executable file, but can also be the name of a DOS <code>.bat</code> file, if you are invoking a DOS-based external editor. Click the ellipsis button to display a Select Editor Program File dialog box in order to search for a program.</td>
</tr>
<tr>
<td>Command Line Parameters (Cont.)</td>
<td>Specify the command line to be passed to the external editor. The contents of this field will depend on your chosen editor. Various substitution symbols are available to pass the current context (file, cursor line, and position) to the external editor. Press the arrow button to display a submenu of substitution symbols. Available symbols include the following:</td>
</tr>
<tr>
<td>• <code>$(SFP)</code> The pathname of the current source file.</td>
<td></td>
</tr>
<tr>
<td>• <code>$(SFN)</code> The current source filename and extension.</td>
<td></td>
</tr>
<tr>
<td>• <code>$(SFD)</code> The directory that contains the current source file.</td>
<td></td>
</tr>
<tr>
<td>• <code>$(SFE)</code> The extension of the current source file, including the period.</td>
<td></td>
</tr>
<tr>
<td>• <code>$(CL0)</code> The line number containing the cursor, where 0 is the first line.</td>
<td></td>
</tr>
<tr>
<td>• <code>$(CC0)</code> The column number containing the cursor, where 0 is the left-most column.</td>
<td></td>
</tr>
</tbody>
</table>
### Use this option

<table>
<thead>
<tr>
<th><strong>Command Line Parameters (Cont.)</strong></th>
<th><strong>To</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>• $(CL1)</td>
<td>The line number containing the cursor, where 1 is the first line.</td>
</tr>
<tr>
<td>• $(CC1)</td>
<td>The column number containing the cursor, where 1 is the left-most column.</td>
</tr>
<tr>
<td>• $(CWD)</td>
<td>The current working directory.</td>
</tr>
<tr>
<td>• $$</td>
<td>A single “$$” symbol.</td>
</tr>
</tbody>
</table>

### Working Directory

Specify the working directory that is set for the eternal editor. Leave this field blank to use the directory where CodeWatch is running. Press the arrow button to display a submenu of substitution symbols. Available symbols include the following:

- • $(CWD) The current working directory. This is the default.
- • $(EWD) The current “execution” directory, as specified in the Workspace Properties dialog box (see page 3-61) when you choose Workspace | Properties command from the File menu.
- • $$ A single “$$” symbol.

### Autosave File

Determine how CodeWatch behaves when you invoke an external editor on a file that you have changed, but not saved. If this option is selected, the file is automatically saved. When this option is not selected, the file is not automatically saved, and CodeWatch will present the following prompt in a message box:

```
This file has been edited but
Has not been saved. Save it now?
```

Choose Yes to save the file and start the external editor. Choose No to start the external editor without saving your changes. Choose Cancel to return to CodeWatch without invoking the external editor.
**Use this option** | **To**
---|---
**Autoreload File** | Determine how CodeWatch behaves when you return to CodeWatch from another application. This applies if you are returning from an external editor, or from any other program. If this option is selected, CodeWatch will automatically reload any file open in the external editor that has been changed outside CodeWatch, but only if there are no unsaved changes.

If this option is not selected, and you return to CodeWatch after making changes to a file outside CodeWatch, you will see the following message box:

The file "filename.cbl" was modified outside CodeWatch. Would you like to reload this file?

Choose Yes to reload the file, and choose No to keep working without reloading the file.

If this option is selected, and you return to CodeWatch after making changes to a file outside CodeWatch and you have not changed the file within CodeWatch, the changes will automatically be loaded into the CodeWatch Source Code Editor. If, however, you have made changes in CodeWatch, you must choose which set of changes to keep. The following message box will appear:

The file "filename.cbl" was modified outside CodeWatch, and there are also unsaved changes in the CodeWatch editor. Would you like to reload this file and lose any changes you made since the last time this file was saved?

Choose Yes to reload the file and discard your changes. Choose No to continue working in CodeWatch.

**Note** In either of the above cases, you can choose No, and then use the Save Copy As command from the File menu to save a copy of the version of the file in the CodeWatch Source Code Editor. You can then close and reopen the file to load the new version.

**OK** | Apply any changes made above and close this dialog box.

**Cancel** | Close this dialog box without saving changes.

**Apply** | Apply changes without closing the page. Changes made with the Apply button cannot be canceled by clicking the Cancel button.
Basic Editing Techniques

This section provides an overview of the most common and basic editing tasks in CodeWatch, including the following:

- Moving around in a file
- Selecting text (see page 4-18)
- Inserting or entering text (see page 4-21)
- Overwriting or replacing text (see page 4-22)
- Deleting text (see page 4-22)
- Correcting or editing text (see page 4-23)
- Cutting, copying, and pasting text (see page 4-25)
- Using the Windows Clipboard to duplicate or move text (see page 4-26)

You may also find it helpful to refer back to the mouse and keyboard techniques that begin on page 4-16.

Moving Around in a File

To move around and control the part of the file that is visible in a Source Code/Edit window, you can use the mouse or the keyboard. Both techniques are discussed in this section, starting with the mouse-based choices. First, however, let's review the insertion point (also known as the cursor or caret). You use the insertion point to specify the location you want to edit in the file.

Insertion Point

The insertion point indicates your current position in the file. The insertion point on the status bar in CodeWatch is referred to as the “Edit point.”

The visual appearance of the insertion point corresponds to the type of text-entry mode: Insert mode, Overtype mode, and Selection mode. You are in Selection mode when you select one or more characters by dragging the mouse or using the keyboard. In all other cases, you are in Insert or Overtype mode. The Ins (Insert) key toggles between Insert mode and Overtype mode. An indicator on the status bar is blank when you are in Insert mode, and indicates OVR when you are in Overtype mode.
For more details on the appearance of the insertion point and these three text-entry mode options, see pages 4-18 through 4-22.

You can move the insertion point anywhere within the text of a line on the screen by positioning the I-beam mouse pointer to the desired location and clicking the left mouse button. You can also move the insertion point using the direction keys (see Table 4-1 on page 4-17) on the keyboard.

**Note** There is one essential difference between using the direction keys on the keyboard to move or page through a file and using the mouse to move or scroll through a file. When you use the keyboard, the insertion point will travel with you as you move through the file. When you use the mouse, however, the insertion point does not change location and remains where it was before you moved. For example, if you use the mouse to view another part of your file and then start entering text, CodeWatch returns you to your starting place and anything you have typed is entered at the original insertion point location.

**How to Move with the Mouse**

The primary mouse-based navigation tools are the horizontal and vertical scroll bars, and the mouse wheel (if your mouse is so equipped). The boxes within the scroll bars are called scroll boxes, and the arrows at either end of each scroll bar are called scroll arrows.

**Note** To move the insertion point to a position in the file that is not currently visible, use the scroll bars to make the position visible, then position the I-beam mouse pointer and click the mouse button.

**Using the Vertical Scroll Bar**

To move through your file one line at a time, click on the scroll arrow at the top or bottom of the vertical scroll bar. Click the bottom arrow to scroll down—or forward—through a file and the top arrow to scroll up—or backward. To move through a file one full screen at a time, click anywhere within the scroll bar—above the scroll box to scroll up, or below the box to scroll down. You can also quickly and continuously scroll forward and backward through a file by clicking and holding down the mouse button over the scroll arrow.

To move long distances through a file, you can drag the scroll box to the appropriate position in the scroll bar. The scroll box position on the vertical scroll bar represents your relative position in the document.
Using the Horizontal Scroll Bar

If you are working with a file that is too wide to fit on the screen, you can use the scroll arrows at either end of the horizontal scroll bar to move right and left. Horizontal scrolling is much like vertical scrolling. Use the scroll arrows to move short distances, click on either side of the scroll box to move by a full screen, or drag the scroll box to reposition the window manually.

How to Move with the Keyboard

With the keyboard commands, you can move short distances with the arrow keys, move by words or paragraphs, move by one screen at a time, and move to the beginning or end of a file. Table 4-1 summarizes the keystrokes used to move the insertion point in a file.

Note Pressing an arrow key moves the insertion point one character or one line in the direction of the arrow. If the insertion point is already at that edge of the window, the window scrolls to keep the insertion point visible.

Table 4-1: Direction Keys

<table>
<thead>
<tr>
<th>To move the insertion point (or cursor)</th>
<th>Press</th>
</tr>
</thead>
<tbody>
<tr>
<td>Left one character.</td>
<td>Left Arrow</td>
</tr>
<tr>
<td>Right one character.</td>
<td>Right Arrow</td>
</tr>
<tr>
<td>Left one word.</td>
<td>Ctrl+Left Arrow</td>
</tr>
<tr>
<td>Right one word.</td>
<td>Ctrl+Right Arrow</td>
</tr>
<tr>
<td>To the first non-blank character of the current line, or the beginning of the current line.</td>
<td>Home</td>
</tr>
<tr>
<td>To the end of the current line (to the first trailing blank).</td>
<td>End</td>
</tr>
<tr>
<td>Up one line.</td>
<td>Up Arrow</td>
</tr>
<tr>
<td>Down one line.</td>
<td>Down Arrow</td>
</tr>
<tr>
<td>To the first line of the screen.</td>
<td>Ctrl+Page Up</td>
</tr>
<tr>
<td>To the last line of the screen.</td>
<td>Ctrl+Page Down</td>
</tr>
<tr>
<td>Up one screen.</td>
<td>Page Up</td>
</tr>
<tr>
<td>Down one screen.</td>
<td>Page Down</td>
</tr>
<tr>
<td>To the beginning of the file.</td>
<td>Ctrl+Home</td>
</tr>
<tr>
<td>To the end of the file.</td>
<td>Ctrl+End</td>
</tr>
</tbody>
</table>
Table 4-1: Direction Keys (Cont.)

<table>
<thead>
<tr>
<th>To move the insertion point (or cursor)</th>
<th>Press</th>
</tr>
</thead>
<tbody>
<tr>
<td>To one tab stop to the right.</td>
<td>Tab</td>
</tr>
<tr>
<td>To one tab stop to the left.</td>
<td>Shift+Tab (or Back Tab)</td>
</tr>
<tr>
<td>To the next item matching the last search item.</td>
<td>F3</td>
</tr>
<tr>
<td>To the previous item matching the list search item.</td>
<td>Shift+F3</td>
</tr>
<tr>
<td>To the next word that matches the word under the cursor.</td>
<td>Ctrl+F3</td>
</tr>
<tr>
<td>To the previous word that matches the word under the cursor.</td>
<td>Ctrl+Shift+F3</td>
</tr>
<tr>
<td>Into the next pane if this window is split.</td>
<td>Ctrl+F6</td>
</tr>
<tr>
<td>Into the previous pane if this window is split.</td>
<td>Ctrl+Shift+F6</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>To move the window over the document</th>
<th>Press</th>
</tr>
</thead>
<tbody>
<tr>
<td>Scroll the window up one line.</td>
<td>Ctrl+Down Arrow</td>
</tr>
<tr>
<td>Scroll the window down one line.</td>
<td>Ctrl+Up Arrow</td>
</tr>
</tbody>
</table>

Selecting Text

Before you can edit a given portion of text, you first have to select it. When you select text, the CodeWatch Source Code Editor enters Selection mode, and the insertion point is displayed highlighting the selected text in reverse video (white text and graphics on a black background rather than the normal black on white).

**Note** Throughout this user’s guide, this reverse video effect is referred to as selected text or highlighted text.

You can select one or more characters of text in order to edit the entire selection as a single unit. To cancel a selection (and return to Insert or Overtype mode, described on page 4-22), position the I-beam mouse pointer outside the selected text and click the mouse button, or use any of the direction keys described previously in Table 4-1.

You can select text in many ways using the mouse or the keyboard. Each approach offers its own advantages.
How to Select Text with the Mouse

The following sections describe ways to select text using the mouse. To cancel a selection using the mouse, click anywhere outside the selection in the window, or press the Esc key.

Selecting a Word

To select an entire word, hold down the Ctrl key, and single-click in the word. The entire word will be highlighted. Pressing Shift+Ctrl+W has the same effect.

Double-clicking also selects a word. In addition, if the program is running, the Inspect/Modify dialog box (see page 3-42) is displayed and the word is displayed as if it were an identifier.

Selecting Entire Lines

To select a single line, click in the gutter to the left of the line of text. The entire line will be highlighted. Dragging the mouse in the gutter selects multiple lines.

To select multiple lines, position the I-beam mouse pointer and drag the insertion point so that text from at least two lines is selected.

Selecting the Entire Document

To select the entire document, hold down the Ctrl key and click in the gutter, choose Select All from the Edit menu, or press Ctrl+A anywhere in the file.

Selecting Multiple Characters or Lines

To select one or more characters, position the I-beam mouse pointer and drag over the desired text. Begin by positioning the I-beam mouse pointer just to the left of the text you wish to select. Press and hold down the left mouse button, and without releasing the button, drag to the right until you have highlighted the desired text. Release the mouse button. The characters will remain highlighted. You can use dragging to select any size block of text, from a single character to an entire file.

Similarly, dragging in the gutter will select more than one entire line.
**Block Selection**

To select a rectangular block of text, hold down the Alt key, and click in one corner of the selection. While holding down the mouse key, drag the mouse to the opposite corner (it need not be in the window—the Source Code/Edit window will scroll if necessary). All text in the rectangle will be selected.

**Extending a Selection**

To extend a selection, hold down the Shift key while dragging with the mouse.

- To select all text between the cursor and another location on the screen, hold down the Shift key and click with the mouse. All text between the cursor position and the point where the mouse was clicked will be selected.

- If text is selected, you can reshape the selection by holding down the Shift key and clicking with the mouse. All text between the origin of the selection and the location where you clicked will be selected.

**How to Select Text with the Keyboard**

CodeWatch provides techniques for selecting text with the keyboard, as listed in Table 4-2. You can hold down combinations of the Shift and Ctrl keys to turn the direction keys, described in Table 4-1 on page 4-17, into selection keys. Place the insertion point where you want to begin your selection, and then press and hold down Shift and/or Ctrl while using any of the keys listed. You will simultaneously move the insertion point and highlight the text.
Table 4-2: Text Selection Keys

<table>
<thead>
<tr>
<th>To extend the selection</th>
<th>Press</th>
</tr>
</thead>
<tbody>
<tr>
<td>One character at a time to the left or right.</td>
<td>Shift+Left Arrow or Shift+Right Arrow</td>
</tr>
<tr>
<td>One line of text up or down.</td>
<td>Shift+Up Arrow or Shift+Down Arrow</td>
</tr>
<tr>
<td>Left one word.</td>
<td>Ctrl+Shift+Left Arrow</td>
</tr>
<tr>
<td>Right one word.</td>
<td>Ctrl+Shift+Right Arrow</td>
</tr>
<tr>
<td>To the first nonblank character on the current line.</td>
<td>Shift+Home</td>
</tr>
<tr>
<td>To the beginning of the current line.</td>
<td>Shift+Home again</td>
</tr>
<tr>
<td>To the end of the current line (to the first trailing blank).</td>
<td>Shift+End</td>
</tr>
<tr>
<td>Text to the beginning of the file.</td>
<td>Ctrl+Shift+Home</td>
</tr>
<tr>
<td>Text to the end of the file.</td>
<td>Ctrl+Shift+End</td>
</tr>
<tr>
<td>Up one screen.</td>
<td>Shift+Page Up</td>
</tr>
<tr>
<td>Down one screen.</td>
<td>Shift+Page Down</td>
</tr>
<tr>
<td>To the entire file</td>
<td>Ctrl+A</td>
</tr>
</tbody>
</table>

Inserting New Text

Inserting text is as easy as typing, but you first must be in Insert mode. In Insert mode, the insertion point appears on the screen as a blinking vertical line. The Ins (Insert) key is used to switch between Insert mode and Overtype mode (described in the following section).

As you enter new characters in Insert mode, they are inserted to the left of the insertion point and the insertion point and all text following the insertion point move to the right. If necessary, the Source Code/Edit window scrolls to keep the insertion point visible.
Overwriting Text

In Overtype mode, the insertion point appears as blinking reverse video block cursor. As you type, CodeWatch overwrites the character highlighted by the cursor. If necessary, the Source Code/Edit window scrolls to keep the insertion point visible.

Overwriting Selected Text

You can overwrite any selected text whether you are in Insert or Overtype mode. As described on page 4-20, when you select one or more characters with the mouse or keyboard, you enter Selection mode. In Selection mode, the selected text appears on the screen in reverse video. The first character you type replaces all the selected text immediately, returns to the mode that was active before you selected the text, and moves the insertion point one character to the right. If necessary, the Source Code/Edit window scrolls to keep the insertion point visible.

Deleting Text

The easiest way to delete a character is to place the insertion point to the right of the character and press Backspace. CodeWatch will delete one character to the left of the insertion point, pulling characters at the right of the insertion point one space to the left. If you prefer, you can place the insertion point to the left of the character you want to delete and press Del. In this case, CodeWatch will delete the character to the immediate right and move all following characters to the left.

To delete several characters at once, you can select (or highlight) them and then press either Backspace or Del (Delete). CodeWatch will delete the selection and fill in the gap by pulling the remaining text in the Source Code/Edit window up and to the left. You can also delete text with the Cut command from the Edit menu. See “Cutting, Copying, and Pasting Text” on page 4-25.

Keyboard shortcuts are also available for deleting text. For example, instead of pressing Backspace to delete characters one at a time, you can press Ctrl+Del to delete the word containing the cursor. Table 4-3 describes these editing shortcut keys.
Correcting and Editing Text

As described in the previous sections, by entering the appropriate mode, you can insert new text, replace old text, or replace selected text. You can insert the typed character(s) at the insertion point (in Insert mode), replace the character(s) at the insertion point (in Overtype mode), or replace the current selection (in Selection mode).

The CodeWatch Editor also provides several editing keys to aid in correcting text, as shown in Table 4-3.

Table 4-3: Editing Keys

<table>
<thead>
<tr>
<th>To</th>
<th>In This Mode</th>
<th>Press</th>
</tr>
</thead>
<tbody>
<tr>
<td>Change the selected text to uppercase.</td>
<td>Selection</td>
<td>Ctrl+U</td>
</tr>
<tr>
<td>Change the selected text to lowercase.</td>
<td>Selection</td>
<td>Ctrl+Shift+U</td>
</tr>
<tr>
<td>Delete the selected text.</td>
<td>Selection</td>
<td>Backspace</td>
</tr>
<tr>
<td>Delete the character preceding the insertion point.</td>
<td>Selection Insert, Overtype</td>
<td></td>
</tr>
<tr>
<td><strong>Note</strong> If the insertion point is at the beginning of a line, this action joins the current line to the end of the previous line.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Delete the selected text.</td>
<td>Selection</td>
<td>Del (Delete)</td>
</tr>
<tr>
<td>Delete the character following the insertion point.</td>
<td>Insert Overtype</td>
<td></td>
</tr>
<tr>
<td>Delete the highlighted character.</td>
<td>Selection</td>
<td></td>
</tr>
<tr>
<td>Replace the selected lines with a blank line if one or more lines are selected. If only part of a single line is selected, delete the selected characters and split the line at the insertion point.</td>
<td>Selection, Insert</td>
<td>Enter</td>
</tr>
<tr>
<td>Delete the selected text and move to the first non-blank character on the next line.</td>
<td>Selection</td>
<td></td>
</tr>
<tr>
<td>Split the line at the insertion point.</td>
<td>Insert</td>
<td></td>
</tr>
<tr>
<td>Move to the first non-blank character on the next line.</td>
<td>Overtype</td>
<td></td>
</tr>
<tr>
<td>Delete all text on the current line.</td>
<td>All</td>
<td>Ctrl+Backspace</td>
</tr>
<tr>
<td>Delete all text from insertion point to the end of the line.</td>
<td>All</td>
<td>Ctrl+Del</td>
</tr>
<tr>
<td>Delete the current line.</td>
<td>All</td>
<td>Ctrl+L</td>
</tr>
</tbody>
</table>
### Table 4-3: Editing Keys (Cont.)

<table>
<thead>
<tr>
<th>To</th>
<th>In This Mode</th>
<th>Press</th>
</tr>
</thead>
<tbody>
<tr>
<td>If the insertion point is within a word, delete from the beginning of the word to the beginning of the next word. If the insertion point is not within a word, delete from the insertion point to the beginning of the next word.</td>
<td>All</td>
<td>Ctrl+Del</td>
</tr>
<tr>
<td>Shift the text from the insertion point to the end of the line right to the next tab stop by inserting blanks in the vacated positions.</td>
<td>All</td>
<td>Tab</td>
</tr>
<tr>
<td><strong>Note</strong> If the selection encompasses more than one line, all lines in the selection are shifted. This is a convenient way of indenting a block of code.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Shift the text from the insertion point to the end of the line left to the previous tab stop, provided there are no non-blank characters between the insertion point and the previous tab stop.</td>
<td>All</td>
<td>Shift+Tab</td>
</tr>
<tr>
<td><strong>Note</strong> If the selection encompasses more than one line, all lines in the selection are shifted. This is a convenient way of unindenting a block of code.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Split the current line at the insertion point.</td>
<td>Insert</td>
<td>Enter</td>
</tr>
<tr>
<td><strong>Note</strong> If the insertion point is at the beginning of a line, this action inserts a blank line before the current line. If the insertion point is after the last non-blank character, this action inserts a blank line after the current line.</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Cutting, Copying, and Pasting Text

You can also delete text with the Edit | Cut command. Unlike the previously discussed deletion techniques, this method stores the deleted text in the Windows Clipboard, which is a temporary holding area for data that is shared across all Windows programs. You can then paste the Clipboard's contents anywhere in your file, into another file, or even into another program.

In general, you copy or move text by selecting the text and then choosing the location where you want to insert, or paste, it. For more information, see the “Using the Windows Clipboard to Duplicate or Move Text” section on page 4-26.

Instead of typing a given block of text when you need a copy, you can use the Edit | Copy command to copy the text to the Clipboard, followed by the Edit | Paste command to paste the text in one or more locations in your file. A copy of the text will be inserted just to the left of the insertion point, leaving the insertion point at the end of the pasted block. With the Paste command, if you are in Selection mode, the pasted text replaces the selected text; if you are not in Selection mode, the text is inserted. The contents of the Clipboard remain unchanged.

You can also use keyboard shortcuts for cutting, copying, and pasting text. The keys or key combinations appear to the right of the appropriate commands. Table 4-4 summarizes the keyboard shortcuts for the Edit menu.

Table 4-4: Edit Menu Shortcut Keys

<table>
<thead>
<tr>
<th>To select the</th>
<th>Press</th>
</tr>
</thead>
<tbody>
<tr>
<td>Undo command</td>
<td>Ctrl+Z or Alt+Backspace</td>
</tr>
<tr>
<td>Redo command</td>
<td>Ctrl+Y or Shift+Alt+Backspace</td>
</tr>
<tr>
<td>Cut command</td>
<td>Ctrl+X or Shift+Del</td>
</tr>
<tr>
<td>Copy command</td>
<td>Ctrl+C or Ctrl+Ins</td>
</tr>
<tr>
<td>Paste command</td>
<td>Ctrl+V or Shift+Ins</td>
</tr>
<tr>
<td>Clear command</td>
<td>Del</td>
</tr>
<tr>
<td>Delete the line containing the cursor</td>
<td>Ctrl+L</td>
</tr>
<tr>
<td>Cut the line containing the cursor</td>
<td>Ctrl+Shift+L</td>
</tr>
</tbody>
</table>
Using the Windows Clipboard to Duplicate or Move Text

The Windows Clipboard is a temporary holding area used to transfer text either within a file, between files, or between applications. You use the Cut, Copy, and Paste commands from the Edit menu to move or duplicate information.

First, select text in the source file and then do one of the following:

- Choose Edit | Cut or press Ctrl+X or Shift+Del to move the selected text to the Clipboard. This action removes the selection from the file.

- Choose Edit | Copy or press Ctrl+C or Ctrl+Ins to copy the selected text to the Clipboard. This action leaves the original text in the file.

Next, position the insertion point in the destination (or target) file and do the following:

- Choose Edit | Paste or press Ctrl+V or Shift+Ins to insert the selected text. You can do this any number of times.

Only one Clipboard is available to all Windows programs, so any cut or copy operation in any program will replace the contents of the Clipboard.
Chapter 5: Building Programs with CodeWatch

This chapter provides an overview of how CodeWatch compiles source files.

### Compiling

There are several ways to compile a file under CodeWatch.

<table>
<thead>
<tr>
<th>To Compile</th>
<th>Choose</th>
<th>Or click</th>
</tr>
</thead>
<tbody>
<tr>
<td>The file that is currently being edited. Note that any changes must be saved to disk before the file is being compiled.</td>
<td>Compile File on the Build menu or press Ctrl+F7.</td>
<td>![Compile File] (Compile File)</td>
</tr>
<tr>
<td>All files that have changed since the last compilation, or that have out-of-date object files. The source files that will be compiled are indicated by a checkmark on the Files tab in the Workspace window (for further information, see page 3-15).</td>
<td>Compile Changes on the Build menu or press F7.</td>
<td>![Compile Changes] (Compile Changes)</td>
</tr>
<tr>
<td>All source files in the workspace.</td>
<td>Compile All on the Build menu or press Ctrl+Shift+F7.</td>
<td>![Compile All] (Compile All)</td>
</tr>
</tbody>
</table>
Compiling Only Changed Files

The **Compile Changes** command on the **Build** menu (see page 3-55) recompiles source files that are determined to require recompilation. Source files are deemed to require recompilation if any of the following conditions are true:

- The source file has never been compiled, that is, there is no object file for the source file.
- The source file has been edited since the last compilation. This is determined by comparing the date of the source file to that of the object file. If the source file is newer than the object file, recompilation is required.
- A copy file used by the source file has been edited since the last compilation. This is determined by comparing the date of the copy file to that of the object file. If the copy file is newer than the object file, recompilation is required.
- An RM/COBOL compilation option has been changed in the workspace that affects the generated program. This includes any of these Compile Command Options: /D, /G, /H, /N, /O, /Q, /S, /U, /V, /Y, /Z, /2 and /7.

Setting Compilation Options

The **Build Options** property page of the Item Properties dialog box (see page 3-73), illustrated below, allows you to view and change the compilation options for a particular file or the workspace.

To display the Build Options property page, make sure the cursor is in the Source Code/Edit window and do one of the following:

- From the **Build** menu, click **Options**.
- Click the **Options** toolbar button.
- Press **Alt+F7**.
- From the **File** menu, choose **Item Properties**, and then click the **Build Options** tab.

By default, the **Build Options** property page is displayed. (See page 3-76 for a description of the options on this page.)
Note that CodeWatch will recommend that a file be recompiled under the following circumstances:

- The setting in the File column is not blank and does not match the setting in the Last Build column.
- The setting in the File column is blank (that is, not specified), the setting in the All column is not blank, and that setting does not match the setting in the Last Build column.

In other words, the File setting has the highest priority, and the All setting has the second highest priority.

Table 5-1 lists the RM/COBOL Compile Command Options that can be set in the Build Options property page of the Item Properties dialog box. Note the following:

- A check (✓) in the Dep? (Dependent) column indicates that a change to this option will mark the source file for recompilation.
- The Default Value column indicates the value that will be used if this option is not specified.
- Italics (for example, Numeric Value) indicate that you will be prompted to enter this value.
- If you select conflicting options (for example, both B=Yes and V=Yes or 2=Yes and 7=No), CodeWatch will issue a warning and require that the error be corrected.
Table 5-1: RM/COBOL Compile Command Options Available

<table>
<thead>
<tr>
<th>Option Description</th>
<th>Dep?</th>
<th>Default Value</th>
<th>Other Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>A: Produce Allocation Map</td>
<td>No</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>B: Binary Sequential Files</td>
<td>✓</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>C: Suppress Copy File Display</td>
<td>No</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>D: Compile WITH DEBUG MODE</td>
<td>✓</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>E: Errors Only Disk Listing</td>
<td>No</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>F: Flag COM1</td>
<td>No</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>F: Flag COM2</td>
<td>No</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>F: Flag EXTENSION</td>
<td>No</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>F: Flag HIGH</td>
<td>No</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>F: Flag INTERMEDIATE</td>
<td>No</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>F: Flag OBSOLETE</td>
<td>No</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>F: Flag SEG1</td>
<td>No</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>F: Flag SEG2</td>
<td>No</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>G: Configuration Override File</td>
<td>✓</td>
<td>None</td>
<td>Filename</td>
</tr>
<tr>
<td>H: Configuration Supplement File</td>
<td>✓</td>
<td>None</td>
<td>Filename</td>
</tr>
<tr>
<td>L: Produce Disk Listing</td>
<td>No</td>
<td>Yes</td>
<td>Directory</td>
</tr>
<tr>
<td>M: Automatic Input Conversion</td>
<td>✓</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>N: Suppress Object Generation</td>
<td>✓</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>O: Object Directory</td>
<td>✓</td>
<td>Default</td>
<td>Directory</td>
</tr>
<tr>
<td>P: Print Compilation Listing</td>
<td>No</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>Option Description</td>
<td>Dep?</td>
<td>Default Value</td>
<td>Other Values</td>
</tr>
<tr>
<td>------------------------------------</td>
<td>------</td>
<td>---------------</td>
<td>--------------</td>
</tr>
<tr>
<td>Q: Suppress Debugging Information</td>
<td>✓</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>R: Output Sequence Numbers</td>
<td></td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>S: Assume Separate Sign</td>
<td>✓</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>U: COMP Usage</td>
<td>✓</td>
<td>Default</td>
<td>Binary</td>
</tr>
<tr>
<td>V: Line Sequential Files</td>
<td>✓</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>W: Compiler Working Memory Size</td>
<td></td>
<td>Default</td>
<td>Numeric Value</td>
</tr>
<tr>
<td>X: Generate Cross-Reference</td>
<td></td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Y: Symbol Info in Object File</td>
<td>✓</td>
<td>No</td>
<td>Yes(3)</td>
</tr>
<tr>
<td>Z: Object Version Number</td>
<td>✓</td>
<td>Latest</td>
<td>v 7</td>
</tr>
<tr>
<td>2: Compile as RM/COBOL 2.7</td>
<td>✓</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>7: Use COBOL-74 Semantics</td>
<td>✓</td>
<td>No</td>
<td>Yes</td>
</tr>
</tbody>
</table>

Note: For more information on the RM/COBOL compilation options, see Chapter 6, *Compiling*, of the *RM/COBOL User’s Guide*. 
The RMPATH and Environment Variables

The compiler uses the contents of the RMPATH environment variable to locate copy files. The content of this path variable is saved in the workspace, and can be set from the Environment tab of the Workspace Properties dialog box.

To set the RMPATH environment variable:

1. From the File menu, choose Workspace | Properties.
2. Click the Environment tab, and then click the Source tab.
3. Add the names of the directories that contain your copy files to the list. To add an item to the list, click in the list box and begin typing.

To rearrange the order of the directories, you can drag entries with the mouse, or use the Move Up and Move Down buttons.

Compilation under CodeWatch is also affected by the contents of the Environment tab. Synonyms may be assigned using this tab, and any of the environment variables described in Chapter 2, Installation and System Considerations for UNIX, and Chapter 3, Installation and System Considerations for Windows, of the RM/COBOL User’s Guide, may be set in this way.
**Locating the Compiler**

The RM/COBOL compiler is located by Windows and does not need to be in the DOS search path. If, for some reason, CodeWatch cannot find the compiler, you will see a message error box like the following:

![Error Box](image)

To resolve this problem, reinstall the RM/COBOL compiler. You can also try to reregister the server:

- Open a DOS session.
- Change into the directory where you installed the compiler.
- Issue this command: `rmcobol /regserver`

Then, retry the compilation. There is no need to restart CodeWatch.

For more information about registering the compiler and runtime executables, see Chapter 3, *Installation and System Considerations for Microsoft Windows*, of the *RM/COBOL User’s Guide*. 
**Compiler Output**

When one of the **Build** commands is given, CodeWatch takes the following actions:

- The Log window is cleared.
- The Build Results tab in the Data window is cleared.
- You are asked to save any files that are about to be compiled and are being edited, and that have been changed since they were last saved or opened.
- Each file in the list of files that are awaiting compilation is compiled, using the options that are currently set for that file and for the workspace.
  - The output of the compiler is sent to the Log window.
  - As each file is compiled, the results are also logged into the Build Results tab of the Data window.
- If a file is open in the editor, the file is reloaded and merged with listing information from the program file.
- Files with errors or warnings are highlighted in the Build Results tab of the Data window.
Appendix A: Miscellaneous Configuration Options

CodeWatch includes several configuration options and tuning parameters that are not set from within the program. Instead, these options are read from a file called rmcw.ini. This file is created in the Windows directory when CodeWatch is run for the first time.

The rmcw.ini file can be edited with any text editor, including the CodeWatch Source Code Editor. To edit this file in CodeWatch, choose Open from the File menu and select c:\windows\rmcw.ini. (Note that the location may vary depending on your version of Windows and your installation.)

**WARNING** The rmcw.ini file contains other keys not described below that are for internal use only. These keys and values should be altered only under the guidance of Liant technical support services.

Runtime Options

Setting the RM/COBOL Runtime Registry Key

The RM/COBOL runtime system uses the following registry key to read configuration information out of the Windows registry. This option needs to be set only if you have renamed your runcobol.exe program. In that case, the specified key should be the same as the name of the runtime, without a directory or the .exe extension.

```
[Defaults]
RuntimeRegistryKey=key
```

This value is read whenever the RM/COBOL runtime is started from within CodeWatch. If not specified, runcobol is used as the key.
Setting the RM/COBOL Runtime Configuration .exe File

When CodeWatch is running, a configuration file is normally specified by using the /C and /X Runtime Command Options. However, an RM/COBOL configuration file also can be attached to `runcobol.exe` by using the Attach Configuration utility (`rmattach`) program (see Appendix G, Utilities, of the RM/COBOL User’s Guide). When `runcobol.exe` is started outside CodeWatch, the attached configuration file is used to modify the behavior of the RM/COBOL runtime.

CodeWatch, however, runs programs without using `runcobol.exe`. It is possible to specify the location of an `runcobol.exe` that has an attached configuration file to emulate the behavior of the standalone runtime.

```
[Defaults]
RuntimeConfigurationEXE=program-file
```

If such a configuration .exe file is specified, the name of the file is also used as the default registry key unless the RuntimeRegistryKey option is specified (see page A-1). The directory containing the .exe file is used to locate the runtime license vault unless the RuntimeLicensePathname option is specified (see the following topic, “Selecting a Runtime License Vault”).

Selecting a Runtime License Vault

Because you may have more than one licensed runtime system installed, there may be times when you need to specify that CodeWatch use a particular license vault.

```
[Defaults]
RuntimeLicensePathname=directory
```

The RuntimeLicensePathname option allows you to specify a directory that contains a license.vlt file. That license vault will be used for all subsequent debugging sessions.

This option is not required if you are using the development system for debugging. It is required only if you have multiple runtime systems installed, or if you have made multiple copies of the runtime.
Compiler Options

Setting the RM/COBOL Compiler Registry Key

The RM/COBOL compiler uses the following registry key to read configuration information out of the Windows registry. This option needs to be set only if you have renamed your rmcobol.exe program. In that case, the specified key should be the same as the name of the compiler, without a directory or the .exe extension.

[Defaults]
CompilerRegistryKey=key

This value is read whenever the RM/COBOL compiler is started from within CodeWatch. If not specified, rmcobol is used as the key.

Setting the RM/COBOL Compiler Configuration .exe File

When compiling, a configuration file is normally specified by using the /G or /H Compile Command Options. However, an RM/COBOL configuration file also can be attached to rmcobol.exe by using the Attach Configuration utility (rmattach) program (see Appendix G, Utilities, of the RM/COBOL User’s Guide). When rmcobol.exe is started outside CodeWatch, the attached configuration file is used to modify the behavior of the RM/COBOL compiler.

CodeWatch, however, compiles without using rmcobol.exe. It is possible to specify the location of an rmcobol.exe that has an attached configuration file to emulate the behavior of the standalone compiler.

[Defaults]
CompilerConfigurationEXE=program-file

If such a configuration .exe file is specified, the name of the file is also used as the default registry key unless the CompilerRegistryKey is specified (see the previous topic, “Setting the RM/COBOL Compiler Registry Key”).
Miscellaneous Options

Changing the Log Window Font

The default font used in the Log window is the same font that is used in the Source Code Editor window

[Defaults]
LogFont=font[,size]

The following example illustrates how you can use this option to change the default font to Lucida Console, 9 point, which would allow more lines to be displayed in the Log window:

LogFont=Lucida Console,9

In order to see this change, however, you must close and reopen the Log window.

Setting the Log Window Size

Use this option to change number of lines retained in the Log window.

[Defaults]
MaxLogLines=value

By default, only the last 150 lines are retained.

Controlling Dependency Checking

When you switch from CodeWatch to another window, and then switch back, CodeWatch checks for source and copy files that may have been changed. To prevent a delay from being noticeable, by default, CodeWatch checks ten files at a time. If you have a very large workspace and notice a significant delay when switching from another window (for example, an external editor) back to CodeWatch, you may wish to reduce this number.

[Defaults]
IdleCheckDependencyCount=value

Reducing this value may make CodeWatch more responsive when switching windows, but it should not have an effect during normal operations.
Index

Symbols
$ (dollar sign), 4-12
- (minus sign), 3-14
+ (plus sign), 2-4, 3-14

A
All caps, as a document convention, xii
Angle brackets, in program names, 2-15,
   2-19, 3-16
Animate button, 2-22, 3-58
Animate command (Run), 2-22, 3-58
Animating the program, 2-22, 3-58
Arrange Icons command (Window), 3-59
Attach Configuration utility (rmattach), A-2, A-3

B
Bold type, as a document convention, xii
Break command (Run), 3-57
Breakpoint command (Run), 3-58
Breakpoints
   changing, 3-22, 3-69
deleting, 3-22, 3-69
disabling, 3-22
displaying (viewing), 3-21, 3-54
enabling, 3-22
setting, 3-23, 3-69
Breakpoints & Watchpoints dialog box, 3-69
   Code Breakpoints page, 2-23, 3-69
   Data Watchpoints page, 2-25, 3-71
Breakpoints command (Edit), 3-53
Breakpoints Tab command (View), 3-54
Breakpoints tab, Data window, 3-21
Build menu, 3-55, 5-1
Build Options property page, Item Properties
dialog box, 3-76, 5-2
Build Results Tab command (View), 3-54
Build Results tab, Data window, 3-27, 5-8

C
Call Stack Tab command (View), 3-54
Call Stack tab, Data window, 3-26
Canceling a selection, 4-18
Cascade command (Window), 3-59
Clear All command (Run | Breakpoint), 3-58
Clear command (Run | Breakpoint), 3-58
Clipboard
   cutting, copying, and pasting text onto,
   4-25–4-26
   using with selections, 4-26
   with the Edit menu commands (Source
   Code/Edit window), 4-22, 4-25
Close button, 3-34
Close command, 3-34, 3-46
Code. See Source code
Code Breakpoints page, Breakpoints &
   Watchpoints dialog box, 2-23, 3-69
CodeWatch
   animating the program, 2-22, 3-58
   changing the workspace, 2-28
   compiling, 3-55, 3-76, 5-1–5-8
   configuring a workspace, 2-12, 3-1
   features, new
   inspecting and modifying data, 2-26, 3-42
   installing, 1-1–1-2
   main window, described, 3-11
   overview, 2-1
   running the program, 2-18
   saving a workspace, 2-28
   setting
      breakpoints, 2-23, 3-21, 3-22, 3-53,
      3-54, 3-69
      watchpoints, 2-24, 3-23, 3-53, 3-54, 3-71
   starting, 2-7–2-11
   stopping the program, 2-27
   system requirements, 1-1–1-2
tutorial, quick start, 2-1
viewing and editing program source code, 2-16, 4-1
workspace properties, setting, 3-61
Colors, use of
in breakpoints, 2-23, 3-21, 3-70
in code, 2-26, 3-27, 3-43, 4-3
in watchpoints, 3-23, 3-73
Command page, Workspace Properties dialog box, 3-68
Compilation options, setting, 3-76, 5-2, 5-4
Compile All command (Build), 3-56, 5-1
Compile Changes command (Build), 3-55, 5-2
Compile File command (Build), 3-55, 5-1
Compiler registry key, configuring, A-3
Compiling, 5-1–5-8
Build menu commands, 3-55
Build Results tab, Data window, 3-27
changed files, 5-2
compilation options, setting, 3-76, 5-2, 5-4
environment variables, 5-6. See also
Environment variables
locating the RM/COBOL compiler, 5-7
registering the RM/COBOL compiler, 5-7
Configuration options, A-1–A-4
Context menus
Data window, 3-28
Log window, 3-30
Source Code/Edit window, 4-4
Workspace window, 3-18
Conventions and symbols, xii
Copy command (Edit), 3-52
Source Code/Edit window, 4-25–4-26
Copy files, 3-17
Cut command (Edit), 3-52
Source Code/Edit window, 4-25–4-26
Data Files Tab command (View), 3-54
Data Files tab, Data window, 3-25
Data Item command (View), 3-42, 3-54
Data items
inspecting, 2-26, 3-42
pointer, 3-43, 3-72
type, 2-26, 3-23, 3-43, 3-72
Data Watchpoints page, Breakpoints & Watchpoints dialog box, 2-25, 3-71
Data window
Breakpoints tab, 3-21
Build Results tab, 3-27
Call Stack tab, 3-26
context-menu commands, 3-28
Data Files tab, 3-25
described, 3-20
illustrated, 2-19
Watchpoints tab, 3-23
Debugging
Full Debug Information (Y) compilation option, 2-16, 2-19, 4-1
Dependency checking, A-4
Directory search sequence, 2-16, 3-66
Dockable windows, 3-13, 3-14
Docked command
Window menu, 3-60
Workspace windows, 3-20, 3-29, 3-30
Document menu, 3-32
Document windows, 3-13, 3-31
closing, 3-36
cycling through, 3-34
menu, 3-33
splitting, 3-35
state of, 3-31
Dollar sign ($), 4-12

D

Data files
inserting, 3-2, 3-48
type, 3-25
viewing on Data Files tab, 3-25

X-2 Index
E

Edit Item command (File), 3-50
Edit menu, 3-52
    Source Code/Edit window, 4-25, 4-26
Editing source code
    with external text editor, 4-12
    with Source Code Editor, 4-1
Editing techniques, 4-15
    correcting and editing text, 4-23
cutting, copying, and pasting, 4-22–4-26
deleting text, 4-22
extending selections, 4-20
inserting new text, 4-21
insertion point, 4-15
moving around in a file, 4-15
overwriting selected text, 4-22
overwriting text, 4-22
replacing text, 4-22–4-23
selecting, 4-18–4-21
selections, editing operations with the Clipboard, 4-26
using the Windows Clipboard, 4-26
Ellipsis button, directory searches, 2-17, 3-10, 3-67, 4-12
Environment page, Workspace Properties dialog box, 3-66
Environment variables
    PATH, 2-14, 3-5, 3-9, 3-62, 3-66
    RMPATH, 2-10, 5-6
    RUNPATH, 2-10, 2-14, 3-5, 3-9, 3-62, 3-66
Exit command (File), 3-51
Expressions, regular, 3-37, 3-38
External text editor, configuring, 4-12

F

Features, new, ix
File menu, 3-45
Filenames, conventions for, xii
Files tab, Workspace window, 3-17
Find command (Edit), 3-36, 3-53
Find dialog box, 3-36
Find Next command (Edit), 3-38, 3-53
Find Previous command (Edit), 3-38, 3-53
Floating command
    Window menu, 3-60
    Workspace windows, 3-20, 3-29, 3-30
Floating windows, 3-14, 3-36
Full Debug Information (Y) compilation option, 2-16, 2-19, 4-1

H

Hyphens, optional, in RM/COBOL compilation and runtime options, xiii

I

Icons, used in Workspace window, 3-15
Initialization file (rmcw.ini), A-1
Insert Items command (File), 3-48
Insert mode, 4-21
Insertion point, 4-15
Inspect/Modify dialog box, 2-26, 3-42
Installation and system considerations, 1-1–1-2
Introduction page, Workspace wizard, 3-3
Italic, as a document convention, xii
Item Properties command (File), 3-49
Item Properties dialog box, 3-73
    Build Options property page, 3-76, 5-2
    Programs property page, 3-75
    Source File property page, 3-74

K

Key combinations, document convention for, xiii
Keyboard
    basic techniques
        correcting and editing text, 4-23
deleting text, 4-22
inserting text, 4-21
moving the insertion point, 4-17
selecting text, 4-20
Keys
    for editing, 4-23
    for moving the insertion point, 4-17–4-18
shortcut keys
on Build menu, 3-55
on Edit menu, 3-52
on Edit menu (Source Code/Edit window), 4-25
on File menu, 3-45
on Run menu, 3-57
on View menu, 3-54
on Window menu, 3-59

L
Library files, 2-12, 2-14, 3-9, 3-17, 3-66
Locating source code files, 2-16, 3-66, 4-1, 4-8
Log window
    compiler output, 5-8
    configuring the font and point size, A-4
    configuring the number of lines retained, A-4
    context-menu commands, 3-30
    described, 3-29
    illustrated, 2-20
Log Window command (View), 3-54

M
Main window, CodeWatch, 3-11
Maximize button, 3-34
Maximize command, 3-34
Menu bar and menus, 3-12, 3-44
Minimize button, 3-34
Minimize command, 3-34
Minus sign (-), 3-14
Mouse
    basic techniques
      scrolling with, 4-16
      selecting text, 4-18

N
New command (File), 3-45
New Window command (Window), 3-59

O
Online services, xiii
Open command (File), 3-45
Open Windows command (Window), 3-60
Options command (Build), 3-56, 5-2
Options page, Workspace Properties dialog box, 3-64
Overtype mode, 4-22

P
Pane | Next command (Window), 3-60
Pane | Previous command (Window), 3-60
Paste command (Edit), 3-52
    Source Code/Edit window, 4-25–4-26
PATH environment variable, 2-14, 3-5, 3-9,
    3-62, 3-66
Plus sign (+), 2-4, 3-14
Pointer data items, 3-43, 3-72
Preferences dialog box, 4-9
    External Editing page, 4-12
    Tabs page, 4-9
Program files, 2-12, 3-17
Program Output command (View), 3-54
Program page, Workspace Properties dialog box, 3-62
Programs property page, Item Properties dialog box, 3-75
Programs tab, Workspace window, 3-16
Properties
    item, 3-73
    workspace, 3-61

R
Recent Workspaces command (File), 3-51
Redo command (Edit), 3-52
Registering the RM/COBOL compiler, 5-7
Registration, xiii
Regular expressions, 3-37, 3-38
Related publications, xi
Remove Item command (File), 3-49
Replace command (Edit), 3-40, 3-53
Replace dialog box, 3-40
Restore button, 3-33
Restore command, 3-33
Results | Find Next command (Build), 3-56
Results | Find Previous command (Build), 3-56
Resume command (Run), 3-57
RMPATH environment variable, 2-10, 5-6
Run | Breakpoint menu, 3-58
Run menu, 3-57
Running
  animate the program, 2-22, 3-58
  control flow of execution, 2-22
  inspect and modify data, 2-26, 3-42
  modify and view watchpoints, 2-24,
  3-23, 3-71
  program, 2-18
  Run | Breakpoint menu, 3-58
  Run menu, 3-57
  set breakpoints, 2-23, 3-21, 3-69
  stop program, 2-27
RUNPATH environment variable, 2-10, 2-14,
  3-5, 3-9, 3-62, 3-66
Runtime Command line options, 2-10, 3-68
Runtime registry key, configuring, A-1

S

Save As command (File), 3-46
Save command (File), 3-46
Save Copy As command (File), 3-46
Saving a workspace, 2-28
Scroll bars, 4-16
Scrolling, 4-16
Search string characters, 3-37
Select All command (Edit), 3-53
Select Program page, Workspace wizard,
  2-13, 3-5
Selecting, 4-18–4-21
  with the keyboard, 4-20
  with the mouse, 4-19
Selection mode, 4-18
Set Additional Options page, Workspace wizard,
  2-13, 3-7
Set command (Run | Breakpoint), 3-58
Set Execution Environment page, Workspace
  wizard, 2-14, 3-9
Shortcut keys
  on Build menu, 3-55
  on Edit menu, 3-52
  on Edit menu (Source Code/Edit window),
    4-25
  on File menu, 3-45
  on Run | Breakpoint menu, 3-58
  on Run menu, 3-57
  on View menu, 3-54
  on Window menu, 3-59
Source code, 3-15, 3-17. See also Source Code
  Editor; Source Code/Edit window
  compilation results on Build Results tab, 3-27
  compiling, 5-1
  editing, 2-16, 4-1
  locating, 2-16, 3-66, 4-1, 4-8
  viewing, 2-16, 4-8
Source Code Editor, 4-1. See also Source code;
  Source Code/Edit window
Source Code/Edit window. See also Source code;
  Source Code Editor
basic editing techniques, 4-15
  correcting and editing text, 4-23
  cutting, copying, and pasting, 4-22,
    4-25–4-26
  deleting text, 4-22
  extending selections, 4-20
  inserting new text, 4-21
  insertion point, 4-15
  moving around in a file, 4-15
  overwriting selected text, 4-22
  overwriting text, 4-22
  replacing text, 4-22
  selecting text, 4-18
  selections, editing operations with
    the Clipboard, 4-26
    using the Clipboard, 4-26
context-menu commands, 4-4
creating new source code files, 4-6
editing source code files, 2-16, 4-1, 4-8
illustrated, 2-20, 4-2
locating source code files, 3-66, 4-1
opening existing source code files, 4-7
preferences, setting, 4-9
viewing source code files, 2-16, 4-1, 4-8
Source File property page, Item Properties
dialog box, 3-74
Source files. See Source code; Source Code
Editor; Source Code/Edit window
Special characters, regular expressions, 3-39
Split command (Window), 3-60
Splitting windows, 3-35
Start command (Run), 3-57
Starting CodeWatch
from a saved workspace, 2-8
from MS-DOS environment, 2-9
from RM/COBOL Runtime Command
line, 2-10
from Windows, 2-7
State | Disable All command (Run | Breakpoint),
3-59
State | Disable command (Run | Breakpoint), 3-58
State | Enable All command (Run | Breakpoint),
3-59
State | Enable command (Run | Breakpoint), 3-58
State | Toggle command (Run | Breakpoint), 3-59
Status bar, 3-12
Status Bar command (View), 3-54
Step Paragraph command (Run), 3-57
Step Program command (Run), 3-57
Step Section command (Run), 3-57
Step Statement command (Run), 3-57
Stop command (Run), 3-57
Stopping the program, 2-27
Support services, technical, xiv
Symbols and conventions, xii
Synonyms, 2-14, 3-10, 3-67
System requirements, 1-1–1-2

T
Tab characters, 4-9
Technical support services, xiv
Text patterns, 3-38

U
Undo command (Edit), 3-52

V
View menu, 3-54

W
Watchpoints
changing, 3-71
deleting, 3-71
displaying, 3-23, 3-54
setting, 2-24, 3-71
Watchpoints command (Edit), 3-53
Watchpoints Tab command (View), 3-54
Watchpoints tab, Data window, 3-23
Web site, Liant, xiv
Window menu, 3-59
Windows
  dockable, 3-13, 3-14
  document, 3-13, 3-31
  floating, 3-14, 3-36
Windows 9x class, x, 1-2
Windows NT class, x, 1-2
Workspace
  changing, 2-28
  commands (File), 3-47–3-48
  configuring, 2-12, 3-1
  defined, 2-12, 3-1
  filename extension, 2-8, 2-28
  properties, setting, 3-61
  saving, 2-28
  starting CodeWatch from, 2-8
  window
    context-menu commands, 3-18
    described, 3-14
    icons used, 3-15
    illustrated, 2-15, 2-19
    wizard, 2-1, 2-12, 3-1
Workspace | Close command (File), 3-47
Workspace | New command (File), 3-47
Workspace | Open command (File), 3-47
Workspace | Properties command (File), 3-48
Workspace | Save As command (File), 3-48
Workspace | Save command (File), 3-47
Workspace Properties dialog box, 3-61
  Command page, 3-68
  Environment page, 3-66
  Options page, 3-64
  Program page, 3-62
Workspace window
  context-menu commands, 3-18
  described, 3-14
  Files tab, 3-17
  icons used, 3-15
  illustrated, 2-15, 2-19
  Programs tab, 3-16
  types of
    dockable, 3-13–3-14
    document, 3-13, 3-31
    floating, 3-14, 3-36